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1. INTRODUCTION

Mulberry is a powerful, easy to use electronic mail (email) program that allows you to
send, access, and manage email. Mulberry also helps you manage other email-related
information, such as address books.

To ensure maximum compatibility with existing mail servers, Mulberry uses Internet-
standard protocols such as IMAP and POP3 for reading mail messages, SMTP for
sending mail messages, MIME for sending and receiving attachments within messages,
IMSP and ACAP for storage of preferences and address books on a remote server, and
LDAP for address lookups.

Mulberry has been designed to fully exploit the graphical user interface provided by the
Mac OS and Windows. For example, Mulberry supports drag and drop so that selected
items, such as messages, addresses, or any text, can be dragged onto other items to
facilitate copying of items from one location to another. Comprehensive Balloon Help
(Mac OS) and ToolTips (Windows) is available throughout the program. Users of

Mac OS 8 or later, and Windows users, will also find contextual menu support
throughout Mulberry.

MAC OS Mulberry also supports Apple’s text-to-speech software, enabling
ONLY Mulberry to read messages to you or notify you of new mail via a spoken
alert.
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2. GETTING STARTED

2.1 System Requirements

Hardware CPU

MAC OS

Any 68K or PowerPC Mac OS computer.
Mulberry is a ‘fat’ application and will run
natively on either of these two processors.

Memory

WINDOWS

Any x86 or Pentium based computer or
compatible that supports Windows 95,
Windows 98, Windows NT 4, or Windows
2000.

MAc OS

Mulberry requires a minimum of 4200K
when running on a 68K Mac OS computer
or a PowerPC Mac OS computer with
virtual memory turned on. It requires a
minimum of 9700K on a PowerPC Mac OS
computer with virtual memory turned off.

WINDOWS

Mulberry typically requires 3500K when
running.

Network

Mulberry will work with any network
hardware that provides access to TCP/IP
services: a direct Ethernet connection,
TCP/IP running over LocalTalk (Mac OS),
TCP/IP running over a wireless connection,
or a modem using a protocol such as PPP or
SLIP.
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System Software  Version

Mac OS
System 7.1 or later.

WINDOWS

Mulberry is supported for Windows 95,
Windows 98, Windows NT 4, and
Windows 2000.

Networking

MACc OS

Mulberry works with either MacTCP (v2.0.6
or later) or OpenTransport (v1.1 or later).
You are advised to make sure you have the
latest version of the network software
installed.

WINDOWS

Mulberry requires a Win32 TCP/IP stack.
The standard TCP/IP stack provided with
the OS should suffice.

MAC OS
Drag & Drop

MAc OS

Mulberry can make extensive use of ‘Drag
and Drop’ facilities on your Mac OS
computer. However, this feature is not
always present: any Mac OS computer
running System 7.5 or later will always
have the Drag Manager software installed -
no further action is needed. System
versions prior to this require that the Drag
Manager extension be installed.

MAC OS
Thread Manager

MAc OS

Mulberry utilizes the Thread Manager in
order to perform various threaded
operations. For example, threading gives
Mulberry the ability to check for new mail
in the background while you’re typing a
new mail message. The Thread Manager
extension is not needed with Mac OS 8.0 or
later, as the software is built in to the
system.
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MAC OS
CFM-68K

MAc OS

If you are using a non-PowerPC Macintosh,
Mulberry requires the CFM-68K Runtime
Enabler (Code Fragment Manager)
extension to be installed. Mulberry will
install this extension for you if it does not
already exist. This extension is not needed
with Mac OS 8.0 or later.

MAcC OS
Internet Config

MAc OS

Internet Config is a free third party
extension, originally written by Peter Lewis
and Quinn, which provides a number of
useful features that help in configuring
Internet preferences. It allows you to store
your Internet settings in one location which
Internet Config aware applications can gain
access to. This means that you only need to
enter most of your Internet settings (e.g.
your user id) once rather than in each
Internet application that you use. Internet
Config also has a list of MIME mappings
which help in mapping between Mac OS
files and message attachments.

NOTE: The functionality of Internet Config
is included in Mac OS 8.5 and later via the
“Internet” control panel. If you are running
Mac OS 8.5 or later, you do not need the
separate Internet Config application.

MAC OS
Speech

MAc OS

Mulberry can read aloud incoming
messages if Apple’s ‘Text to Speech’
software is installed on your system. If it is,
Mulberry will display a ‘Speech’ menu in its
menu bar. If it is not installed, the ‘Speech’
menu will not appear. To learn more about
text to speech capabilities read the
documentation that came with your System
Software.

Mulberry Reference Guide v2.0



2.2 Installing Mulberry

To install Mulberry, simply double-click the ‘Mulberry Installer’ file (Mac OS) or the
‘Mulberry Setup.exe’ file (Windows) on the Mulberry CD-ROM, or the equivalent file
that you downloaded from the Internet. A standard installer will then run and give
you options as to which parts of the Mulberry distribution to install, as well as the
location where it will be installed. The ‘Easy Install’ option (Mac OS) or ‘Typical’ option
(Windows) will install the application and all its accompanying documentation. If you
want to install other parts of the distribution choose ‘Custom Install’ (Mac OS) or
‘Custom’ (Windows) in the installer, and select the components you want to install.

2.3 Getting Help

MAc OS

Mulberry makes extensive use of the Mac OS ‘Balloon’ help mechanism
to provide on-line help. To turn on balloon help, choose the Show
Balloons option from the Mac OS Help |2) menu (top-right of menu-bar
for System 7.6.1 or earlier), or from the Help menu (Mac OS 8.0 or later).
Once you are familiar with the application you can turn balloon help off
by choosing Hide Balloons from the same menu.

When balloon help is on, balloons will appear as you move the mouse
over various items on the screen, including menu items, buttons and

other controls. The text in the balloon explains what the corresponding
item will do if selected.

If the balloon help is not sufficient, then consult this document for more
detail.

WINDOWS

Mulberry makes extensive use Windows ‘ToolTips’ to display brief
information about controls in windows when the cursor is positioned
and held over the control for a short while. Mulberry also includes a
Windows online help facility to provide simple descriptions of items
while using the program. If the online help is not sufficient, then consult
this document for more detail.
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2.4 Starting Mulberry
Mulberry can be started in one of two ways.

Double-click on an existing Mulberry preferences file. This has the same effect as
dropping the preferences file onto the application icon. The application’s preferences
are then taken from this file.

Double-click the Mulberry application icon. If Mulberry is configured for single-user
mode, it will first look for a preferences file in the default location. For Mac OS, the
default location is the Preferences folder, inside the System Folder. For Windows,
the default location is the Windows Registry. If no preferences file is found,
Mulberry will present you with an empty preferences dialog (see page 17), which
must be configured before Mulberry can be used. Please consult your network
supervisor or your Internet service provider (ISP) if you are unsure of the proper
settings for Mulberry.

If Mulberry is configured for multi-user mode, it will present a dialog (shown in
Figure 1) asking for personal details only. The other preference information will
have been configured by your system administrator. After starting Mulberry in this
mode, you can change the preferences to suit your needs and save them in a file for
later use.

Mulberry has been designed for use in either a single-user or multi-user environment.
The majority of this guide will describe the features and preference settings available in
Mulberry in its default, single-user state. Mulberry has a number of powerful
administrative options available to system administrators. These options are detailed
in the Mulberry Administrator’s Guide, which is distributed as part of the Mulberry
Administrator’s Toolkit package.

Note: If you are using a copy of Mulberry that has been pre-
configured by your system administrator or Internet service
provider, some of the features and preference settings described
in this guide may not be available to you.
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Information
about this copy
of Mulberry

Version Humber 2.68.68
rH‘SEPiGl Humber 5S1-888661

Licensed to
Dan McCartiar
UP Cyrusaft International, Inc.

Internet Mail from the Ground

Login to Server:

imsp.cyrusoft.com

Lser ID:

Password:
[Eancell |[ OK ]|

| The server to  Enter the password Enter the user ID Thiz button iz not active
login 1o for your server for your server until some text has been
account here account here tvped into the user [D field

Figure 1 The multi-user login dialog box

Note: The multi-user login dialog may appear slightly different
or not be displayed at all depending on the preference
information set by your system administrator or Internet
service provider.
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2.5 Drag and Drop

Dragging and dropping is the same process you use to manipulate files and folders in
the Finder (Mac OS) or Windows Explorer (Windows), only in Mulberry (and other
applications that support it) it can be used to drag and drop other objects such as text or
graphics.

MAc OS Mulberry’s drag and drop capabilities are available if Mac OS drag

OnNLY manager software is installed on your computer. Note that the drag
manager is built-in to Mac OS versions 7.5 and later. Earlier versions of
the OS require the ‘Drag Manager’ extension to be installed.

In Mulberry’s case, any text that you can copy or edit can be dragged and dropped to any
other text area, be it in the same window, a different window or even a window in
another application that supports text drag and drop. You can also drag and drop items
such as messages, addresses and groups, as well as incoming or outgoing file
attachments. For example, a message in a mailbox window can be dragged to another
mailbox window to copy it from one mailbox to another. There are many subtle uses of
this feature in Mulberry. For example, Mulberry can copy all the addresses in a message
into an address book if you drag the message to the address book window.

For each action which you can accomplish with drag and drop, there is always an
equivalent method to achieve the same results. For example, text can be copied and
pasted between different locations, and messages can be copied between mailboxes
using a menu command.

2.6 Contextual Menus

On systems running Mac OS 8 or later, or any Windows platform, Mulberry makes
extensive use of contextual popup menus, which can be accessed by holding down the
control key and clicking the mouse button (Mac OS), or by clicking the right mouse
button (Windows) in different areas of the main windows. Each area has its own
associated contextual menu that can be used as a shortcut to several frequently used
menu commands.

2.7 Using a Network Connection

If Mulberry is performing a time consuming network task (for example reading a large
message or opening a large mailbox), it will display a spinning $ cursor (Mac OS), or
‘hour-glass’ cursor (Windows). When this cursor is visible, you can cancel the current
network task by pressing either Escape or command-period (Mac OS) on the
keyboard. However, this will completely terminate the network connection with the
server. In the case of IMAP servers (used to read mail) or an IMSP server (used for
remote preferences and address books), Mulberry will attempt to automatically log you
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back in and recover its previous state. In the case of an SMTP server, canceling the
sending of a message will leave the message window open. You can then attempt to
send the message again at a later time if you desire.

MAc OS When sending draft messages, Mulberry will save a temporary copy of

ONLY the message about to be sent to disk so that if it is forced to quit because of
an unrecoverable network error, the message is not lost. Each time
Mulberry starts up it looks for any such temporary message files on the
System disk and opens them for you to try sending again.
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3. BASIC CONCEPTS

Electronic mail messages are a means of communicating text and other multimedia
information between different computers. While this may sound straightforward, the
process of getting an email message from your computer to another person’s computer
is actually quite complex. In the past, Internet mail was limited to text messages.
However, modern Internet email systems provide for the sending of complex non-
textual information such as documents, graphics, sound, and video.

Throughout this document, the terms ‘mail client’ and ‘mail server’ will be used rather
frequently. A mail client is simply a program, like Mulberry, that runs on your
computer and allows you to view and manipulate your email, as well as send messages
to other email users. A mail server is a program that runs on another computer — most
often one controlled by your network administrator or Internet service provider. The
mail server, among other things, collects new messages that have been sent to your
email address since the last time you read your mail. The server also takes care of
routing your outgoing mail to the appropriate person.

The interaction between a mail client and mail server is governed by a number of
different complex sets of rules, or protocols. In order for you to access your email, a
mail client must communicate with a mail server on a regular basis. The mail client
sends requests to the server (such as “send me a list of new messages”), and the server
sends a response to that request. In order for this system to work, it is essential that the
client and server speak the same “language”. It is the responsibility of companies that
write email clients and servers to adhere to the various email-related protocols that
have been established.

The next few sections will describe in more detail the various ways in which Mulberry
interacts with mail servers, as well as the protocols that Mulberry utilizes to help you
read, send, and manage email effectively.

3.1 Modes of Operation

Mail clients operate in three different ‘modes’ in their interaction with mail servers.

A client is said to operate in an online mode when it maintains a constant connection
to a mail server. In this scenario, a user’s mailboxes reside on the mail server. This
mode of operation requires that the mail client have constant access to a network
connection. As such, this mode of operation may not be ideal for certain situations,
such as a mobile user trying to access their email from a laptop while on an airplane.
However, since mailboxes are stored in one central location, you can always access all of
your messages from different locations or different computers.

Offline mode is used when the mailboxes accessed and manipulated by the mail client
are stored on a local computer, such as a laptop or desktop PC. A mail client operating
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in an offline mode only needs access to a network connection in order to contact the
mail server and ask for new messages. If the mail server has new messages available
for that user, they are downloaded and stored in the appropriate local mailbox and the
network connection is terminated. This approach is advantageous for users who
always access their mail from the same computer, or who frequently find themselves in
situations where a network connection is not available.

Disconnected mode is a hybrid form of the online and offline modes described above.

In a disconnected mode scenario, a single mailbox exists both as a server mailbox, stored
on the mail server, and as a local mailbox, stored on a laptop or desktop computer. The
mail client can work in either an online mode, directly manipulating mailboxes on the
server, or in an offline mode working with local mailboxes. The key to disconnected
mode is that the mail client must also provide a means of synchronizing server
mailboxes with their local mailbox equivalents. Because the two types of mailboxes are
kept synchronized, disconnected mode operations provide all of the advantages of
offline and online operations.

3.2 The IMAP and POP Protocols: Accessing your Email

There are two widely-used protocols for reading and manipulating Internet mail. The
major difference between these two protocols lies in their support for the various
modes of operation, described in section 3.1. The IMAP protocol supports online,
offline and disconnected modes, while the POP protocol was designed to work only in
an offline mode.

3.2.1 The IMAP Protocol

The Internet Message Access Protocol (IMAP) is an Internet standard for the reading
and manipulation of electronic mail messages stored on a mail server. An IMAP mail
client such as Mulberry normally runs on a user’s personal computer, which contacts
the IMAP server and allows you to see and manipulate your email messages and
mailboxes.

IMAP servers allow you to create and manipulate mailboxes. A mailbox is commonly a
file, stored on the IMAP server, which contains a set of messages. The IMAP server
reads the mailbox file and sends information about each message to the IMAP client,
which then displays the information to you in its own way. The IMAP server also
allows a client to read and manipulate messages in a mailbox.

Mailboxes are usually organized hierarchically on the IMAP server. This allows them
to be grouped logically according to topic. Mulberry allows you to specify different
hierarchies in which to look for mailboxes. This provides you with a method for quick
access to groups of interesting mailboxes.

3.2.1.1 Subscriptions

IMAP clients such as Mulberry have the ability to mark a set of mailboxes as ‘subscribed’
mailboxes. The IMAP client can send a specific request to the IMAP server to get the list
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of subscribed mailboxes. It is up to the IMAP client to decide how to present this
subscribed mailbox list to you. Mulberry makes use of the subscribed mailboxes feature
to allow you to create a set of mailboxes that always appear at the top of the mailbox list.
This is useful if you have a set of mailboxes that you frequently use and want quick
access to in the server window.

3.2.1.2 Extensions to IMAP

Some IMAP servers support a variety of standardized extensions to the protocol.
Among the extensions Mulberry supports are access control for mailboxes, quota
information for mailboxes, and namespace information for display hierarchies.

Access Control for mailboxes allows you to share mailboxes with other people that
have access to your mail server. You can set up privileges for mailboxes to
determine what levels of access users have.

Quota information shows levels of resource usage on the server. For example, you
might be limited to a maximum amount of disk space or a maximum number of
messages in each mailbox.

Namespace information allows Mulberry to detect all of the top-level display
hierarchies available on your mail server. Mulberry has the ability to automatically
list these display hierarchies in the server window. Display hierarchies are
discussed in detail in section 5.2.2.4.

3.2.1.3 Disconnected Mode

While IMAP mail clients typically operate in an online mode, some IMAP mail clients,
such as Mulberry, offer the ability to operate in disconnected mode as well. Mulberry
allows you to specify which mailboxes from an IMAP server should be synchronized
when switching between online and disconnected modes. Mulberry will automatically
create the appropriate local mailboxes to “mirror” the selected mailboxes on the IMAP
mail server, as well as handle the synchronization of the local and server mailboxes
automatically. Use of disconnected mode in Mulberry is described in more detail in
section 5.2.5.

3.2.2 The POP Protocol

The Post Office Protocol, version 3 (POP3) is a simpler Internet standard for
downloading email messages from a mail server. As mentioned previously, POP3 was
designed to work only in offline mode. The only interaction that a POP3 client has
with a POP3 mail server is in contacting the server and downloading new email
messages to a local disk. As such, POP3 mailboxes reside on your local computer rather
than on the mail server.
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3.3 The MIME Protocol: Email is Not Just Text Anymore

Most users of modern email systems have received some sort of non-textual data with
an email message — an image, a word processing document, or some other type of file
attachment. The Multipurpose Internet Mail Extensions (MIME) protocol specifies a
method for encoding any data in such a way that it can be transmitted from one
computer to another.

MAc OS Mulberry supports the use of MIME types and sub-types in conjunction
with Internet Config to ensure that files received via email are correctly
mapped to file types that the Mac OS will recognize.

WINDOWS Mulberry supports the use of MIME types and sub-types in conjunction
with the Windows Registry to ensure that files received via email are
correctly mapped with file extensions recognized on the local machine.

3.4 The SMTP Protocol: Sending Mail

The Simple Mail Transfer Protocol (SMTP) is the main Internet standard for the
sending of electronic mail messages. It does not provide any capability for a client to
read email messages. Mulberry uses SMTP to send email messages that you compose,
regardless of whether you’re using IMAP or POP3 to access your messages.

3.4.1 Extensions to SMTP

Some SMTP servers support various extensions, some of which Mulberry can take
advantage of:

» SMTP AUTH provides a way for an SMTP client such as Mulberry to authenticate
with the SMTP server. This allows the SMTP server to know who is trying to send
mail and to configure itself appropriately. A number of SMTP servers are set to
prevent ‘relaying’ — the sending of messages from someone outside of the ‘domain’
of the SMTP server to someone else also outside of the SMTP server ‘domain’.
SMTP AUTH can be used to verify outside senders as being legitimate users of that
server and turn on relaying for those users only.

» Delivery Status Notifications provides a way for SMTP servers to notify the sender
of a message as to the status of that message. Status information is sent back to the
original sender of the message in the form of a special notification message that can
include the whole original message, or just the headers of the original message to
help identify which message is being referenced. Status information that can be
returned is:

- ‘Success’ — indicates that the message was successfully delivered to a recipient’s
in-coming mailbox.

- ‘Failure’ — indicates that the message was rejected and not delivered to a
recipient’s mailbox.
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- ‘Delay’ - indicates that the message has been delayed en-route to the recipient’s
mailbox.

3.5 The IMSP and ACAP Protocols: Remote Preference and Address Book
Storage

One of the many benefits of IMAP is that it allows you to access all of your mail, stored
on a remote server, from different locations and computers. For users that operate in
this mode, it also makes sense to have other email-related information stored on a
remote server. For example, having your mail client save its preferences on a remote
server rather than on your local machine ensures that it will have the same settings no
matter where you are. By saving your address books on a remote server, you can
guarantee that the names, email addresses, and contact information typically stored in
your address book will be available to you everywhere.

The Internet Message Support Protocol (IMSP) is used to store preference and address
book information on a remote server. If you store your preferences and address books
on an IMSP server, those resources will always be available to you, no matter what
computer you use to run Mulberry. This is particularly advantageous if you frequently
use different computers to read your mail. Mulberry can be configured to use IMSP, if
such a server is available. If it is not available, preferences and address books have to be
stored locally on each computer used to run Mulberry.

In addition to storing addresses on a remote server, IMSP allows address books to be
searched on the server and shared among groups of users. Shared address books make
it easy to set up a centralized address book for a group of individuals or a workgroup,
and combined with server based searching, make it easy for co-workers to find
addresses of other people in their group.

The Application Configuration Access Protocol (ACAP) is an emerging, standardized
replacement for the IMSP protocol. Like IMSP, ACAP allows for the storage and
retrieval of information such as address books and preferences, but in a more efficient
and reliable manner. Additionally, ACAP is designed to be a more general-purpose
solution than IMSP; that is, non-mail applications such as web browsers can take
advantage of ACAP for remote storage of information such as bookmarks or
configuration options.

When operating in disconnected mode, Mulberry has the ability to synchronize
preferences and address books stored on IMSP and ACAP servers with the equivalent
local files.

3.6 The LDAP Protocol: Directory Assistance

The Lightweight Directory Access Protocol (LDAP) allows information about
individuals and institutions to be stored and accessed from a server. Mulberry allows
you to perform basic address lookups using one or more specified LDAP servers.
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3.7 General Security Concepts

Many people don’t realize that common mail protocols such as IMAP, POP3, and SMTP
dictate that personal information such as your username, password, and the text of
your email messages are transmitted over the Internet in clear text. A savvy Internet
hacker has the ability to intercept that information and use it for any number of illicit
purposes. While the chances of that happening are rare, it’s best to take advantage of
security features whenever possible. Mulberry offers security features in two important
areas: authentication, and PGP message security (via a separate PGP plugin). In
addition, third-party applications can be used to provide encrypted communications
between Mulberry and any servers.

3.7.1 Authentication Security

Authentication refers to the process by which a mail client and server verify your
identity. Typically, you enter a username and password into a mail client. The mail
client then sends that information to the mail server for verification. Unfortunately,
this is commonly done using plain, unencrypted text. In addition to plain text,
Mulberry offers support for other popular authentication methods: Kerberos v4,
CRAM-MDS5, DIGEST-MD5 and NTLM. When you use one of these authentication
methods, your password is never transmitted in clear text over the Internet, making it
difficult (if not impossible) for a hacker to obtain this information by monitoring the
traffic between the client and server.

Mulberry supports different authentication methods by a series of plugins. New
authentication methods can be added by simply adding a new plugin to the Mulberry
Plug-ins folder. They will then automatically be available for use in Mulberry the next
time it starts up.

These alternate authentication methods are available for all the different protocols
listed in the sections above. Note that in order to use any of these alternative
authentication methods, your server(s) must support that method. Contact your server
administrator if you’re not sure which authentication methods are supported by your
mail servers.

3.7.2 PGP Message Security

In conjunction with the Mulberry PGP Plugin (available separately), Mulberry offers
seamless integration with versions 5 and 6 of Network Associates’ popular PGP
software. In the context of email, PGP allows you to perform several important security
operations. When sending email, PGP provides mechanisms to encrypt messages
before sending them as well as digitally “sign” messages so that the recipient can verify
their authenticity. On the receiving end, PGP allows you to decrypt messages and verify
a PGP signature attached to a message. When the Mulberry PGP plugin is installed,
various menu commands and buttons will appear to provide seamless access to the
signing and encryption capabilities of PGP. For more information on using PGP with
Mulberry, please see PGP Guide that is part of the PGP plugin distribution.

Mulberry Reference Guide v2.0 15



3.7.3 Encrypted Network Traffic

Third-party products that run on the client and server can provide an encrypted
‘channel’ for sending data between a client program on one machine and a server
program on another. Such software uses a mechanism called ‘port-forwarding’ which
allows the third-part software to interact with the client or server program without the
need for those programs to be specifically modified to work with them. Mulberry
supports port-forwarding software of this kind.
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4. CONFIGURING MULBERRY

Mulberry has a number of flexible configuration options. For the basic email user, the
simple preferences panel allows quick configuration of a basic set of options necessary
to get Mulberry up and running. More advanced email users will want to explore the
advanced preferences panel, which gives you access to all of Mulberry’s powerful
configuration options — including multiple email servers, display fonts and styles,
multiple identities, and many other features.

The simple preferences panel is shown in Figure 2. The advanced preferences panel is
shown in Figure 3. For using the simple preferences consult the Mulberry QuickStart
Guide.

Some of the controls in the various preferences panels may be disabled if Mulberry has
been pre-configured by your network administrator.

Preferences
Feal Hame: |'-.-'ir'u:e Everett |
Email Address: [vinceRoygrusoft.om |
User |03 |'u'i|"|l:E |
Mail Serwver: [imap .cyrusoft.com |
Server Type: @ IMAF () POP3 () Local
SHMTFP Serwver: |5mt|:|.n:l=|r‘u5cift.l:cim |
Hew Mail Check: [ Save User ID
() Hever [] Save Passwaord
& Ever*g:mir‘ns. [#f Login at Startup
[Juse Alert Separator: [1]

Set Signature

Eﬂapg Outgoing Messages

Defaul £2][IMAP : INEDX .Mai LSent | = |

Figure 2 The preferences dialog in simple mode

Mulberry Reference Guide v2.0 17



To change between To switch between To uze settings To have balloon help

local and rermote simple and advanced from Internet turned onin this
preferences, click preferences panels, Config, click here dialoganly, click here
here. click here

/
=

B/Shmu Bal loons
in Preferences

Use lnternet
Config Settings

() Simple

i) Advanced

Preferess en; Fammphe

! Arcounts Frelerences

i Alria [N ml'_-'uml': e ) I
—_— ]

[ hew Bal lccna

in Frafe-ancar

[ e invimvat
Confip Sartting

& Iaapksy Ch Rinpie

o s - ;MWH __ Storage
= rmiien S amibnticating "“"‘*I' !j Local
(Z1 Flnawp ru-lr-m:l Fiain Teet (3] gE“ I::} Remote
_;Eal:ul-:u--l-:u Ure 06fsinca ] | Gpin j

1 i Senr iy [ e Laas QD

Zmw Feggecrd
B s =

|- A razumy

Lo Delault

fL Open I
/]/ Save As... ]

| LT MemthreliS:
=yt hrard

& Spch —i
O takch e 10 and Pafened |m Sﬂ\l’E DEfﬂuIt ]
Click a buttan Preference
here to see a panels are
different panel shown here -|
Toopena preferences file

framdisk, click here To zsawve the current

preferences as the default
inthe System Falder,
click here

To zave the current
preferences inafile,
click here

Figure 3 The preferences dialog in advanced mode
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The advanced preferences dialog has two main areas:

The central window pane is used for showing different panels that can be used to set
preferences.

MACOS To switch between panels, click on one of the buttons on the left
hand side of the dialog.

WINDOWS To switch between panels, click on one of the tabs at the top of the
dialog.

The right hand side of the dialog contains controls used to open and save
preferences files, as well as change some universal settings.

Mulberry supports storage of preferences either locally, on a local or shared hard drive,
or remotely on an IMSP or ACAP server. To switch between local and remote
preferences, click the Local or Remote radio buttons on the right-hand side of the
dialog.

A set of preferences stored in a local file or remotely is called a ‘preference set’. You can

have as many preference sets as you like and switch between them by clicking the
Open button.

- For local preferences this will display a standard file dialog allowing you to
choose a local preference file to open.

- For remote preferences this will open a dialog showing you the available
preference sets on the remote server, and allow you to pick one to open.

One local and one remote preference set can be saved as the ‘default set’. The default
preference set is the one opened when launching Mulberry by double-clicking its icon.
To save the current preference set as the default preference set, you can click the Save
Default button.

MAc OS The default location for local preferences is the Preferences folder inside
the System Folder.

WINDOWS The default location for local preferences is the Windows registry for the
current user.

Closing the preferences dialog by clicking the OK button will also save the current
preference set. In this case, the preference set will be saved in the same location from
which it was opened.
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To save the current preference set under a different name, click the Save As... button.

- For local preferences this will bring up a standard file save dialog allowing you to
choose the name and location for the preference file.

- For remote preferences, this will open a dialog box listing the current preference
sets stored on the server, and allow you to enter a name for the new set.

Multiple preference sets allow you to quickly switch between sets of preferences while
Mulberry is running. When you load a new preference set while Mulberry is running,
all of your current server connections are terminated, and new connections are
established for the various accounts defined in the new preferences file. You can switch
preference sets while Mulberry is running in two ways. First, you can use the Open
button in the Preferences dialog to load a new local or remote preference file. You can
also double-click a local preferences file in the Finder (Mac OS) or the Windows
Explorer (Windows).

MAC OS The ‘Show Balloons in Preferences’ checkbox allows you to turn on

OnNLY Balloon Help only within the preferences dialog itself. Balloon Help
contains useful information on how to fill in the various fields in each of
the preference panels.

The ‘Use Internet Config Settings’ checkbox is described in section 7.4.

There are currently twelve different panels to choose from in the advanced preferences
dialog, though some of these may not be present or are disabled depending on what
additional features are available to Mulberry. Each of these panels will be described in
the following subsections.

20 Mulberry Reference Guide v2.0



4.1 Accounts Panel

Please check with your network supervisor or your Internet service provider (ISP) if
you are unsure of the proper settings for the Accounts panel.

Accounts Preferences

Account Egr‘*us::-ft | MAF — ]

Type: | IMAP Mai lbowx

Serwvear | imap.cyrusof t.com |

jﬁuthenticatiunvﬂptiunsVE}:tras\

Hethnd:[ Flain Text 4]

i

Wi nce |

[ Sove User 1D
[] sove Passward

User |D0O:

[[] Hatch User ID and Password

Figure 4 The Accounts preference panel
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The following four settings are available regardless of the type of account chosen:

Account Selects an account for editing, creates a new account, renames or
deletes the account currently displayed.

Type The type of account currently being displayed (not editable).

Server The internet address of the server should be entered here. This can

be a fully qualified name (e.g. imap.cyrusoft.com) or an IP address
(e.g. 206.31.218.196). To use a hon-default port, add a *:” and the port
number (e.g. imap.cyrusoft.com:146). The default port numbers for
the various protocols used by Mulberry are:

- IMAP -143
- POP3-110
- IMSP - 406
- ACAP-674
- SMTP -25
- LDAP -389

Match User ID
and Password

To have Mulberry use the same password with a user ID that was
used before, turn this on. This allows you to enter your user ID and
password only once when the user ID is the same, even if logging in
to different types of servers.

Note: This option may produce undesirable results if
you use the same username but different passwords
on more than one server in the Accounts panel.

The remainder of the Accounts panel will vary depending on the type of account
currently being displayed.
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4.1.1 IMAP Mailbox Account

4.1.1.1 Authentication Tab

The options available in the Authentication tab remain constant regardless of the
account type selected. The authentication methods described below are available for
IMAP Mailbox accounts and all other account types.

Sauthentication

Method:| Flain Text 4|

U=zer IEI:|'u'ir'u:e |

[ Save User ID
[] save Fassword

Figure 5 The Authentication tab for authentication methods requiring just a
user id and password

Method To choose the authentication method to use with the current
account, click here. Mulberry currently supports Plain Text, CRAM-
MD5, DIGEST-MD5, Kerberos v4, and NTLM authentication
methods. It also supports ANONYMOUS login which does not
require any additional information.

The following options are only available when using an authentication method that
requires only a user id and password:

User ID The user ID required for you to log in to this server should be
entered here.

Save User ID To save the user ID in the preferences file so that it will be used the
next time Mulberry is launched with the current preferences file,
turn this on.
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Save Password To save the your password in the preferences file so that it will be
used the next time Mulberry is launched with the current
preferences file, turn this on.

WARNING: If this option is turned on, anyone with
access to your preferences file will be able to read your
email. Passwords are saved in encrypted form in both
local and remote preference sets.

fﬁuth&nticﬂtiﬂl’lﬁ"\

Hethnd:[ Kerberos Y4 - ]

-

[#f Use Defoult Serwver Principal

Server
Frimcipal 3| |

Ealee Default User ID
Uzer ID:| |

Figure 6 The Authentication panel for Kerberos authentication

The following options are only available when using the Kerberos v4 authentication
method:

Use Default To have Mulberry discover the Kerberos server principal

Server Principal automatically, turn this on.

Server Principal The Kerberos realm of the server should be entered here.

Use Default User  To use the default Kerberos user ID to login to the specified server
ID instead of the ID you specified in the “User ID” field, turn this on.
User ID The user ID required for you to log in to this server should be

entered here, if ‘Use Default User ID’ is turned off.
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4.1.1.2 Options Tab

S Options

ELngin at Startup
Hierarchy Separator: |:|

[] Automatic Hierarchy List

E Al lew Disconnected Dperations

Figure 7 The Options tab for an IMAP Mailbox account

Login at Startup

To automatically login to the selected server when you start
Mulberry, turn this on.

Directory The hierarchy separator character for mailbox hierarchies should be

Separator entered here (usually ‘/’ or “.”). If you do not fill in this field,
Mulberry will determine the correct separator.

Automatic To automatically list any display hierarchies returned by the server,

Hierarchy List

turn this on. The display hierarchies will be shown in the server
window. This option only works if your server supports the IMAP
‘NAMESPACE’ extension. Please see section 5.2.2.4 for a detailed
description of display hierarchies.

Allow
Disconnected
Operations

To enable disconnected operations with this account, turn this on.
Disconnected mode allows you to read and manipulate mail from
an IMAP Mailbox account without being connected to your mail
server. Please see section 5.2.5 for a full description of disconnected
mode operations.
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4.1.1.3 Extras Tab

The options available in the Extras tab are available for IMAP Mailbox accounts as well
as POP3 and Local Mailbox accounts.

Account ldentity:
¥ Tie to Identity

Identitg:[ Mulberty Support e ]

Figure 8 The Extras tab for an IMAP Mailbox account

Tie to Identity Check this option to tie one of your identities to the selected
account. For a complete description of identities, please see
section 5.6.1.6.

This option allows you to specify an identity to use by default when
replying to or forwarding a message stored in a particular mail
account.

Note: You can also tie an identity to a specific mailbox. In
this case, the identity tied to the mailbox will override the
identity tied to the mail account containing that mailbox.
Please see section 5.2.4.1 for instructions on tying an
identity to a mailbox.
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4.1.2 POP3 Mailbox Account

4.1.2.1 Options Tab

S Options

[]Leave Mail on Serwver

Delete After: dugz

ODzlete after Local Expungs

|:| Skip Messages Bigger than: kil:h

[[] Use APOP when Awvailable

Figure 9 The Options tab for a POP3 Mailbox Account

Leave Mail on
Server

To prevent Mulberry from deleting your messages from the POP3
server after downloading them, turn this on.

Delete After

If you select this option, Mulberry will remove messages from the
selected POP3 server after the specified number of days, rather than
deleting them immediately after downloading them.

Delete after Local
Expunge

If you select this option, Mulberry will remove a message from the
selected POP3 server only after the corresponding message has been
deleted and expunged from the local POP3 mailbox.

Skip Messages

When this option is selected, Mulberry will not download messages

Bigger Than from the selected POP3 server that exceed the specified size.
Use APOP When To use the more secure APOP authentication mechanism, turn this
Available on. You must also have Plain Text selected as the authentication

mechanism for this POP3 server. APOP will only be used when the
server advertises that it is available.
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4.1.2.2 Local Tab

S Local

{:} Use Default Location
@ Specify Location:

Macintosh HOIPOP Mai lboxes:

() Relative Path

!) Absolute Path

Figure 10 The Local tab for a POP3 Mailbox account

Use Default
Location

To store POP3 mailboxes for this account in the default location,
click here. The default mailbox location is determined by a setting
in the Disconnected tab of the Mailbox preference panel (see
section 4.5.3), and can be either the Mulberry application folder or
the user documents folder defined by the operating system.

Specify Location

To store POP3 mailboxes in a folder other than the default location,
click here. You can type a path in the location box or use the
Choose button to select a directory.

Relative Path

If this item is selected, Mulberry interprets the pathname relative to
the default location. If you use the Choose button to select a
directory, Mulberry will determine whether relative or absolute is
most appropriate.

Absolute Path

If this item is selected, Mulberry interprets the pathname as an
absolute path. If you use the Choose button to select a directory,
Mulberry will determine whether relative or absolute is most
appropriate.
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4.1.3 Local Mailbox Account

S Local

[:} Use Default Location
i Specify Location:

Macintosh HDO:Local HMai lboxes:

() Relative Fath

E) Absolute Path

File Format: Automatic - ]

Figure 11 The Local tab for a Local Mailbox account

Most of the options in the Local tab are identical to those in the Local tab for a POP3
Mailbox account (see section 4.1.2.2). However, there is one additional option available
to specify the format of the local mailboxes in this account type.

File Format Choose the mailbox format to use for mailboxes under this account.
Available options are Automatic, Mac OS, Windows, and UNIX. In
general, you will want to keep this set to Automatic. However, if
you set up the local mailbox account to access mailboxes on a shared
disk from a computer using a different operating system, you may
need to change the file format. Additionally, you can modify this
setting if you want to create local mailboxes in a format that will
allow easy transport to a computer running a different operating
system.
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4.1.4 SMTP Send Mail Account

4.1.4.1 Options Tab

S Options

IEUEE Local Oueues for Sending
|:| Hold Messages when Added to Oueue

Figure 12 The Options tab form an SMTP Send Mail account

Use Local Queues
for Sending

Select this option to enable SMTP queuing. When this option is on,
Mulberry will create a local mailbox to store outgoing mail sent
through the selected SMTP account. Queued mail is sent in the
background, allowing you to perform other operations within
Mulberry immediately after sending a message.

If you are operating in disconnected mode, the SMTP queue will
hold outgoing messages until the next time you connect to a
network. You can manipulate the contents of the SMTP queue via
the Outgoing Queue window, described in Section 0.

Note: In order to use the selected SMTP account in
disconnected mode, you must have this option checked.

Hold Messages
when Added to
Queue

When this option is selected, messages will be assigned a status of
“Hold” when added to the SMTP queue, causing them not to be sent
immediately. For held messages to be sent, you must manually
change the status of the messages in the Outgoing Queue window,
described in Section 0.
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4.1.5 IMSP Options Account

4.1.5.1 Options Tab

S Options

IEUEE Femote Preferences at Startup

Figure 13 The Options tab for an IMSP Options account

Use Remote Select this option to use the default preference set on the selected
Preferences on remote IMSP server instead of those stored in a local file when
Startup starting up Mulberry.

4.1.5.2 SetsTab

d Sets

Remote Preference Sets

single

Eename... Lelete

Figure 14 The Sets tab for an IMSP Options account

The Sets tab allows you to view and manipulate the different preference sets on the
current IMSP server. A listing of all available preference sets appears in the Remote
Preference Sets box. To update the listing of preference sets, click the Refresh button.
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The Rename button allows you to change the name of the currently selected
preference set. The Delete button will delete the currently selected preference set(s)
from the server.

4.1.6 ACAP Options Account

The options available for an ACAP Options account are identical to those available
when using an IMSP Options account.

4.1.7 IMSP Address Books Account

4.1.7.1 Options Tab
S Options

E Login at Startup

E Al low Disconnected Operations

Figure 15 The Options tab for an IMSP Address Book account

Login at Startup To set Mulberry to automatically login to the selected IMSP Address
Book server when you start the program, turn this on.

Allow To make address books in this account accessible while in
Disconnected disconnected mode, select this option. Please see section 5.2.5 for a
Operations full description of disconnected mode operations.

4.1.8 ACAP Address Books Account

The options available for an ACAP Address Book account are identical to those
available when using an IMSP Address Book account.
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4.1.9 LDAP Address Search Account

4.1.9.1 Attributesl Tab

Root

Name

Email

Nick-name

Address

Company

S attributesi Y

Root: |e=Us

Hame:lcn

Email:lmail

Hi:k—name:lgiuennume

Hddress:lpnstulﬂddress

Enmpang:ln

Figure 16 The Attributesl tab for an LDAP Address Search account

Enter the root starting location for the LDAP search.

Enter the attribute value on the LDAP server that corresponds to the
name of the person being looked up. This will usually be ‘cn’.

Enter the attribute value on the LDAP server that corresponds to the
email address of the person being looked up. This will usually be
‘mail’.

Enter the attribute value on the LDAP server that corresponds to the
nick-name of the person being looked up.

Enter the attribute value on the LDAP server that corresponds to the
postal address of the person being looked up.

Enter the attribute value on the LDAP server that corresponds to the
company of the person being looked up.
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4.1.9.2 Attributes2 Tab

S attributes2 Y

FPhiote Hnrk:|telephnheﬁumber

FPhiote Hnme:|hnmetelephnheﬂumber

UHLs:|uPI

|
|
Fax:|fucsimiIetelephnheﬂumber |
|
|

Hntes:|

[¥] Put Attributes in Motes

Figure 17 The Attributes2 tab for an LDAP Address Search account

Phone Work Enter the attribute value on the LDAP server that corresponds to the
work telephone number of the person being looked up.

Phone Home Enter the attribute value on the LDAP server that corresponds to the
home telephone number of the person being looked up.

Fax Enter the attribute value on the LDAP server that corresponds to the
fax number of the person being looked up.

URLs Enter the attribute value on the LDAP server that corresponds to the
URL of the person being looked up.

Notes Enter the attribute value on the LDAP server that corresponds to the
Notes field of the person being looked up. This field is disabled if
you check the ‘Put Attributes in Notes’ option below.

Put Attributes in  To have the full set of attributes returned by the LDAP server for an
Notes entry inserted into the address notes field, turn this on.
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4.2

Alerts

Alerts Preferences

_;'"’ Messages -"'U"(Mtac hirne nts-"'-.l

Stule: | INBOXes 4|

{:} MHewer

) Onee on Startup

Y EVE*’“H: mins.
[] Use Foreground Alert

[] Use Background Alert
EFlash lcon in Background

[ Floy Sound: [ Simple Beep

L] Open Mai lbax Window

Alert when Mailbox Contains:
{#) Mew Messages
() Any Messages

Apply to Eqbinet:[ Chack Favourites

Figure 18 The Alerts preference panel

The Alerts preference panel allows you to define several different alert styles to apply to
different groups of mailboxes. For example, you may want to check your INBOX for

new mail every five minutes, and receive notification via a sound and foreground

alert. You may also want to check another group of mailboxes, such as your subscribed

mailboxes, less frequently and receive a different type of alert when new messages

arrive in those mailboxes.

Alert styles work in conjunction with cabinets. Each alert style you create has a cabinet
associated with it. New mail checking and notification takes place for mailboxes within
that cabinet according to the settings specified within the associated alert style. For a
complete description of cabinets, please see section 5.2.2.6.
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Style

This popup allows you to choose among the different alert styles
you’ve created, as well as make changed to those styles. When you
select an alert style using this menu, the settings for that style are
displayed. The New ... option allows you to create and name a new
alert style. The Rename... option allows you to rename the
currently selected alert style, and the Delete... option deletes the
selected alert style.

New Mail
Checking

To enable automatic mail checking, click the ‘Every ... minutes’
option and enter a time in minutes to specify the interval between
automatic mail checks. If ‘Never’ is selected, no automatic mail
checking will take place. Selecting the ‘Once on Startup’ option
causes mailboxes to be checked only once, after you start Mulberry.

Use Foreground
Alert

To show an alert dialog when new mail arrives and Mulberry is the
active application, turn this on.

Use Background
Alert

To show an alert dialog when new mail arrives and Mulberry is in
the background, turn this on.

MAc OS ONLY

Flash Icon in
Background

MAc OS ONLY

To flash the application icon in the menu bar when new mail
arrives and Mulberry is in the background, turn this on.

WINDOWS ONLY
Show Icon in

WINDOWS ONLY
To show the application icon in the taskbar, turn this on.

Task Bar

Play Sound To play a sound when new mail arrives, turn this on. You can select
the sound from the list of installed system sounds using the popup
menu.

Open Mailbox To automatically open the mailbox window for any mailboxes that

Window contain new mail, turn this on.

Alert when To present an alert only when a mailbox is checked and contains

Mailbox Contains

new messages, click the New Messages option. To present an alert
when a mailbox is checked and contains any type of message, click
the Any Messages option. The type of alert presented will depend
on the settings above.

Apply To Cabinet

Select the cabinet to associate with this alert style. Mailboxes in this
cabinet will be checked at the interval specified and you will be
notified of new messages according to the settings specified in the
current alert style.
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4.2.1 Attachments Tab

£ odttachments b

[]uUse Alert
E Flay Sound: Oroplet e ]

[ speak:
Thi=s message has an attachment

Figure 19 The Attachments tab in the Alert preference panel

Use Alert To show an alert box when a message with attachments is opened,
turn this on.
Play Sound To play a sound when a message with an attachment is opened,

turn this on. You can select the sound from the list of installed
system sounds using the popup menu.

MAc OS ONLY MAc OS ONLY

Speak To generate a spoken alert when a message with an attachment is
opened, turn this on. You can specify the text to be spoken in the box
below the check box.
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4.3 Display

Display Preferences

_).-"rSE-r'*.re-r' -"-\_,.-"rl‘*“la ilbo= VMessage -""n.l_,.-"l’l.'.lu-:nte-s USt-_-,- les

Colour: Bold [#zlic Sdeiee Under

Logged in :- M O O O
Logged out :- E |:| |:| D

Ser*uer*::l E Colour Background
Eubinet::l E Colour Background
Hierurchg::l E Colour Background

[ Reset Window Defaults

Figure 20 The Display preference panel

In addition to the settings in the Display panel, Mulberry saves window position
information in your preferences. To facilitate easy use between different computers,
different sets of window positions are saved for different monitor resolutions and
different operating system types.

Reset Window Resets all window positions to their default values

Defaults

WINDOWS ONLY WINDOWS ONLY

Independent To view each individual Mulberry window as a separate,
Windows independent window, turn this on. To confine all of the Mulberry

windows inside one rooted window, turn this off. Changes only
take effect after you quit and restart Mulberry.
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WINDOWS ONLY

Multiple Taskbar
Items

WINDOWS ONLY

To have each individual Mulberry window appear as a separate
entry on the taskbar, turn this on. To have a single taskbar entry for
all Mulberry windows, turn this off. This option is not available if
you do not have the Independent Windows option turned on.
Changes only take effect after you quit and restart Mulberry.

4.3.1 Server Tab

The settings in this tab affect the text names of mail servers, cabinets, and display
hierarchies appearing in the server window.

Logged In

To set the color for displaying the text name of servers in the server
window for which you are currently logged in, click the colored box.
To select a text style for the text names of logged in servers, turn the
appropriate checkbox on or off.

Logged Out

To set the color for displaying the text name of servers in the server
window for which you are not logged in, click the colored box. To
select a text style for the text names of logged out servers, turn the
corresponding checkbox on or off.

Server

To set the background color for servers in the server window, click
the colored box. To eliminate the background color, uncheck the
‘Colour Background’ box.

Cabinet

To set the background color for mailbox cabinets in the server
window, click the colored box. To eliminate the background color,
uncheck the ‘Colour Background’ box.

Hierarchy

To set the background color for mailbox display hierarchies in the
server window, click the colored box. To eliminate the background
color, uncheck the ‘Colour Background’ box.
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4.3.2 Mailbox Tab

All settings in this tab affect text names of mailboxes appearing in the server window.

S Mailbox Y

Colour: Bold (/i =Shkee Under

Fecent :-
Un=aen :-
Open :-
Fawvouri te :-
Clo=ed :-

L E OO E]
OO0 OO
O OO0 O
O OO0d

Figure 21 The Mailbox tab in the Display preference panel

Recent

To set the color for mailboxes with new messages, click the colored
box. To select a text style for mailboxes with new messages, turn the
corresponding checkbox on or off.

Unseen

To set the color for mailboxes with unseen messages, click the
colored box. To select a text style for mailboxes with unseen
messages, turn the corresponding checkbox on or off.

Open

To set the color for mailboxes that are currently open, click the
colored box. To select a text style for open mailboxes, turn the
corresponding checkbox on or off.

Favourite

To set the color for mailboxes that are marked as ‘Favourites’ (those
that will be checked for new mail), click the colored box. To select a

text style for favourite mailboxes, turn the corresponding checkbox

on or off.

Closed

To set the color for ordinary mailboxes, click the colored box. To
select a text style for ordinary mailboxes, turn the corresponding
checkbox on or off.
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4.3.3 Message Tab

All settings in this tab affect message captions appearing in mailbox windows.

S Mezzage %

Unseen :- E |:| |:| D

O O 0O O

O O 0O O

Important: - %] ] [ L]
pelctec:[ Nl OO0 O M O
Multiple Addresses!: |:| |:| |:| E

Colour : Bold (#3lic Sheiee Under

Matched :I:l E Colour Background

Unmatched ! |:| Colour Background

Figure 22 The Message tab in the Display preference panel

Unseen

To set the color for new messages, click the colored box. To select a
text style for new messages, turn the corresponding checkbox on or
off.

Seen

To set the color for messages that have been seen, click the colored
box. To select a text style for seen messages, turn the corresponding
checkbox on or off.

Answered

To set the color for messages that have been answered, click the
colored box. To select a text style for answered messages, turn the
corresponding checkbox on or off.

Important

To set the color for important messages, click the colored box. To
select a text style for important messages, turn the corresponding
checkbox on or off.

Deleted

To set the color for messages that have been deleted, click the
colored box. To select a text style for deleted messages turn the
corresponding checkbox on or off.

Multiple
Addresses

Some messages in mailbox windows are addressed to multiple
recipients. To set a text style for displaying the address fields of such
messages, turn the corresponding checkbox on or off.
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Matched To set the background color for messages that meet the current
‘Match’ criteria, click the colored box. To eliminate the background
color, uncheck the ‘Colour Background’ box.

Unmatched To set the background color for messages that do not meet the

current ‘Match’ criteria, click the colored box. To eliminate the
background color, uncheck the ‘Colour Background’ box.

4.3.4 Quotes Tab

All settings in this tab affect message text appearing in a message window.

S Quotes Yy

Colour:  Bold (sl Under
}Level:- D D D
siLavel : [

}}}LEHE“- [#] Use Multiple Colours
srrrlevel: ]
spvvslaval: |

Recognised Quotes

.
-

Figure 23 The Quotes tab in the Display preference panel

Level Click on the Colour box to specify a color for each level of quoted
text. You can also use the checkboxes to the right of the first level to
specify different text styles for quoted text. Any selected text styles
will apply to all levels of quoted text.

Use Multiple To use different colors for each level of nested quotes, check this

Colours box. If this box is not selected, you will only be allowed to specify
one color for all quoted text.

Recognised Mulberry uses the characters in this box to determine which lines in

Quotes the text of a message are quoted text. If a line of message text begins
with one of the listed characters, Mulberry assumes that line
contains quoted text and applies the specified colors and styles.
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4.3.5 Styles Tab

All settings in this tab affect message text appearing in a message window.

S Styles Y,

Calaur : Bold {#s)i= Under

il O O
L se=n: I O O

Heuu:ler*:- M O
Style Tag5:- |:| |:|

Recognize URL Schemes

http: /s
https:/f
mailto:
ftpe /s
file:ﬁ{

OO K E

]

Figure 24 The Styles tab in the Display preference panel

URL

To set the color for displaying active URLS, click the colored box. To
select a text style for URLSs, turn the corresponding checkbox on or
off.

URL Seen

To set the color for displaying followed URLs, click the colored box.

To select a text style for URLS, turn the corresponding checkbox on
or off.

Header

To set the color for displaying message header fields, click the
colored box. To select a text style for message header fields, turn the
corresponding checkbox on or off.

Style Tags

To set the color for displaying styled text tags, click the colored box.
To select a text style for styled text tags, turn the corresponding
checkbox on or off.

Recognise URL
Schemes

To have Mulberry recognize a particular type of URL and display it
as specified above, enter its scheme here. This should include any
required directory characters after the “:’ (e.g. use ‘http://’, not ‘http:’).
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4.4 Fonts

Lists

Plain Text

Printed Text
Printed Captions
Styled Base

Styled Fixed

44

Font Preferences

Font: Size:
Lists:[ Geneva - ][ 10| &
Plain Text:| Manaco SIERE
Printed Text:| Times a|[ 14 ]
Print Eaptinns:[ Palatino = ][ CI— ]
Styled Ease:[ Palatino — ][ L= B ]
Styled Fixed:| Monaco 2 ERE

Figure 25 The Font preference panel

Choose the font face and size to use when displaying lists of items,
such as servers and mailboxes in the server window, message
captions in a mailbox window, and address books in the address
book manager window.

Choose the font face and size to use when displaying message text in
a message window or a draft window. You should try to choose a
font with a fixed character width (mono-spacing) so that text
formatting and alignment is preserved.

Choose the font face and size to use when printing text messages.
Choose the font to use for the header and footer on printed pages.

Choose the default font face and size to use for displaying styled text
in text/enriched and text/html styled text messages or drafts.

Choose the font face and size to use for displaying fixed-width text
in text/enriched or text/html styled text messages.
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4.5 Mailbox

kMailbox Preferences

_;'( Eiasic:\'u"’ﬁdva nced UDiscu nnected ﬁ"-.L

Open Mai lbox at:

() First Message

() Last Message

@ First MHew Message

[] Expunge on Close
[] Harhn on Expunge

[Eiﬂpen Mext with Mew Messages
[] A=k before Opening Mext

[] Mowe Read Messages in [HBOX

Mowe to:

Hart when Mowing

Figure 26 The Mailbox preference panel

45.1 Basic Tab

Open Mailboxat  These three radio buttons determine whether mailbox windows are
opened with either the ‘First’, ‘Last’, or ‘First New’ message
displayed. The ‘First’ and ‘Last’ options will display the oldest and
newest set of messages, respectively, when a mailbox window is
opened. The ‘First New’ option will cause the oldest unread
message to be highlighted when a mailbox window is opened.

Expunge on Close To automatically expunge a mailbox after closing its window, turn
this on. Expunging permanently removes from the mailbox any
messages marked as deleted.
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Warn on Expunge To display a warning before expunging a mailbox, turn this on.

Expunging permanently removes from the mailbox any messages
marked as deleted.

Open Next with
New Messages

To automatically move to the next mailbox with new messages in it
when you have read all messages in the current mailbox, turn this
on.

Ask before
Opening Next

To show a warning before moving on to the next mailbox with new
messages, turn this on.

Move Read This option allows you to automatically move messages in your

Messages in INBOX that you’ve read to another mailbox. Upon closing the

INBOX INBOX window, all ‘seen’ messages are moved to the mailbox
specified in the ‘Move to’ field (described next), and deleted
messages are expunged from the INBOX.

Move to When the INBOX is closed any messages that have been seen will be
automatically moved to this mailbox and the INBOX expunged. The
mailbox name should be the full path name for the mailbox. You
can click on the pop-up menu next to the field to select a mailbox
from those currently known to Mulberry.

Warn when To display a warning if any messages are about to be automatically

Moving moved out of the INBOX, turn this on.
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45.2 Advanced Tab

New Messages

Use ‘Copy
Messages To’
Cabinet

Use ‘Copy Drafts
To’ Cabinet

Maximum
History

Mew Messages:

!} are Unseean
[j are Recent

E} are Recent and Unhseen

Cabinets:
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[#] Use ‘Copy Drafts To® Cabinet

M@z imum History: |3

H

Message Display Cache:
Initial Downlood: |2
@ Unlimited Total
(JLimit to:

!} Auto |hcrement

E} | hicrement

)
[ [

Figure 27 The Advanced tab in the Mailbox preference panel

These three radio buttons determine what type of message is
considered to be a new message. Selecting ‘are Unseen’ or ‘are
Recent’ causes messages without the seen flag set and messages with
the recent flag set, respectively, to be considered as new. The ‘are
Recent and Unseen’ option causes messages without the seen flag
AND with the recent flag to be considered new.

For a complete description of message flags, please see section 5.3.3.3.

To use the list of mailboxes in the ‘Copy Messages To’ cabinet in the
‘Copy To’ main menu and popup menu, turn this on.

To use the list of mailboxes in the ‘Copy Drafts To’ cabinet in the
‘Append To’ main menu and popup menu, turn this on.

Enter the number of recently chosen mailboxes to be shown in the
‘Copy To’ or ‘Append To’ main menu or popup menu when the
menus are set to display their respective cabinet contents.
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The next set of options determine the behavior of Mulberry’s message display caching.
Novice users will probably want to use the default settings.

Initial Download

Enter a number into this field. Mulberry will download a
corresponding number of message captions automatically when you
first open a mailbox window. Setting this number too high when
using a slow network connection could result in poor performance.

Unlimited Total

To allow Mulberry to download an unlimited number of message
captions for a mailbox, select this option. If this option is not
selected, message caption information will be discarded as other
captions need to be downloaded. Selecting this option when
working with very large mailboxes could result in a low memory
situation.

Limit To

To allow Mulberry to discard information on messages not
currently displayed in a mailbox window, click here. When the
number of message captions downloaded exceeds the specified
number, Mulberry will discard previously downloaded message
captions. Enter the number of message captions to remember in the
box to the right.

Auto Increment

If this option is selected, Mulberry will automatically download a
number of new message captions equivalent to the number of
messages displayed in the mailbox window.

Increment If this option is selected, Mulberry will automatically download a
number of new message captions equal to the number entered.
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45.3 Disconnected Tab

fﬂptiunswLucal-‘\

EF‘I"‘Dmpt on Startup if Reguired

|:| Automatic HModem Dial MHangup

[ Harn if Mailboxes do not Match
|:| Uze 05 Specific Default Locations

Figure 28 The Disconnected tab in the Mailbox preference panel

Within the Disconnected tab, the Options tab allows you to specify various settings that
affect disconnected mode operations.

Prompt on
Startup if
Required

When Mulberry is started, it will attempt to start up in the same
state it was in when it was last quit — either connected or
disconnected mode. In the case where Mulberry was previously in
connected mode and no network connection is available on startup,
you can select this option to have Mulberry prompt you to
determine whether you want to establish a connection or startup in
disconnected mode instead. If you don’t have this option turned
on, Mulberry will always try to establish its previous state on
startup, and you will receive an error message if a network
connection is required but not available.

Automatic
Modem
Dial/Hangup

Select this option to have Mulberry automatically dial and hang up
your modem as necessary when moving between connected and
disconnected mode.
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Warn if
Mailboxes Do Not
Match

In some rare cases, if an online IMAP mailbox has completely
changed since the last time it was synchronized with a disconnected
mailbox, Mulberry may not be able to perform some of the pending
synchronization options. Turning this option on will produce an
alert if this happens.

You will generally want to keep this option on.

Use OS Specific
Default Locations

To use the default location for documents as specified by the current
operating system, select this option. The default location is usually
the user documents folder. If this option is off, the default location is
the Mulberry application folder.

This setting can potentially affect any local mailboxes, disconnected
mailboxes, POP3 mailboxes, and local address books that are set to be
stored in the default location.

The items in the Local tab are identical to those in the Local tab for a POP3 mailbox
account (see section 4.1.2.2), though the settings in this tab specify the location for the
storage of disconnected mailboxes.
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4.6 Message

Message Preferences

[[] show Message Header in Window
ESh-:-m Styled Text Alternatives
EF‘ut Mes=age Header in File when Sawving

Creatar for Sawved Messages |H*ch |[ Choozse ]

Print Captions: Set.

Eaﬂelete Meszage after Copy
[] Al low Deleted Messages to be Opened
Eﬂeuge Opehn Message Window
[#] Qucte whole Message if no Selection
Eﬂpen First Digest Message

Harkn when Opening a Message bigger than:
(D Mo Limit @ Size:[ 188 Kbytes
Allow Choice of who to Reply to when:

{#® Option Key is Down
(3 Option Key is not Down

Figure 29 The Message preference panel

Show Message To have the message header displayed at the top of each message
Header in when opened, turn this on.
Window

Show Styled Text To display the styled text message part in a multipart/alternative
Alternatives message, turn this on. To always display the plain text part of a
multipart/alternative, turn this off.

Put Message To save the message header along with the message text when a
Header in File message is saved, turn this on.
when Saving
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MAc OS ONLY

Creator for Saved
Messages

MAac OS ONLY
Enter the creator code for messages saved to disk. For example:

‘ttxt’ for TeachText/SimpleText
‘MSWD’ for Microsoft Word

If you don’t know the proper creator code for the application you
want to use, you can click the Choose button and select the
application you want to handle saved messages. Mulberry will fill
in the appropriate creator code for you.

WINDOWS ONLY

Extension for
Saved Messages

WINDOWS ONLY

Enter the three character filename extension for messages saved to
disk. For example:

.txt for a plain text file

.doc for a Microsoft Word document

Print Captions

Click the *Set...” button to define the header and footer that will
appear when you print a message. A dialog box (shown in Figure 30)
will appear. You can create different headers for regular messages
and draft messages.

Delete Message
after Copy

To delete messages after copying from one mailbox to another, turn
this on.

Allow Deleted
Messages to be
Opened

To allow messages that are marked as deleted to be opened, turn this
on.

Reuse Open
Message Window

To reuse the oldest open message window when opening a message
from a mailbox window, select this option. Holding down the
Option (Mac OS) or Alt (Windows) key when opening a message
from the mailbox window will produce the opposite behavior.

Quote whole
Message if no
Selection

If this option is checked and you reply to a message, the complete
text of the original message will automatically be quoted in the reply
draft window, unless you highlight a specific portion of the original
message to quote instead.

Open First Digest
Message

To automatically open the first digest message when a
multipart/digest message is opened, turn this on.

Warn when
Opening a
Message bigger
than

52

When this option is selected, a warning alert will be displayed
before opening a message exceeding the specified size. If ‘No Limit’
is selected, no size warning occurs.
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Allow Choice of
who to Reply to
when

This setting allows Mulberry to automatically display a dialog with a
choice of reply addresses when replying to a message. To have this
dialog always come up, select ‘Option Key is not Down’ (Mac OS) or
‘Alt Key is not Down’ (Windows) option. To have the dialog appear
only when you hold down the Option (Mac OS) or Alt (Windows)
key while selecting the Reply option, choose ‘Option Key is Down’
(Mac OS) or ‘Alt Key is Down’ (Windows).

4.6.1 Editing Captions

You can create custom captions to appear on message printouts. Captions are created
using the ‘Set Caption’ dialog.

D s 1T Cnptiun ————————————————— E
Iy Marne I Srnart Marme | From Mame To Marne I CC Manne Subject I Crate Mow
My Email | Smart Email | From Email ToEmail | CC Email Date Short | Page Number
My Full | Smart Full Frorn Full ToFull | CCF Date Long |
Header W Message i) Draft [l Draw Box
Page %page. #smart—full oh #sent—short =
Footer % Mesaage i) Draft [ Drove Box
Printed for: Bmz—ramz on Braw |~ |
[ |
[ Bevert |

Figure 30 The Set Caption window

You can edit different headers and footers for regular messages and draft messages by
selecting either the ‘Message’ or ‘Draft’ radio buttons. The buttons at the top of the
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window allow you to insert various fields from the message you are printing into the
printed header or footer. A description of each field button follows:

My Name Your real name. If you have not specified your real name in the
appropriate preference panel, your email address will be used
instead.

My Email Your email address.

My Full Your real name and email address.

Smart Name

The real name of the correspondent. If a real name is not specified,
the email address of the correspondent will be used instead.

Smart Email The email address of the correspondent.

Smart Full The real name and email address of the correspondent.

From Name The real name specified in the ‘From’ address of the current
message. If a real name is not present, the email address will be used
instead.

From Email The email address specified in the ‘From’ address of the current
message.

From Full The real name and email address specified in the ‘From’ address of
the current message.

To Name The real name specified in the ‘To’ address of the current message. If
a real name is not present, the email address will be used instead.

To Email The email address specified in the ‘To’ address of the current
message.

To Full The real name and email address specified in the ‘To’ address of the
current message.

CC Name The real name specified in the ‘CC’ address of the current message. If
a real name is not present, the email address will be used instead.

CC Email The email address specified in the ‘CC’ address of the current
message.

CC Full The real name and email address specified in the ‘CC’ address of the
current message.

Subject The subject of the current message.

Date Short A short version of the date and time the current message was sent.

Date Long A long version of the date and time the current message was sent.
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Date Now A short version of the current date and time.

Page Number The current page number.

To draw a box around either the header or footer, select the appropriate ‘Draw Box’
checkbox. The ‘Revert’ button will change all captions back to the state they were in
when the Set Caption window was first opened.

4.7 Outgoing

Outgoing Preferences

_;'(Generalwﬁtyledw\

Default Domain for
Outgoing HMail: |cgrusnft.cnm

Tab Width:[¢ |
Hrap Length:

Feply Prefi=z:i|:> Caption:| Set.

Forward Prefix: Caption:| Seat.

Print Caption=s:| Set.

E Insert Signature Automatical ly
Eﬂdd Blank Line before S5ighnature
EHGPH if no Subject when Sending

|:| Remember Chosen Copy Mai lbowx
Eﬁppend as Draft

|:| Copy IMBOX Messages being Replied to
[#] Use Spaces instead of Tabs

Eur*-:lp Text while Composing

[ Delete Original Draft

Eﬂnh’t Delete Important Drafts

Figure 31 The Outgoing preference panel
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4.7.1 General Tab

Default Domain
for Outgoing Mail

If you enter an email address without the ‘@’ character which is not
a nickname or a group name, this text will be filled in as the rest of
the email address. If you are not sure what to enter here, you should
leave it blank.

Tab Width

The character width to use for tab characters, or the number of
spaces to insert when typing a tab in a draft window when the ‘Use
Space for Tab’ checkbox (described below) is on.

Wrap Length

The number of characters per line to which the text of a draft
message is wrapped when it is sent. This should normally be left at
76 characters per line.

Reply Prefix

The string used to indicate a quotation of a message being replied to.
This string followed by a space is inserted at the start of each line of
the quotation.

Reply Caption

To configure the text displayed before and after each message being
replied to, click the ‘Set...” button. A dialog box (shown in Figure 30)
will appear.

Forward Prefix

The string used to indicate a quotation of a message being
forwarded. This string followed by a space is inserted at the start of
each line of the quotation.

Forward Caption

To configure the text displayed before and after each message being
forwarded, click the ‘Set...” button. A dialog box (shown in Figure 30)
will appear.

Print Captions

Click the ‘Set...” button to define the header and footer that will
appear when you print a message. A dialog box (shown in Figure 30)
will appear. You can create different headers for regular messages
and draft messages.

Insert Signature
Automatically

To have the signature specified in the current identity automatically
added to the end of a new draft message, turn this on.

Add Blank Line
Before Signature

To ensure that there is at least one blank line between the signature
and any text that precedes it, turn this on.

Warn if no To have a warning displayed when sending a message with an
Subject when empty subject line, turn this on.

Sending
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Remember
Chosen Copy
Mailbox

To use the last mailbox chosen for copying a sent message as the
default the next time a draft message window is created, turn this
on.

Append as Draft

To copy draft messages into a mailbox so that they will be opened as
draft messages, turn this on. Holding down the Option (Mac OS) or
Alt (Windows) key while selecting the equivalent command will
produce the behavior.

Copy INBOX To automatically set the ‘Also copy original message’ checkbox
Messages being when replying to a message in the INBOX, turn this on.

Replied To

Use Spaces To use a run of spaces rather than a real Tab character when typing a

instead of Tabs

tab in a draft window, turn this on. The number of spaces used is
determined by the ‘Tab Width’ setting, described above.

Wrap Text while
Composing

To have text in a draft window wrapped to the ‘Wrap Length’,
described above, while composing a message, select this option. If
this option is not selected, text will be wrapped to the width of the
compose window, and re-wrapped to the specified ‘Wrap Length’
when the message is sent.

Delete Original
Draft

If a draft message is opened from a mailbox, turn this on to have the
original draft message deleted after the draft has been sent, saved or
copied.

Don’t Delete
Important Drafts

If the ‘Delete Original Draft’ option is on, turn this option on to
prevent draft messages marked as ‘Important’ from being deleted.
This allows the use of ‘template’ draft messages by marking such
messages as ‘Important’ to avoid them being deleted like ordinary
draft messages.
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4.7.2 Styled Tab

S Styled i,

Compose Text as: [F‘l-:lih *]

Generate Alternatives:
Generate: Generatel
Compose Enriched: pf Flain ] HTHL
Compose HTHL: E Flain |:| Enr iched

[¥] Send Flain Text Flowed

Figure 32 The Styled tab in the Outgoing preference panel

Compose Textas  To set the default styled text format to use when composing draft
messages, choose one from the pop-up menu.

Composing To automatically generate a text/plain part alternative when

Enriched composing a text/enriched message, turn ‘Plain’ on. To
automatically generate a text/html part alternative when
composing a text/enriched message, turn ‘HTML’ on.

Composing To automatically generate a text/plain part alternative when

HTML composing a text/html message, turn ‘Plain’ on. To automatically
generate a text/enriched part alternative when composing a
text/html message, turn ‘Enriched’ on.

Send Plain Text When this option is on, outgoing text/plain messages are sent using

Flowed the “flowed” format. If the recipient of such a message is using a
mail client that supports flowed text, the message will automatically
wrap to the size of their viewing window. Users of mail clients that
do not support flowed text will see the message text wrapped to the
‘Wrap Length’ specified in the General tab of the Outgoing panel
(see section 4.7.1).

58 Mulberry Reference Guide v2.0



4.8 Security

Note: The options in this preference panel are only available when you have the
Mulberry PGP plugin installed. Please see the PGP Guide that that is part of the PGP
plugin distribution for a complete description of using PGP with Mulberry.

Security Preferences

|:| Uze MIME Multipart Security
[#] Always Encrypt to Self
|:| Cache FPassphrase while Bunning

E'-.-'er*ifg Signed Messages when Opened
Eﬂecrgpt Mes=ages when Opensd

Figure 33 The Security preference panel

Use MIME When this option is on, Mulberry generates outgoing messages that
Multipart Security are signed or encrypted with PGP as proper MIME multipart/signed
or multipart/encrypted messages. If this is off, messages are sent as

regular text/plain parts with signing and/or encryption information
in the message body.
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Always Encryptto When this option is on, any encrypted messages generated will also

Self be encrypted to the signing key specified in the currently selected
identity. As an example, if you save copies of all outgoing messages,
this option ensures that you can decrypt messages sent to other

people.
Cache Passphrase  To cache in memory the passphrase(s) for any signing key(s) you use
while Running during the current Mulberry session, turn this on. PGP passphrases
are never written to disk.
Verify Signed To automatically verify the signature on a signed message when it is
Messages when opened, turn this on. This feature will only work for messages in a
Opened proper MIME multipart/signed format.

Decrypt Messages  To automatically decrypt an encrypted message when it is opened,
when Opened turn this on. This feature will only work for messages in a proper
MIME multipart/encrypted format.

4.9 ldentity

Identity Preferences

Identities

Defaul t
Mulberry Support

Add. .. Change... Luplizate Lelete

[¥] Use Tied Identities with Mew Drafts

Outgoing Addresses to Count as Mine

supportReoyrusoft.com

Figure 34 The Identity preference panel
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Identities Displays a list of the current set of identities. You can use drag and
drop to re-order identities in the list. The first identity is always
considered the ‘default’ identity.

Add To add a new identity to the list, click here.

Change... To edit the currently selected identities, click here.

Duplicate To duplicate the currently selected identities, click here.

Delete To delete the currently selected identities, click here.

Use Tied To automatically select a tied identity when creating a new draft,
Identities with turn this on. The tied identity is determined by the currently

New Drafts selected mailbox, front most mailbox or message window. Holding

down the Option (Mac OS) or Alt (Windows) key when creating a
new draft will produce the opposite behavior.

Outgoing Enter addresses into this field, one on each line. The addresses
Addresses to displayed here are used to determine whether or not you are the
Count as Mine sender of a message when a ‘Smart Address’ is displayed in a

mailbox window.
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4.9.1 Editing Identities

Mame uzed to SMTP account to use [dentity iters not activated in
represent this when sending messages  the panels below are inherited
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Panels used fo configure
different identity items

Figure 35 The ‘lIdentity Edit’ dialog box

The items in the Identity Edit dialog are:
‘ldentity Name’ — A text string describing the current identity.

‘SMTP Account’ — The SMTP server to use for sending messages with this identity.
The popup menu includes all ‘SMTP Send Mail’ accounts as defined in the
‘Accounts’ panel.
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‘From’, ‘Reply-To’, ‘Sender’, ‘Options’, ‘Outgoing’ and ‘Security’ tabs — These tabs are
used to specify more options for the current identity, and are described below

49.1.1 FromTab

Active

To use a custom ‘From’ address when the current identity is
selected, turn this on. If this checkbox is not selected, the inherited
‘From’ address is used instead.

Single Address

To enter a single address with separate fields for full name and
email address, click here.

Multiple To enter multiple addresses in a single field, turn this on. If this

Addresses option is selected, a single text box will be displayed in lieu of the
‘Name’ and ‘Email’ boxes described next.

Name The name to be used as part of the custom ‘From’ address should be
entered here (e.g. ‘Joe User’).

Email The email address to be used as part of the custom ‘From’ address

should be entered here (e.g. ‘joeuser@cyrusoft.com’).

4.9.1.2 Reply-ToTab

The ‘Reply-To’ tab is identical to the ‘From’ tab. Address(es) entered into this tab will be
used as the Reply-To address when the current identity is selected.

Note: If you choose to use the ‘Multiple Addresses’ option in
either the ‘From’ or ‘Reply-To’ fields, the addresses you enter
should be fully specified email addresses, e.g. "Mulberry Sales"
<sales@cyrusoft.com>.

4.9.1.3 Sender Tab

The ‘Sender’ tab is identical to the ‘From’ tab, except the ‘Multiple Addresses’ option is
not available. The address entered into this tab will be used as the Sender address when
the current identity is selected.

Mulberry Reference Guide v2.0 63



4.9.1.4 Options Tab

S Options

[ Active

!} Copy Toi|IMAP iuser .support..answerad || — I
{3 Mo Copy To

{:} Choose Copy To |:| Also Copy Original Message
DHEti'u'E EFI:ti'u'e

#-Header Lines Signature

Figure 36 The Options tab of the Identity Edit dialog

Copy To

Enter the mailbox in which copies of messages sent with this
identity are to be saved. Use this to keep a record of messages that
you send. The ‘Active’ box must be checked for sent messages to be
copied.

No Copy To

When this item is selected, the ‘Copy To:” popup menu in the Draft
window will be set to ‘None’ by default when the current identity is
used.

Choose Copy To

When this item is selected, the ‘Copy To:” popup menu in the Draft
window will be set to ‘Choose Later’ by default when the current
identity is used.

Also Copy
Original Message

Select this option to copy the original message into the specified
‘Copy To’ mailbox along with your reply. This option is only
applicable when you are composing a reply or forwarding a message.

X-Header Lines

64

To create your own custom header field lines for this identity, click
this button. A text box will open where you can type the additional
header lines. The ‘Revert’ button in the text box will cause the text
box to return to the state it was in when originally opened. If
‘Active’ is not checked, the inherited ‘X-Header Lines’ will be used
instead.
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Signature To create your own custom signature to use when sending messages
with this identity, click this button. A text box will open where you
can type your custom signature. The ‘Revert’ button in the text box
will cause the text box to return to the state it was in when originally
opened. If ‘Active’ is off, the inherited ‘Signature’ will be used
instead.

4.9.1.5 Outgoing Tab

S Outgoing

Ti Cc B DSh

[] Active
[] Fequest DSH

[] Success Motification () Return Hhole Message
[ Failure Motification @ Return Headers Only
[] Delay Hatification

Figure 37 The Outgoing tab of the Identity Edit dialog

The first three tabs allow you to specify one or more email addresses to automatically
add to the To, CC, or BCC line of an outgoing message when the current identity is
selected. Addresses specified in these tabs are added to the appropriate header line
when you select the identity from the popup menu in the Draft window, and removed
when you switch to another identity.

The DSN tab allows you to request Delivery Status Notification information for all
messages sent using the current identity. Click the ‘Active’ box to activate this feature.

Request DSN Check this box to request delivery status notification information
for all outgoing messages that use this identity.

Success Check this box to request a notification when the message is

Notification delivered successfully.

Failure Check this box to request a notification when the messages is NOT

Notification delivered successfully.
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Delay Notification Check this box to request a notification when there is a delay in
delivering a message.

Return Whole Check this box to request that the entire original message be
Message included with any of the notifications that are selected.

Return Headers Check this box to request that only the headers of the original
Only message be included with any of the notifications that are selected.

Note: Keep in mind that DSN notifications are not guaranteed. These requests
depend on the ability of the various SMTP servers that handle your message to
honor DSN requests. In some cases, you may not receive notifications even if
you have these options turned on.

4.9.1.6 Security Tab

S Security

] Active

[] Sign Messages
[] Encrupt Hessages

Sign with Keg:[ Default Key |

Fey: | |

Figure 38 The Security tab of the Identity Edit dialog

This tab will only be available when the Mulberry PGP Plugin is installed.

Sign Messages To automatically sign messages generated when this identity is
active, turn this on.

Encrypt Messages To automatically encrypt messages generated when this identity is
active, turn this on.
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Sign with Key This popup menu allows you to choose the PGP key you will use for
signing and encryption options when this identity is active.
Available options are:

Default Key — uses the default key as specified within
the PGP application

From Address Key — uses a key with an email address
matching the ‘From’ address specified within this
identity.

Reply-To Address Key — uses a key with an email
address matching the ‘Reply-To’ address specified
within this identity.

Sender Address Key — uses a key with an email address
matching the ‘Sender’ address specified within this
identity.

Other Key — uses a different key. When this option is
selected, you can type a string in the ‘Key’ box. When
you sign a message, Mulberry will attempt to find a PGP
key with a name or email address that contains the
specified string.
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4.10 Addresses

Address Preferences

Allow Choice of Addresses whern:

@ Option Key is Down
() Option Key is Mot Down

_fExpanainn\J.-"ancaI\

[[] Use Expansion instead of Mick-names
E Expand when Mick-name Fails

[#] Expand using Full Mame
|:| Expand using Hick MHame
|:| Expand wu=ing Email Address

Figure 39 The Addresses preference panel

Allow Choice of This setting allows Mulberry to automatically display a dialog with a

Addresses choice of addresses when you click the Draft button in the Address
Book or Address Search window. The items in the dialog will
correspond to the items selected in the window when you click the
Draft button. To have this dialog always come up, select the ‘Option
Key is not Down’ (Mac OS) or ‘Alt Key is not Down’ (Windows)
option. To have the dialog appear only when you hold down the
Option (Mac OS) or Alt (Windows) key while selecting the Draft
option, choose ‘Option Key is Down’ (Mac OS) or ‘Alt Key is Down’
(Windows).
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4.10.1 Expansion Tab

Use Expansion
instead of Nick-
names

To expand partial addresses via an address book search instead of
using nickname lookup, turn this on. This will cause Mulberry to
search all address books marked for searching for matches in the
fields specified below using the partial address as a search string.

Expand when
Nick-name Fails

To perform address expansion only after nickname resolution fails,
select this option.

Expand using Full
Name

To search for the partial address in the Full Name field of all address
book entries when doing expansion, turn this on.

Expand using
Nick-Name

To search for the partial address in the Nick-Name field all address
book entries when doing expansion, turn this on.

Expand using
Email Address

To search for the partial address in the Email Address field of all
address book entries when doing expansion, turn this on.

The items in the Local tab are identical to those in the Local tab for a POP3 mailbox
account (see section 4.1.2.2), though the settings in this tab specify the location for the
storage of local address books.
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4.11 Attachment

Attachment Preferences
__Sending Attachments:
Override MIME with: | Binhex 4 ‘]

@ Always override MIME
{:} Only override when needed

__Saving Attachments:
~ Sawve to Disk:

{:} A=k for Location
!j Use Default Location:

|HD=2500 : Desk top:

__Open after Soue:

() Always B
L=
{#) Ask
{:} Heuear Set Mappings

[ Ihclude Text Attachments

Figure 40 The Attachment preference panel.

Override MIME The default encoding to use for files sent from this computer.
with
MAC OS ONLY

This should normally be set to ‘AppleDouble’ so that files can be
read by users on other computer systems.

Always override  To always use the encoding method specified above regardless of the
MIME file’s type, turn this on.

MAC OS ONLY

This allows you to always send binary files to other Macintosh users
and ensure that the full file information is sent as well.
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Only override
when needed

MAc OS ONLY

To only use the encoding method specified above with binary files
or files which may have a resource fork, turn this on.

WINDOWS ONLY

To use MIME mappings determined by the Windows Registry for
files that do not need special processing, turn this on.

Ask For Location

To be given the choice of name and location when downloading an
attachment, turn this on.

Use Default To use a default name and save an attachment in a default folder

Location when downloading turn this on and enter the folder location in the
text field.

Choose To choose the location of the default download folder, click here.

Open After Save:
Always

To have attachments automatically saved to disk after downloading,
turn this on.

Open After Save:
Ask

To be given the choice of opening attachments saved to disk after
downloading, turn this on.

Open After Save:  To prevent attachments saved to disk after downloading from being
Never opened, turn this on.

Include Text To have text attachments opened after downloading using the
Attachments ‘Open After Save’ option, turn this on. To prevent text attachments

from being opened after downloading irrespective of the ‘Open
After Save’ option, turn this off.

WINDOWS ONLY
Launch

WINDOWS ONLY

To automatically launch all attachments using a particular
application, enter the command line for the application here. Enter
a %s in the command line to substitute the file name of the
attachment.

Set Mappings

To edit the default MIME type to file type mappings, click here. This
brings up a dialog box (shown in Figure 41) from which you can
specify a relationship between a MIME type/subtype and a Mac OS
file creator and file type (Mac OS) or a file extension (Windows).
These mappings can then be used to correctly convert between
Email attachments and files on the local computer.
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4.11.1 Mappings

The mappings set in the explicit mappings dialog are used to override the default

MIME to file type mappings specified in Internet Config (see page 206 for more details)

(Mac OS) or the Windows Registry (Windows). These mappings are only used for

incoming attachments.

MIME to MacOS Mapping

MIME Tvpe to Mac

HMIME type fsubtype

05 File Type Mappings:

HMacDS Application Type

text html

text/plain

appl ication/msword

@ Internet Explorer 2.01

@SimpleTe:{t

TF Microsoft Hord

MIHME : [
Tupe: |

Change
Subtype: | |
MacOs File:
Application: | | Choose...

| Cancel I | oK I
Figure 41 The attachments type mapping dialog
MAC OS To add a new mapping to the list:

Click the New button to create a new blank entry.
Edit the MIME ‘Type’ and ‘Subtype’.
Click the Change button.

Click the Choose button and choose the application corresponding to
the MIME values entered.

Select an appropriate file type from the Type pop-up menu. This type
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must correspond to the MIME type and subtype of the part to be

downloaded.
To edit an entry, select that entry in the table and edit the parameters as
above.
WINDOWS To add a new mapping to the list click the Add... button. This allows you

to set the MIME type and subtype and the corresponding file extension for
the mapping. You can also choose which option to use for opening a file
when a matching MIME part is downloaded to disk.

To edit an entry, select that entry in the table and click the Change...
button.

To delete an entry, select that entry in the table and click the Delete
button.

4.12 Speech (Mac OS Only)

This panel will only be available if the Mac OS Text-To-Speech software is installed on
your computer.

Speech Preferences

Automatic Speech:

[] Speak. MHew Messages in [HBOX
[] Speak. Messages as they Arrive

[] Speak Hew Mail Alert

Speak ## new messages in EE

Mes=sage Speak:

= =

| izomi big Outgoing

Maximum characters to speak: |4095 |

Empty ltem: |Thi=s field is blank |

Figure 42 The Speech preference panel.
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Speak New
Messages in
INBOX

To automatically have new messages in your INBOX spoken after
you open the INBOX window, turn this on.

Speak Messages as
they Arrive

To have new messages spoken when they arrive, turn this on. You
can use this to have parts of new mail message read to you as the
message arrives (e.g. the name of the sender and the subject).

Speak New Mail
Alert

To have the new mail alert speak text instead of beep, turn this on.

Speak Enter the text to be spoken when new mail arrives if the previous
option is on. Use a single ‘#’ to have the number of new messages
spoken for each mailbox which has new mail. Use a single **’ to
have the name of the mailbox spoken for each mailbox that has new
mail. Use ‘##’ to have the total number of new messages in all
mailboxes with new mail spoken. Use ‘**’ to have the names of all
mailboxes with new mail spoken one after the other in turn.

Incoming To edit which parts of an incoming message are spoken, click here.
This brings up a dialog box (shown in Figure 43) from which
message items and suitable text can be specified for speaking.

Outgoing To edit which parts of a draft message are spoken, click here. This
brings up a dialog box (shown in Figure 43) from which message
items and suitable text can be specified for speaking.

Maximum The maximum number of characters in the body of a message that

characters to will be spoken. Use this to limit the amount of text spoken.

speak

Empty Item The text to be spoken when a field in the message being read is
empty should be entered here.
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4.12.1 Speech Configuration

Configure Message Speech="=—"——"—H

Message Speech:

Item to Speak Text to Speak before Item
To ¢1st address) To |
Subject Subject

Body <without header ) Hessage reeds

Marne Mes=sage ends=s

|L‘ance|| | 0K I

Figure 43 The dialog used to configure which parts of a message are spoken

To add a new mapping to the list click the New button to create a new blank entry. This
will bring up the dialog box shown in that allows you to choose which message field is
read and to specify the text to be spoken before that item is spoken. To edit an entry,
double-click that entry in the table. To delete an entry, use the del et e key.

Edit Message Speech i=H

ltem: | To ¢1st Address> 4 |

Text: To

|Eance|| | 0K I

Figure 44 The dialog used to edit items in the speech configuration dialog

You can select which message item to speak from the pop-up menu shown in Figure
45. The ‘Text’ field can be set to text that will be spoken before the message item is read.
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The ‘None’ item can be used to speak some text at any point during the message speak
process.

From {1=t Address}
From (ALl Addresses)

Ta {1=t Address)
Ta {All Addresses)

CC (1=t Address)
CC {All Addresses)

Oate
Subject
Humber of Parts

EBody fwithout Header )
EBody {with Header

® Mone

Figure 45 The pop-up menu of message items that can be spoken
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5. USING MULBERRY

To help you read, compose, and manage your email, Mulberry uses several different
windows. The best way to become familiar with Mulberry is to learn about the
information contained in each major window. Each subsection in this chapter
describes one of Mulberry’s main windows, dialogs and menus that might be
encountered in the window, and important concepts to know when using the window.

5.1 Status

SMTP Status: Idle
Hetwork Status: [dle

Figure 46 The Status display

Mac OS

This provides status information about the Network (IMAP, POP, IMSP,
ACAP and LDAP) and SMTP operations currently in progress. It will also
give an indication of the progress of operations that may occasionally
take a long time to complete (for example, sending large attachments or
opening large mailboxes). Clicking the close box will hide the window. To

see the window again select the Status item from the Windows menu
(see page 202). The location of the status window and its hidden/shown
state are saved in the current preferences file when Mulberry is closed,
and then restored from that preferences file when it is used to launch
Mulberry again.

WINDOWS

The status line at the bottom of the main window provides status
information about the Network (IMAP, IMSP and LDAP) and SMTP
operations currently in progress. It will also give an indication of the
progress of operations that may occasionally take a long time to complete
(for example sending large attachments or opening large mailboxes).
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5.2 Server Window

The server window displays several different entities, the most important being all of
the mail servers as defined in the ‘Accounts’ preferences, as well as the mailboxes

available on each mail server.

Depending on how you’ve configured Mulberry, the server window can display a
simple list with your INBOX and a few mailboxes of interest, or a complex list of
multiple mail servers, subscribed mailboxes, cabinets, and display hierarchies.

5.2.1 Server Window Layout

The server window, an example of which is shown in Figure 47, is divided into three

main sections:

The name of the mail server

Tool Bar associated with this window
\ /

0 =——= Cyrusoft IMAP mE
Logout Draft Create Check Eabin;t Search Details
Pl | Hame: L | e & |= !

v ¥ INBDX 230 0
b+ [T Company
P 7 friends - - -
@ jane - - -
@ L= john - - -
@ L= read- mail - - -
@ sent-rail - - -
=P work - - -
@ from the boss - - - I
[+ |
\ [«
Mailbox List Col\umn
Headers
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Figure 47 Sections of the server window
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The Tool Bar section contains several buttons and a popup menu for quickly
accessing common operations.

The items in the Column Header section indicate what type of mailbox information
is displayed in the corresponding column in the Mailbox List section.

The Mailbox List section displays lists of mailboxes, cabinets, mail servers, and other
items.

5.2.1.1 Tool Bar

There are several buttons in the header area at the top of the server window. These
buttons allow you to quickly perform some of the most common operations on items
in the server window.

The Login button at the top-left of the server window allows you to login or logout of
the currently selected IMAP server. Logging in to an IMAP mail server automatically
generates a list of mailboxes available on the selected server, which includes your
INBOX, any subscribed folders, and any display hierarchies you’ve previously specified.
POP mail servers and local mailbox accounts are always ‘logged in’. Logging out of a
server causes Mulberry to terminate all connections to that server. Note that Mulberry
maintains a constant connection to an IMAP server when logged in.

If you only have one mail server account set up, the Login button will act on that
server, and will always be available. If you have multiple mail server accounts set up,
you must select one of those accounts in the ‘Mailbox List’ section of the server window
to make this button active.

When you are already logged in to the selected mail server, the Login button will
change to a Logout button. Logging out of a server causes Mulberry to terminate all
connections to that server.

The Draft button is used to compose a new e-mail message. Clicking this button will
cause a new compose window to appear. For more information on the compose
window, see page 151.

The Create button allows you to create a new mailbox in a selected mail account or
within a selected display hierarchy. When you click this button, you will be presented
with a ‘Create Mailbox’ dialog that allows you to enter a name for the new mailbox and
specify where it will be created. This button is not available unless a mail server, display
hierarchy or mailbox (that is allowed to contain other mailboxes) is selected. Creating
mailboxes is covered in more depth on page 90.

The Check button causes Mulberry to check the selected mail server or mailbox for
new messages. When checking the INBOX of a POP3 account, Mulberry will login to
the POP3 server, download any new mail, and then logout.

The Cabinet popup menu allows you to hide, show, create, delete, and rename
cabinets. More information on cabinets is available on page 91.
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The Search button allows you to search for messages within a mailbox. This button is
only available when a mailbox is selected in the server window. When you click this
button, you are presented with a new search window. The search window is covered
on page 117.

The Details button at the top-right allows you to view detailed information about
mailboxes and servers in the server window. The Details button is only active if a
mailbox or mail server is selected.

5.2.1.2 Column Headers

The column headers indicate what mailbox information is displayed in each column in
the mailbox list below it. The column indicates with text or an icon what the
information is:

Name The name of the displayed item.
= State Icons representing the state of the corresponding mailbox. These

icons include:

| Indicates that the mailbox is open and a corresponding
mailbox window is on screen.

v Indicates that the mailbox is closed, but is marked for
automatic mail checking.

@ Indicates that the mailbox is closed, but it has new
messages.

No icon means the mailbox is closed and has no new messages.

&y Total The total number of messages in the mailbox the last time it was
checked. If the mailbox has never been checked or opened, a
dash will appear.

B Recent The number of new messages that have arrived in the mailbox
the last time it was opened. If the mailbox has never been
checked or opened, a dash will appear.

#z7 Unseen The number of unseen messages in the mailbox the last time it
was checked, or, if the mailbox is open, the current number of
unseen messages in the mailbox window. This last value may be
different from the total number of unseen messages in the
mailbox if the mailbox window is only displaying a subset of all
the messages in the mailbox. If the mailbox has never been
checked or opened, a dash will appear.
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s Favourite

A ‘diamond’ button that can be clicked to turn on or off
automatic checking of the corresponding mailbox. If the mailbox
is marked for automatic checking the button will have a check
mark:

P Indicates a mailbox not marked for automatic checking.

o Indicates a mailbox marked for automatic checking.

Mailboxes marked as favourites are automatically added to the
‘Check Favourites’ cabinet. For more information on cabinets,
see page 91.

Size

The size of the mailbox. This information is available for locally-
stored mailboxes, such as mailboxes in a POP or Local Mailbox
account, or IMAP mailboxes cached for disconnected mode
operations.

For IMAP mailboxes in connected mode, the size has to be
manually calculated. For mailboxes that have not had their size

calculated the button appears. Clicking this button will cause
Mulberry to calculate the mailbox size and then display it in place
of the button.

f Hierarchy
Display
Toggle Button

This button is only available when a cabinet or display hierarchy
Is selected. Items within cabinets and display hierarchies can be
viewed as either a flat or hierarchical list. Clicking this button
toggles between these two views.

Column headers can be re-arranged, added, or deleted.

MAc OS Hold down the command (3 ) key and click the mouse button (3 -click)
on a column header to change the column type, insert a new column, or
delete the column.

WINDOWS Click the right mouse button on a column header to change the column
type, insert a new column, or delete the column.

When you do this, the menu shown in Figure 48 will appear.
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State

Total
Column | Recent
Types Unseen

Favourite

Size
Insert and Insert Column after
Delete — Insert Column hefore
Commands Delete Column

Figure 48 The pop-up menu for changing column headers in the server window

Note: The ‘Name’ column, which displays the names of the various items
in the server window, is always present and cannot be changed or deleted.
However, you can insert columns before or after it. Additionally, the
hierarchy display toggle button cannot be changed or removed.

5.2.1.3 Mailbox List

The main purpose of the mailbox list section of the server window is to display the
various mailboxes available to you. However, depending on the number and type of
mail servers you have access to, your list of interesting mailboxes may be quite large. In
order to help you categorize and organize your mailboxes, several types of entities other
than mailboxes can be displayed in the server window. These different entities are
represented by the following icons:

Servers
P An IMAP server account.
Eﬁ An IMAP server account that is available for use in disconnected mode. This
icon is only shown when in disconnected mode.
2] A POP server account.
A Local Mailbox account.
Mailboxes
= A remote mailbox that can be opened.
E A remote mailbox that cannot be opened or that failed to open in the past.
=7 A remote mailbox that contains no new messages.
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A remote mailbox marked as interesting.

e b

A mailbox with messages stored on the local disk. This can either be a mailbox
within a POP or Local Mailbox account, or an IMAP mailbox that has been
synchronized for use in disconnected mode.

% A mailbox whose contents are only available while in connected mode.

Note: Mulberry depends on responses from the IMAP server to
decide which of the remote mailbox icons to display for a particular
mailbox. Some IMAP servers do not communicate mailbox states,
in which case the first remote mailbox icon will be used for all
mailboxes.

Cabinet

A cabinet, which stores aliases of mailboxes (see page 91).

& &

An alias to a mailbox, found within a cabinet

Mailbox ‘containers’

[ A folder, which may contain more mailboxes or other folders. Note that
unlike a mailbox, a folder does NOT hold mail messages. It is simply used as a
placeholder within a hierarchical list of mailboxes.

4 A display hierarchy, which may contain mailboxes or folders (see page 87).

& The subscribed mailbox list.

At the highest level, the mailbox list shows all of the mail servers you have defined in
the Accounts preferences panel, listed alphabetically, as well as any cabinets that you
have made visible. Within each mail account, the INBOX is shown at the top, followed
by the list of subscribed mailboxes and any display hierarchies that have been defined,
listed alphabetically.

Figure 47 shows a simple server window, with the default column headers and only
one mail server defined. There are no subscribed mailboxes, and one display hierarchy
is defined. Notice that since only one mail server account is defined in the Accounts
preferences panel, the name of the account is shown in the title bar of the server
window rather than in the mailbox list area. Because only one display hierarchy is
defined in this example, the contents of the hierarchy are displayed directly in the
mailbox list area.

A more complex server window is shown in Figure 49. The window shows multiple
mail accounts and their contents. Since multiple mail accounts are defined, the title of
the server window is simply ‘Servers’, and the contents of each server account are
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displayed under a collapsible header. The list of ‘Subscribed’ mailboxes in the third

mail account (the second IMAP account) is shown as a flat list, while the contents of the

expanded display hierarchy ‘INBOX.*" in the first IMAP account is shown as a
hierarchical list.
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Figure 49 The server window with multiple mail accounts, multiple display
hierarchies and some subscribed mailboxes
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Double-clicking on a server name will open a new window, similar to the server
window, but displaying only the contents of that mail server account. Double-clicking a
mailbox in the list will open a mailbox window containing message captions for that
mailbox (see page 111).

Note that several items in the server window, including mail servers, cabinets, and all
hierarchies can be expanded and collapsed using disclosure triangles. This allows you
to organize a complex server window to show only the mailboxes of immediate
interest.

5.2.2 Working with the Server Window

5.2.2.1 Logging In To Servers

When you open an IMAP mailbox in connected mode, Mulberry must first log in to the
appropriate IMAP server if it has not already done so. When you check for new mail in
a POP3 INBOX mailbox, Mulberry must login to the POP3 server. When a login is
necessary, the dialog shown in Figure 50 appears, allowing you to enter your user ID
and password for that server. If you wish, you can set your preferences to automatically
login to all IMAP mail servers when you start Mulberry (see page 25).

Note: Your user ID may be specified in the preferences, in which case you
will not be able to change it (as shown in Figure 50). Similarly, if you have
also set your preferences to save the password for the current account, the
Login dialog may not appear at all. In addition, some authentication
mechanisms do not require the Login dialog.

Shows the server being

logged in to The user ID for your

/ account on the server
SetUser ID & Password % EH| A warning that the caps lock

key is currently down
= Login to IMAP server: (
E‘ imap . cyrusof L. com /
User ID: daboo

caps lock
i= daown The password for your

account on the server

Figure 50 The dialog used to log in to a server

Password: |(sssssss
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The login dialog will also appear when a login is necessary for other types of servers,
such as an IMSP or ACAP preferences server. The icon in the login dialog is used to
indicate what type of account is being logged in to. The server type icons are:

For an IMAP mail server.

For a POP mail server.

4 =

For an SMTP send mail server.

i
[

For an IMSP or ACAP remote preferences server.

For an IMSP or ACAP remote address book server.

For an LDAP remote address lookup server.

i

S e e e
Il
Il

5.2.2.2 Modifying the List of Mailboxes

By default, Mulberry will always show your INBOX as the first item under each mail
server account. The INBOX is usually where your incoming mail is stored. In the case
of IMAP mail accounts, any subscribed mailboxes will be automatically displayed after
you login, in the ‘Subscribed’ hierarchy, immediately below the INBOX. Other
mailboxes and hierarchies are displayed only if you explicitly ask for them. This can be
done in two ways:

Open a mailbox directly. This is described in more detail on page 85.

Add a new display hierarchy. This is described in more detail on page 87.

5.2.2.3 Opening Mailboxes

The simplest way to open a mailbox is to double-click on the icon of the desired
mailbox in the mailbox list. Alternatively, a mailbox can be opened by selecting the

Open Mailbox option from the File menu (see page 186). When you do this, the
dialog shown in Figure 51 is displayed.

In the Open Mailbox dialog, you can enter the full pathname of the mailbox to open in
the ‘Name’ text box. If you have configured multiple mail server accounts, you can
select the account on which the mailbox exists in the ‘Account’ popup menu. Clicking
the Browse... button will produce a ‘Browse Mailbox’ window with contents similar to
the server window, allowing you to select a mailbox to open. The Open Mailbox...
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command is most useful for directly opening mailboxes that aren’t listed in the server
window.

[0 =———— open Mailhox=—"—H

Account:| imap % |

Mame:

(o]

Figure 51 The Open Mailbox dialog

Note: The server window must be the active window for the
Open Mailbox command to be active.

5.2.2.4 Display Hierarchies

Display hierarchies are a means of displaying a list of mailboxes within a particular
hierarchy. These are most useful in conjunction with IMAP servers, where mailboxes
are stored in hierarchies, but can also be used to view mailboxes in POP or Local
Mailbox accounts that you have organized hierarchically on disk.

The concept of display hierarchies are somewhat complicated by the fact that different
types of IMAP servers store mailboxes in different ways.

Some IMAP servers store mailboxes within a standard UNIX directory structure on the
server machine. For example, mailboxes can be stored in a user’s home directory
(usually denoted as ‘~/’), or in a subdirectory of the home directory, such as ‘~/mail/’.
Since IMAP servers allow mailboxes to be shared among many users, interesting
mailboxes may also exist in directories outside of a user’s home directory, such as
‘~bob/mail/public/’ or ‘~public/’.

In contrast, other types of server maintain a completely separate mail store, which is
often not directly accessible to users except through IMAP. Users can create personal
mailboxes in the INBOX hierarchy, such as ‘INBOX.work’ or ‘INBOX.friends.bob’.
Other users’ shared mailboxes may be available in a separate hierarchy such as
‘user.bob.public’.

In order for Mulberry to display the mailboxes available in a particular location on an
IMAP server, a display hierarchy must be created. In simple terms, a display hierarchy
is simply a pointer to a particular location in a mail store. For example, a display
hierarchy of ‘~/* on the first type of server described above, will list all of the available
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mailboxes in a user’s home directory. An ‘INBOX.*’ display hierarchy on the second
type of server will list all of a user’s personal mailboxes.

To simplify the process of creating display hierarchies, Mulberry provides the Display
Hierarchy dialog, which is accessed by selecting Display Hierarchy>New Display
Hierarchy... from the Mailboxes menu. This dialog, shown in Figure 52, allows you
to build a new display hierarchy using a natural language query.

Display Hierarchy ———H
Search in account [ Cyrusoft IMAP 4
for mailboxes | in sub-hierarchy % |

3 Display Full Hierarchy
@ Display Top Level of Hierarchy Only

el

Figure 52 The Display Hierarchy dialog box
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Several options are available to assist you in finding available mailboxes:

Search in account

If you have more than one mail server account defined, choose the
account you want to search using this popup menu.

For mailboxes

This popup menu specifies the pattern you wish to use to find
available mailboxes. Each of these options works in conjunction
with a string that you type in the text box below the popup menu.
Available options are:

‘whose name starts with’ — find mailboxes with names that begin
with the specified text string.

‘whose name ends with’ — find mailboxes with names that end
with the specified text string.

‘whose name contains’ — find mailboxes with names that contain
the specified text string.

‘whose name is’ — find mailboxes with names that match the
specified text string exactly.

‘in sub-hierarchy’ — find mailboxes in the hierarchy specified by the
text string

‘in entire hierarchy’ — find all mailboxes available on the specified
mail server. The text box will not accept any input if you choose
this option.

Display Full
Hierarchy

To have the full hierarchy matching the search pattern initially
displayed, choose this option. Selecting this option causes the
names of all mailboxes in the specified hierarchy to be fetched
from the server when logging in.

Note: This is only available when you are finding
mailboxes using the ‘in sub-hierarchy’ or ‘in entire
hierarchy’ options.

Display Top Level
of Hierarchy Only

To have only the top level of the hierarchy matching the search
pattern initially displayed, choose this option. Selecting this
option causes Mulberry to fetch only the names of the mailboxes at
the top level of the specified hierarchy when logging in.

Note: This is only available when you are finding
mailboxes using the ‘in sub-hierarchy’ or ‘in entire
hierarchy’ options.
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Once you have created a display hierarchy, it will be shown under the appropriate mail
server account in the server window until you delete it. To delete a display hierarchy,
click once on the hierarchy and select Display Hierarchy>Remove Display
Hierarchy... from the Mailboxes menu. To edit a display hierarchy, select Display
Hierarchy>Edit Display Hierarchy... from the Mailboxes menu. A dialog box will
appear asking you to specify a new path for the display hierarchy. To refresh the
contents of a display hierarchy, select Display Hierarchy>Refresh from the
Mailboxes menu.

Note: If there is only one display hierarchy defined for a
particular server, only the contents of that display hierarchy
will be visible. To edit or remove a single hierarchy, you need
to use the Server Details window for the server (see page 95).

Note that some display hierarchies may appear automatically under certain IMAP mail
accounts. IMAP servers that support the NAMESPACE extension (see page 12) have
the ability to advertise a list of interesting display hierarchies to a mail client. Mulberry
will automatically list these display hierarchies if the ‘Automatic Hierarchy List’ option
(see page 25) is turned on for a particular IMAP mail account.

5.2.2.5 Creating, Renaming, and Deleting Mailboxes

Once you have customized the mailbox list in the server window, you may want to
create your own mailboxes under one or more mail server accounts. You can create a
new mailbox by choosing Create from the Mailboxes menu or by clicking the

Create button in the server window tool bar. When you do this, the dialog shown in
Figure 53 is displayed.

You can choose to enter the full pathname for the new mailbox (e.g. ‘INBOX.newbox’ or
‘~/mail/newbox’) by clicking the Full Pathname button. You can also choose to create
the mailbox in an existing hierarchy by clicking the Create in Hierarchy button. In
this case just enter the name of the mailbox (e.g. ‘newbox’). You can choose to have the
server automatically subscribe to the new mailbox by selecting the Subscribe when
Created checkbox. When you create a new mailbox, Mulberry will automatically insert
it in the correct location in the server’s mailbox list and also open an empty mailbox
window for the new mailbox.
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Create Mailbox=——H

Mailbox Name:

i3 Full Pathname
i@ Create in Hierarchy:

INBOX.

in Account: |[imap

[] Subscribe when Created

|Eance|| | oK I

Figure 53 The dialog used to create a new mailbox on the server

The default selections in the Create Mailbox dialog will vary depending on the item
you had selected before executing the Create Mailbox command. For example, if you
click on a display hierarchy in the server window and then create a new mailbox, the
dialog assumes you meant to create the new mailbox in that hierarchy. If you click on a
server name in the server window and then create a new mailbox, you will only be able
to specify the new mailbox name using a full pathname.

5.2.2.6 Cabinets

Cabinets provide a powerful mechanism for grouping sets of mailboxes together. In
simple terms, a cabinet is a collection of aliases to different mailboxes. The server
window displays cabinets at the top of the mailbox list section, before any mail servers
or mailboxes. Cabinets can not be displayed in individual server windows, only the
main server window. You can control which cabinets are displayed using the Cabinet
popup menu in the server window tool bar. To display a cabinet, click on the Cabinet
popup menu and select a cabinet name. Cabinets that are currently displayed have a
check mark in front of their name. To hide a cabinet, click on the popup menu and
select the appropriate cabinet name again. Figure 54 shows the server window with
three cabinets displayed:
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Figure 54 The server window with cabinets displayed

Mulberry comes with several pre-defined cabinets. You can also create as many of your
own cabinets as you like. The pre-defined cabinets that come with Mulberry are:

Check Favourites This cabinet contains a list of mailboxes marked for automatic
checking. This cabinet is used by the first alert style by default
(see page 35).

Open After Login This cabinet contains a list of mailboxes that Mulberry should
open automatically after starting up.

Copy Messages To This cabinet contains a list of mailboxes that will appear in the
Copy To popup in the Message window or the Copy to
Mailbox sub-menu under the Messages menu. Note that
the contents of this cabinet are only used if the ‘Use Copy
Messages To Cabinet’ option is checked in the Mailbox
preference panel (see page 47).

Copy Drafts To This cabinet contains a list of mailboxes that will appear in the
Copy To popup in the Draft window or the Append to
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Mailbox sub-menu under the Draft menu. Note that the
contents of this cabinet are only used if the ‘Use Copy Drafts To
Cabinet’ option is checked in the Mailbox preference panel (see

page 47).

Mark Seen on Close Mailboxes listed in this cabinet will automatically have all
messages marked as seen when their mailbox windows are
closed.

Auto Synchronise This cabinet contains a list of IMAP mailboxes that will be

synchronized automatically when switching between
connected and disconnected modes. For more information on
disconnected mode operations, see page 104.

New Messages This cabinet contains a list of all mailboxes that have been
marked for automatic checking, AND have been found to
have new messages since they were last opened. This is a fast
and convenient way to display a list of only those mailboxes
that have new messages to be read. This cabinet is an example
of an ‘automatic’ cabinet that is maintained by Mulberry. The
contents of this cabinet can not be changed directly.

Subscribed This cabinet contains a list of all mailboxes marked as
subscribed in all IMAP mail accounts.

Cabinets can contain mailboxes from multiple mail servers. When multiple mail
server accounts are defined, Mulberry will prepend the server name and a colon (:) to
the mailbox names within a cabinet. The contents of cabinets are always sorted, first by
server name and then either alphabetically or hierarchically.

To add a mailbox alias to a cabinet, first make sure the cabinet is visible at the top of the
server window. Then, simply find the mailbox(es) that you wish to add to the cabinet
and drag the icon for the mailbox(es) onto the appropriate cabinet icon. Mulberry will
add an alias to the appropriate mailbox to the selected cabinet.

To remove a mailbox alias from a cabinet, highlight the mailbox alias you wish to
remove and press the delete key on your keyboard or choose Cabinets>Remove Item

from the Mailboxes menu. Removing a mailbox alias just removes that item, it does
not delete the mailbox that it refers to.

Note: You cannot change the contents of the ‘New Messages’
cabinet. The contents of this cabinet are managed automatically
by Mulberry.

To create your own cabinet, select New ... from the Cabinet popup menu or select
Cabinets>New Cabinet... from the Mailboxes menu. Mulberry will prompt you
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for a name for the new cabinet. User-defined cabinets are listed after the pre-defined
cabinets in the order that they are created. You can create as many cabinets as you like.

In addition to individual mailbox aliases, cabinets can also contain ‘wildcard’ items.
These items allow you to quickly add the contents of an entire mailbox hierarchy to a
cabinet. For example, you might want all of the folders in your INBOX hierarchy to
appear in the ‘Copy Messages To’ cabinet. One way to set this up would be to select all of
the folders in your INBOX hierarchy and drag them to the ‘Copy Messages To’ cabinet.
Unfortunately, if you were to then create a new mailbox in your INBOX hierarchy, you
would have to remember to also add that new folder to the ‘Copy Messages To’ cabinet.
An elegant solution for this problem is to place a single wildcard entry for the
‘INBOX.*" hierarchy into the ‘Copy Messages To’ cabinet. ‘Wildcard’ entries are dynamic
— every time they are needed, the full list of matching mailboxes is determined and
substituted for the ‘wildcard’ entry. Thus any changes to the mailbox hierarchy will
always be picked up by the ‘wildcard’ entry.

To add a ‘wildcard’ entry to a cabinet, click once on the appropriate cabinet and select
Cabinets>New Wildcard Item... from the Mailboxes menu. You will be presented
with a dialog box like the one in Figure 55.

CabinetEntrylist=—————H
hMatch mailboxes in account [ All )
anywhere in hierarchy #]

el

Figure 55 Cabinet wildcard item dialog box

The options in this dialog box are very similar to those in the Display Hierarchy dialog,
described on page 87.

You can modify a wildcard item within a cabinet by clicking once on the wildcard item
and selecting Cabinets>Edit Wildcard Item... from the Mailboxes menu, or by
double-clicking on the wildcard item. A dialog box will appear, allowing you to specify
a new path for the wildcard item.

Note that the mailbox aliases within a cabinet function in a manner very similar to the
actual mailboxes they represent. Double-clicking on a mailbox alias will open a separate
mailbox window for the associated mailbox. If you attempt to remove a cabinet item
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using the Delete... command from the Mailboxes menu, you will be asked whether
you want to delete the mailbox alias or the actual mailbox associated with the alias.

5.2.2.7 Closing the Server Window

Clicking the close box on the server window will automatically log you out from any
IMAP servers. A dialog box will also appear asking if you would like to quit Mulberry,
or just hide the server window. Mulberry will not operate without the server window,
so the window will only be hidden if you choose to close the window.

Note: Logging out of an IMAP server will close all mailbox and
message windows that belong to that server.

To see the server window again, select the appropriate item from the Windows menu
(see page 202), which contains a list of all available windows.

Note: Since the server window is hidden, its name appears in
brackets in the Windows menu.

The location and size of server windows are saved in any existing current preferences
file when Mulberry is closed, and then restored from that preferences file if it is used to
launch Mulberry again.

5.2.3 Getting Information on Mail Servers

Mulberry allows you to view detailed information on the various mail servers you
have configured in your Accounts preferences. This information will be of most
interest to experienced users and system administrators.

To get information on a server, click once on the server name in the server window
and click the Details button in the server window tool bar, or select Properties... from
the Edit menu. The dialog shown in Figure 56 will appear. The dialog shows the name
of the server, the type of the server recognized by Mulberry, the ‘Greeting’ text, and the
‘Capability’ text.

The name is just the Internet address of the server.

The type indicates which mail protocol Mulberry is using to communicate with the
server. This will depend on what versions the server supports, and will be one of
‘POP3’, ‘IMAP2bis’, IMAP4’ and ‘IMAP4revl’.

The greeting is the first line of text sent back by the server when first contacted by
Mulberry. It sometimes gives details about the manufacturer and version of the
server software.

The capability text is the information returned by the server when Mulberry
requests information about what commands and extensions the server supports.
This usually indicates the version of the IMAP protocol the server is using (e.g.
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‘POP3’, ‘IMAP2bIs’, ‘IMAP4revl’ etc.) and any extensions that the server supports
(e.g. ‘ACL’ or ‘QUOTA’). This information is useful when trying to track down
problems with the server, or making sure you are connected to the right server.

The hierarchies text appears if only one display hierarchy is defined for the selected
server. You can edit or remove the hierarchy path in this window. See page 87 for
more information on display hierarchies.

Hame : | imap.cyrusoft. com |

Tupe: | IMAF e |

Gresting: [+ OK darius.cygrusoft.com Cyrus -
IMAF4 w1.5.2 =server ready |

Capabi i ty: |[IMAP4 [MAP4r=w1 ACL OUOTA LITERAL+ |
X=MOM-H | ERARCH | CAL-FRENAME

Hierarchies: | IMBOY . |

Figure 56 The server properties dialog box
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5.2.4 Getting Information on Mailboxes

Detailed information is also available for individual mailboxes. To get information on
a mailbox, click once on the mailbox and click the Details button in the server window
tool bar or select Properties... from the Edit menu. You will be presented with the
Mailbox Properties dialog box, which is shown in Figure 57.

The Mailbox Properties dialog can have up to four different panels displaying different
information about the mailbox. The four possible panels are:

Options
Details
Access *
Quota *
Mailbo; INEOX =]
Detalls
Heme! |IHEOY | @
Ehoptions Sarwer: [Irag.ogdgot T, eon |
Hierarchg: | |
et [
Hezmages!

Total = Amcemntz Unzmen & Onlmted:?

Sl | 1450 |-c|| Colculate i

Stobu=! | Opee |
UID Wl idi g [earareae |
Egachronlmed! (1251 /00 11 242 -5a0 |

Click button here Different panels
to see a different are shown here
panel

Figure 57 The Mailbox Properties dialog showing the ‘Details’ panel

* Note: The ‘Access’ and ‘Quota’ panels are only available
when you are communicating with an IMAP mail server that
supports the ACL or QUOTA extensions, respectively.
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5.2.4.1 Mailbox Properties: Options

Options @

[#] Check for Mew Mail with style: [ INBOXes — ]
[[] Open after Login
[] U=se for Copying Messages

[JUse for Drafts or Sent Messages
[] Mark Seen on Close

Eﬁgnchrnnise on Oisconnect

ldentity
[ Tie to Identity

Identitg:[ Mulberry Support - ]

Figure 58 The Mailbox Properties ‘Options’ panel

This panel allows you to set several different options for a given mailbox. The available
options are:

98

‘Check for New Mail with style’:  If turned on, the mailbox will be checked for
new messages at the interval specified by the alert style selected in the popup (see
page 35).

‘Open After Login’:  This option tells Mulberry to automatically open this mailbox
after the program is launched and you have successfully logged into the IMAP
server containing the mailbox.

‘Use for Copying Messages’: This option lets you add the selected mailbox to the list
of mailboxes used in the ‘Copy To’ menu in the Message window.

‘Use for Drafts’: This option lets you add the selected mailbox to the list of mailboxes
used in the ‘Copy To’ menu in the Drafts window.

‘Mark Seen on Close’: This option tells Mulberry to automatically mark all
messages in the selected mailbox as seen when you close the mailbox window.

‘Synchronise on Disconnect’:This option tells Mulberry to automatically add the
selected mailbox to the list of mailboxes that will be synchronised when
disconnecting.

‘Tie to Identity’: If turned on, the identity chosen in the popup menu will be ‘tied’ to
the selected mailbox. When creating new drafts, or replying to messages in the
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selected mailbox, Mulberry may automatically select the ‘tied’ identity in the new
draft window. For more information on tied identities see page 156.

5.2.4.2 Mailbox Properties: Details

Details o
Mame: || HEOX | =

Serwer | i map .cyrusof t.ocom |

Hierarchy: | |

Hierarchy
Separator: D

Messages:

Total : Recent: Unseen: Deletad:
Size:! Calculate

Status: |III|:-er'|
U0 Yalidity: |257418961
Synchronised: [12/30,/09 16:31 -B504 |

Figure 59 The Mailbox Properties ‘Details’ panel

The items in this panel are:
‘Name’ The full pathname of the mailbox.
‘Server’ The Internet address of the server on which this mailbox is located.
‘Hierarchy’ The hierarchy that the folder belongs to, if any.

‘Hierarchy Separator’ The character that signifies a new level of hierarchy in the
mailbox name.

‘Messages’
— ‘Total’ The total number of messages in the mailbox.

— ‘Recent’” The number of new messages in the mailbox the last time it was
checked. This is the number of messages that have arrived since the
last time the mailbox was open.

— ‘Unseen’ The number of unseen messages in the mailbox the last time it was
checked, or, if the mailbox is open, the current number of unseen
messages in the mailbox window. This last value may be different
from the total number of unseen messages in the mailbox if the
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mailbox window is only displaying a subset of all the messages in the
mailbox.

— ‘Deleted” The number of messages marked as deleted in the mailbox, if open. If
the mailbox is closed this value will be empty.
‘Size’ Shows the size of the mailbox in bytes.
‘Calculate’ Clicking this button causes the mailbox size to be re-calculated.
‘Status’ Shows various status information about the mailbox:
‘Open’ Indicates that the mailbox is open and has a window on-screen.
— ‘Subscribed’ Indicates that the mailbox is subscribed to.

— ‘No Hierarchy’ Indicates that the mailbox does not have a sub-hierarchy.

— ‘Cannot Open’ Indicates that the mailbox cannot be opened.

— ‘Interesting’ Indicates that the server has marked the mailbox as ‘interesting’.

‘UID Validity’ A number that is unique to this mailbox and provided by the
server. This value is only available for IMAP4 and later version servers.

‘Synchronised’ Shows the date and time that the IMAP mailbox was last
synchronised with a disconnected mailbox on this machine.
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5.2.4.3 Mailbox Properties: Access

Access Control List

Mai lbn:-:-:::[ Cyrusaftiuser.press — ] Key
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Figure 60 The Mailbox Properties ‘Access’ panel

The *Access’ panel displays information about the access control list for the mailbox or
mailboxes being examined in this dialog. The access control list for the mailbox chosen
in the ‘Mailbox’ popup is displayed in the dialog. To see the access list for other
mailboxes being examined, choose them via the popup menu.

The access control list is the list of users who have ‘rights’ to the mailbox. For
mailboxes, there are a total of nine ‘rights’ that can be applied to each user. These are:

Q, ‘Lookup’ - if set, the user is able to see the mailbox if they attempt to list it.
‘Read’ - if set, the user is able to read messages in the mailbox.

B ‘Seen’ - if set, each user can mark a message as seen without affecting other
users.

Fi ‘Write’ - if set, the user can change any message flag except the delete flag.
%J ‘Add’ - if set, the user can add messages to the mailbox by copying them in.

@ ‘Post’ - if set, the user is able to send mail directly to the mailbox. This capability
is only available if supported on the server.

@ ‘Create’ - if set, the user can create sub-hierarchies of mailboxes below the
mailbox.
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& ‘Delete’ - if set, the user can delete and expunge messages from the mailbox.

% ‘Admin’ - if set, the user is able to change the access control list for the mailbox.

The rights that you have to the mailbox are shown in the ‘Current User:’ row at the top
of the access control list table. All users’ rights are then shown in the table below this.
Each row consists of a user id, followed by nine icons or buttons representing the state
of the right for that user:

@ A button indicating that this right is turned off for the user, but it can be
changed by clicking it.

# A button indicating that this right is turned on for the user, but it can be
changed by clicking it.

#* Anindication that this right is turned off for the user, but it cannot be changed
because you do not have the rights to do so.

“  An indication that this right is turned on for the user, but it cannot be changed
because you do not have the rights to do so.

When you have the right to change ‘rights’ for the mailbox, you can do so by clicking

one of the ‘diamond’ buttons in the list. To change the ‘rights’ for more than one user
at a time, select all their user ids and click a diamond button with the option key held
down.

To delete one or more users from the access control list, select their user ids in the list
and click the ‘Delete’ button. To create add rights for a new user, click the ‘New User...’
button. This will display the dialog shown in Figure 61. This allows you to enter any
number of user ids, one on each line, and choose a set of ‘rights’, by clicking the buttons
below the list, to apply to all the users that you enter.
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Figure 61 The dialog used to add new users to an access control list

You can create a set of ‘rights’ as a style to quickly apply frequently used ‘rights’. To
create a new style:

Select a user id with the set of ‘rights’ to use.
Click the ‘Style’ pop-up menu and choose ‘New Style...’.

Enter your chosen name for the new style in the resulting dialog.

The new style will be added to the end of the ‘Style’ pop-up menu list. To apply a style,
select one or more user ids in the access control list and then select the required style
from the ‘Style’ pop-up menu.

When there is more than one mailbox being examined, you can apply the rights for the
current mailbox selected in the ‘Mailbox’ popup to all the others by clicking on the

‘Apply to All’. This provides a convenient and quick way to copy rights from one
mailbox to others.
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5.2.4.4 Mailbox Properties: Quota

Quota

Name Current HMaximum |'% Used

= user drny
STORAGE =1 5000 1%

Figure 62 The Mailbox Properties ‘Quota’ panel

The ‘Quota’ panel displays information about the available quota for the mailbox. This
is a hierarchical list of ‘quota roots’ and quota values. In the example in Figure 62,
‘user.vince’ is a ‘quota root’, and ‘STORAGE’ a quota value. For each quota value, the
current and maximum values are shown together with the percentage used. The units
of the values are determined by the type of quantity being described. Thus for
‘STORAGE’ the units will probably be Mb of disk use, for ‘MESSAGES’ the units will be
number of messages.

5.2.5 Disconnected Mode Operations

Messages in remote IMAP mailboxes can be cached locally for use when the computer
running Mulberry is not connected to a network. These messages can be read and
otherwise manipulated in the normal manner, and any changes made to messages
while in disconnected mode will be reflected in their online counterparts the next time
a network connection is made. This is known as disconnected mode operation.

In order to use an IMAP mailbox in disconnected mode, you must first synchronize
that mailbox with a local cache. There is some preparation necessary before IMAP
mailboxes can be synchronized for disconnected use:

- The IMAP account that contains the mailboxes to be used in disconnected
mode must have the ‘Allow Disconnected Operations’ preference option
enabled (see page 25).
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- The IMAP mailboxes to be synchronized must be identified. For mailboxes
that will be synchronized on a regular basis, the easiest way to do this is to
add the desired mailboxes to the ‘Auto Synchronise’ cabinet (see page 91).
A mailbox can also be chosen for synchronisation using the Options tab of
the Mailbox Properties dialog (see page 98).

5.2.5.1 Disconnecting

To switch Mulberry into disconnected mode, select the Disconnect... item from the
File menu. The Disconnect Options dialog, shown in Figure 63, will appear.

Disconnect Options=—"——H

When Disconnecting:

3 Synchronise All Messages
i@ Synchronise New Messages
3 Mo Message Synchronisation

[ Synchronise Mailbox Lists
[ Send Queued Messages First
[ Synchronise Bemote Address Books

Message Synchronisation:

@ Entire Message
_» Entire Message below: (10 KB
2 First Displayable Part Only

= Hide Mailbox Information | cancel |

Add Cabinet: (%] | Add.. || Clear |

CHU Z T HEOX,
Cyrusoftl IHBOX

Total:z Done i@ Mes=sages:iH

Figure 63 The Disconnect Options dialog
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The Disconnect Options dialog provides the following options:

Synchronise All
Messages

Selecting this option causes all messages in each mailbox to be
synchronised. Any messages already synchronised will have their
flag state updated and messages removed from the IMAP server will
be removed from the disconnected cache. New messages on the
IMAP server not already in the disconnected cache will be
downloaded.

Synchronise New

Selecting this option causes only new messages in each mailbox to

Messages be synchronised. Only messages on the IMAP server that are not
already in the disconnected cache will be downloaded. Other
messages in the disconnected cache will not be touched.

No Message When this option is selected, no message synchronisation takes

Synchronisation

place.

Synchronise
Mailbox Lists

This option causes a list of all defined mailboxes to be cached for use
in disconnected mode. When a mailbox list is cached for
disconnected use, all display hierarchies will be navigable as they are
while in connected mode.

Send Queued
Messages First

This option causes pending messages in the outgoing queue to be
sent before going into disconnected mode.

Synchronise
Remote Address
Books

This option causes remote IMSP or ACAP address books to be
cached for disconnected use. Address books to be synchronised
must be specified in the ‘General’ panel of the Address Book
Properties dialog (see page 168) and their address account must be
marked for disconnected operations (see page 32).

Entire Message

When this option is selected, the entire contents of each message
(header and all parts) will be downloaded and available in
disconnected mode.

Entire Message
Below nn

When this option is selected, only those parts of a message with a
total byte count below the specified number will downloaded. This
means that some messages in the disconnected cache may only be
‘partial’. Such messages can be ‘fully’ downloaded at a later date to
bring all parts into the disconnected cache as required.

First Displayable

When this option is selected, only the first text part that would be

Part Only shown in the message window is downloaded. As with the
previous option, this results in a partial message in the
disconnected cache.
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The bottom portion of the dialog displays the mailboxes to be synchronised. By default,
the contents of the *Auto Synchronise’ cabinet are listed (see page 91). The contents of
other cabinets can be quickly added using the Add Cabinet popup menu. To add one
or more individual mailboxes, click the Add... button. To remove mailboxes, select
them and hit the delete key. To clear the entire list of mailboxes, click the Clear button.

When all disconnected options are set as desired, click the OK button to begin the
synchronisation process. The bottom line of the dialog gives status information on the
progress of synchronisation, including the total number of mailboxes to be
synchronised, the number completed, and the total number of messages synchronised.

After synchronisation has completed, Mulberry will terminate all active connections to
IMAP, IMSP, and ACAP servers. Once this is complete, the Disconnected Options
dialog will disappear and Mulberry will be in disconnected mode. In this state, it is safe
to remove any network connection.

5.2.5.2 Connecting

To return to connected mode, select Connect... from the File menu. A dialog, shown
in Figure 64, similar to the Disconnect Options dialog will appear.

Disconnect Options =——— H

YWhen Connecting:

@ Stay Connected
3 Update then Disconnhect

[ Synchronise Offline Changes
Lipdate POP3 Accounts

[+ Send Queued Messages

[ Synchronise Remote Address Books

Message Synchronisation:

s Entire Message
Entire Message below: |10 KB

First Displavable Part Only
(Goncer )

Figure 64 The Connect Options dialog
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Many of the options in this dialog are similar to those in the Disconnect Options dialog.
However, several new options appear, including:

Stay Connected Selecting this option causes Mulberry to stay in connected mode
after performing any specified synchronisation.

Update then When this option is selected, Mulberry will perform any specified

Disconnect synchronisation options and then return to disconnected mode.

Synchronise When this option is selected, any changes made to messages in

Offline Changes disconnected mailboxes will be synchronised with the equivalent
messages in online IMAP mailboxes.

Update POP3 When this option is selected, Mulberry will check any POP3

Accounts accounts listed in the server window for new messages while in
connected mode. This option is only available when the ‘Update
then Disconnect’ option is selected.

Send Queued This option causes pending messages in the outgoing queue to be

Messages sent. When using the ‘Update then Disconnect’ option, Mulberry
will wait until all messages in the outgoing queue have been sent
before automatically disconnecting.

Synchronise When this option is selected, any changes made to addresses in
Remote Address  disconnected address books will be synchronised with the
Books equivalent address in online address books.

When using the ‘Update then Disconnect’ mode, the mailbox list used in the
Disconnect dialog will be available to allow you to specify which mailboxes should be
synchronised before the disconnect.

5.2.5.3 Manual Synchronisation

When Mulberry is in connected mode, individual mailboxes can be synchronised
without switching into disconnected mode. To do this, either select a mailbox in the
server window or open a mailbox and view its captions in a mailbox window, and then
select Synchronise... from the Mailboxes menu. The Synchronise dialog, shown in
Figure 65, will appear.
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synchronise——=H

Mailbox:

3 All Messages
) New Messages
@ Selected Messages

Messages:

@ Entire Message
) Entire Message below: |10 KB
3 First Displayable Part Only

|Cance|| | oK I

Figure 65 The Synchronise dialog

All of the options in this dialog are similar to the options found in the Disconnect
Options dialog, except for the ‘Selected Messages’ option. This option allows you to
synchronise only a selected list of messages in a particular mailbox. For this option to
be available, you must first double-click on a mailbox to open it, select one or more
messages, and then select the Synchronise... menu option.

5.2.6 Reference
OPERATIONS ON ITEMS IN THE SERVER WINDOW

To open one or more Pressret urnor ent er on the
selected mailboxes keyboard.

Double-click any one of the
selected mailboxes.

To open a mailbox that does  choose Open Mailbox from
not appear in the server list the File menu.

To see information about the Choose Properties from the

selected mailbox Edit menu or press
Command-I (Mac OS) or
Ctrl-1 (Windows).
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To create a new mailbox on
the server

Choose Create from the

Mailboxes menu or click the
create button in the server

window.
To rename one or more Choose Rename from the
selected mailboxes Mailboxes menu.
To delete one or more Choose Delete from the

selected mailboxes

Mailboxes menu.

To subscribe to one or more
selected unsubscribed
mailboxes

Choose Subscribe from the
Mailboxes menu or press
Command-= (Mac OS) or
Alt-= (Windows).

To unsubscribe from one or
more selected subscribed
mailboxes

Choose Unsubscribe from
the Mailboxes menu or press
Command-- (Mac OS) or
Alt—-- (Windows).

To check for new messages
in one or more selected
mailboxes

Choose Check Mail from the
Mailboxes menu or press
Command-L (Mac OS) or
Ctri-L (Windows).

To check the set of mailboxes
marked for automatic
checking

Choose Check Favourites
from the Mailboxes menu or
press Shift-Command- L

(Mac OS) or Shift-Ctrl-L
(Windows).
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5.3 Mailbox Window

The name of the mailbox
associated with this

) window . .
Category List of Sort direction
titles messages button
|\ \ | \
Cyrusoft:INBOX —————HIB
\
= 7g v e (3) [
elect.@
Diaft  Rep Forward Telete Expunge Search
P ™ From: / To: K | Date Sent: | Thread: X
- |
2 13 M Matthew Wall 25400 19:28 -0... PS
TE 4 Cyrus Daboo 2/850011:19 -0, Web pages
4 3 8 Matthew wall 259001747 -0... ETA an store?
S E M Matthew wall 2/950018:27 -00. silkymail graphic
6l Matthew wall 2/950019:26 -0, home page suggestion
7E A Matthew wall 210400 16:54 - .. applying Sieve to Cyrusoft |a
g A Matthew wall 2/11/00 19:19 - prices as you requested ||
fleé  1z/12  |&Fe K EXTI| K
1 \ S S S

\ \ \\
Mailbox  Number of Total number Number of Number of Number of

write cached of messages unseen deleted matching
status messages messages messages  messages

Figure 66 A mailbox window showing all available messages in the mailbox

Figure 66 shows a typical mailbox window. Mailbox windows show a list of messages in
the corresponding mailbox (the window title is the name of the mailbox). The window
is divided into four main sections:

The Header section contains several buttons and popup menus used to perform
actions on messages in the window.

The Column Headers section indicates which information from a message is
displayed in the corresponding column and which category is used to sort the
messages.

The Message List section shows all the requested categories of information about
each message sorted according to your preference.
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The Mailbox Information section at the bottom of the window lists important
information about the mailbox. The first icon indicates whether the mailbox can be
changed by you (read-write permission) or whether you can make no changes (read-
only permission). The two icons are:

- ¥ Indicates read-write permission - you can do almost anything to a message.

- % Indicates read-only permission - you can read messages, but you may not be
able to delete or expunge them, or change particular flags.

If a mailbox has read-only permission you will not be able to delete or expunge any
messages, or copy any messages into the mailbox. You may be able to set some of the
flags (see page 127) for messages in the mailbox, but this depends on your permission to
do so as determined by the server. If you do not have enough permission to change a
flag, an error message from the server will be displayed when you try to do so.

A choice of options set in the ‘Mailbox’ preferences (see page 44) allows mailbox
windows to be opened either at the start or end of the message list or with the oldest
new message in the list selected and displayed.

The next icon to the right is a button that allows you to jump directly to a particular
message number, or to quickly cache all of the header information for messages in the
current mailbox. The next set of numbers tells you the number of message that
currently have cached header information (the first number) and the total number of
messages in the mailbox (second number). Header caching is described in detail on page
127.

The next two icons indicate the number of unseen messages, and the number of
messages marked for deletion, respectively. Note that these two numbers include
information only on messages that are currently cached.

The final icon indicates the number of messages that match the current ‘Match’ criteria.
Matching is described in detail on page 113.

5.3.1 Header

The header contains several buttons on the left side for performing various actions on
messages in the current mailbox. Menu commands that carry out the same actions are
also available (see page 56).

* The Draft button allows you to quickly open a new Draft window and start
composing a new message.

* The Reply button opens a new Draft window and allows you to compose a reply to
the currently selected message. Information from the message you’re replying to is
automatically included in the new Draft window. This button is only available if a
message is selected in the Mailbox window.

e The Forward button opens a new Draft window and allows you to forward the
currently selected message to another person. The text of the message you’re
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forwarding is automatically included in the new Draft window. This button is only
available if a message is selected in the Mailbox window.

 The Delete button allows you to mark the currently selected message(s) for
deletion. The Delete button has three states depending on what is selected.

* If no messages are currently selected in the mailbox window then the Delete
button is not active.

* If one or more selected messages are not deleted then the Delete button is off
and clicking on it will delete the undeleted messages in the selection.

» If all the selected messages are deleted, then the button title changes to Undelete
and it is in the on state. Clicking the button now will undelete the selected
messages.

Note If you delete a single message, Mulberry will
automatically select the next message after the one deleted (if
one exists).

* The Expunge button allows you to permanently remove any message(s) currently
marked for deletion. The Expunge button is only available when there are some
deleted messages in the mailbox.

The right-hand side of the header section provides you with different ways to filter the
list of messages in the mailbox and search for specific messages of interest. Searching
and matching are covered later in this section. The upper right corner of the header
displays an icon that indicates the connected/disconnected status of the mailbox.
Possible icons include:

@ An online (IMAP) mailbox

n A POP3 or Local mailbox

ﬂé An online (IMAP) mailbox that has been synchronized and is being used in
disconnected mode.

5.3.1.1 Matching

Mulberry’s matching feature provides a quick and easy way to select or display only
messages of interest within a mailbox window. There are two buttons and two popup
menus located in the Header section of the mailbox window that control this
functionality. By default, each mailbox window displays ‘All’ messages that are
available when opened. You can choose to limit this list of messages by constructing a
match pattern and clicking the ‘Match’ button. The popup menu next to the Match
button allows you to construct a match pattern by choosing from the following options:
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Hone

Last Search Results
Update

Construct Search..

Hot
- O
Arnd

Hew

« Unseen
| mportant
Arnzwered
Oeleted
Oraft

Sent Today

Sent since Yesterday
Sent this He=k

Sent within 7 Days

Sent by Mea
Sent to He
Sent to List

Selected To Addresses
Selected From Addresses
Selected Correspondents
Selected Subjects
Selected Dotes

Figure 67 The Match Criteria popup

A match pattern is constructed from one or more message characteristics and a boolean
operator. For example, you might wish to display only a list of new messages from the
last 7 days. To do this, you would select ‘And’ as your boolean operator, select the ‘New’
and ‘Sent within 7 Days’ options, and click the Match button. The list of messages in
your mailbox window is then filtered to display only those messages meeting the
criteria you specified. To resume viewing all of the available messages in the mailbox,
click the All button.

The following chart describes each available matching option in depth:

None This option allows you to quickly unselect all current matching
criteria for this mailbox.

Last Search This option tells Mulberry to use the results of the last search on

Results this mailbox as its matching criteria. For more information on

searching, see page 117.
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Update

This option tells Mulberry to check the current mailbox again for
messages meeting the current matching criteria. This is useful when
new messages have come in to a mailbox, or when additional
messages in the mailbox have been cached since a match was
originally constructed.

Construct Search

This option opens the search window and uses the current
matching criteria as the search criteria.

Not Boolean operator that matches messages which do NOT meet the
currently selected criteria.

Or Boolean operator that matches messages which meet one or more of
the currently selected criteria.

And Boolean operator that matches messages which meet ALL of the
currently selected criteria.

New Matches any message that is new.

Unseen Matches any message that is unseen.

Important Matches any message that is important.

Answered Matches any message that has been answered.

Deleted Matches any message that is marked for deletion.

Draft Matches any message that is a draft.

Sent Today Matches any message that was sent today.

Sent since Matches any message that was sent either today or yesterday.

Yesterday

Sent This Week

Matches any message that was sent this week.

Sent within 7 Matches any message that was sent within the last 7 days.

Days

Sent by Me Matches any message that was sent by you.

Sent to Me Matches any message that was sent to you.

Sent to List Matches any message that was sent to a list of people.

Selected to Matches any message with the same ‘To:” address as the currently
Addresses selected message(s) in the mailbox window.

Selected From
Addresses

Matches any message with the same ‘From:’ address as the currently
selected message(s) in the mailbox window.
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Selected Matches any message with the same ‘To:” or ‘From:” addresses
Correspondents (excluding your own) as the currently selected message(s) in the
mailbox window.

Selected Subjects  Matches any message with the same subject as the currently selected
message(s) in the mailbox window.

Selected Dates Matches any message that was sent on the same date as the currently
selected message(s) in the mailbox window.

The last five options above act on one or more currently selected messages within the
mailbox window. You can select one or more messages manually from the mailbox
window that have the characteristics you’re looking for. Alternatively, the ‘Select’
popup menu in the header section of the mailbox window allows you to quickly
highlight groups of interesting messages within the mailbox window:

Seen

Uh=seen

| mportant
Urii mportant
Anzswerad
Unanswerad
Deleted
Uhdeleted
Draft

Mot Draft

Matching
Moh—-matching

Figure 68 The ‘Select’ popup menu

The following table describes each of the available selection options in depth:

Seen Selects messages that have been seen.

Unseen Selects messages that have not been seen.
Important Selects messages that are important.
Unimportant Selects messages that are not important.
Answered Selects messages that have been answered.
Unanswered Selects messages that have not been answered.
Deleted Selects messages that are marked for deletion.
Undeleted Selects messages that are not marked for deletion.
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Draft Selects messages that are drafts.

Not Draft Selects messages that are not drafts.
Matching Selects messages that meet the current match criteria.
Non-Matching Selects messages that do not meet the current match criteria.

5.3.1.2 Searching

Mulberry provides robust message searching capabilities. Using the search window, you
can find email messages meeting multiple criteria. You can search for messages in one
or several different mailboxes. You can even save searches and reuse them later. The
Message Search window, shown below, is the interface to this powerful functionality:

[ =————Message Sparch=—"—H

Search Set: @

— Find Messages whose

[ From Address = ] [ Contains - ] [cyruzaft |
and —

[ gize 4 | [ Is Greater Than | & ] [ | | HE |

[ More Choices I [ Fewer Choices I [ﬁ]

[* Show Mailbox Information

Total ;7 Found: O Mes=sages=s: 0

Figure 69 The Message Search window

The top section of the window allows you to set one or more email message attributes
to search. By default, the Search window is configured to search on one attribute. To
add more attributes, click the More Choices button. To decrease the number of
attributed to search on, click the Fewer Choices button. The message attributes that
can be searched are:
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® From Address
To Addre=s=
CC Addres=s
BCC Addres=s
Recipient
Correspondent
Oate Sent
Oate Receiwed
Subject
Body
Header Field
Entire HMessage
Size

Fecent Flag
Seen Flag
Ar=swered Flag
Impor-tant Flag
Ozleted Flag
Oraft Flag

Search Set

Figure 70 The Search Attributes popup menu

From Address

The ‘From’ address of the message.

To Address The ‘To’ address of the message.
CC Address The ‘CC’ address of the message.
BCC Address The ‘BCC’ address of the message.
Date Sent The date the message was sent.

Date Received

The date the message was received.

Subject The subject text of the message.
Body The body text of the message.
Header Field The header text of the message.

Entire Message

The entire message, including all headers and the message body.

Size The size of the message.
Recent Flag The recent flag of the message.
Seen Flag The seen flag of the message.

Answered Flag

The answered flag of the message.

Important Flag

The important flag of the message.

Deleted Flag

The deleted flag of the message.
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Draft Flag The draft flag of the message.

Search Set This option allows you to select a previously saved set of search
criteria in order to combine it with one or more other criteria.

Once you have selected a message attribute to search, you must set certain criteria to
search on. The available criteria vary with the different attributes. When you select a
text field, such as the ‘To’, ‘From’, ‘CC’, or ‘BCC’ addresses, or the message Subject or
Body, you can choose from the following criteria:

sContains

Ooes not Contain
l= HMe

Iz not HMe

Figure 71 Text Search Criteria

Contains The selected field contains the following text.
Does not Contain  The selected field does not contain the following text.

Is Me The selected address field contains my email address. This option
will only be available if an address field is selected.

Is not Me The selected address field does not contain my email address. This
option will only be available if an address field is selected.

When searching a date field, the following criteria are available:

#E=fore
On
Af ter

i= Today

since Yesterday
this Heesk
within ¥ Days
thi=s Month

thi=s ‘Year

Figure 72 Date Search Criteria

Before The selected date field is before the following date.
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Is Today The selected date field is equal to today’s date

Since Yesterday The selected date field is equal to either today’s or yesterday’s date.

This Week The selected date field falls within the current week.
Within 7 Days The selected date field falls within the past 7 days.
This Month The selected date field falls within the current month.
This Year The selected date field falls within the current year.

If at any time you need to clear the criteria you’ve set, click the Reset button. When
you have selected the message attributes you wish to search and the appropriate criteria,
click the Search button to begin the search. Mulberry will search the selected
mailboxes for messages that match your search criteria. If any messages are found, the
current mailbox window is brought to the front and you are presented with a list of
only messages matching your search parameters.

0=———————  Message Search=————H

Search Set: E]

Find Messages whose

[ From Address = ][ Contains = ]lcurugnft |

[Mure Choices ] [ Reset ] [ Cancel I

= Hide HMailbox Information

Add Cabiret: (2] [ Add.. |[ Clear |

imap: |MEOX -
imap: |[MBOX . friends [
imap: |MBOX . read-mai |
imap: |MBOX . =ent-mai
imap: [MEOX . work

imap:user.=sales

CHU: | MEOX -

Total : 7? Found: 4 Messages: 29 [ |

TAALAXA

Figure 73 The Message Search window with mailbox information displayed
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As the search progresses, the Search window presents information on the total number
of folders being searched (‘Total’), the number of mailboxes that contain messages
found during the search (‘Found’), and the total number of messages in all mailboxes
that match the current search (‘Messages’). While the search is in progress, a progress
bar will be visible to indicate the time remaining.

If you would like to save a set of search parameters for later use, you can use the
Search Set popup menu in the upper right corner of the Search window. Choose the
Save As... option to specify a name for the current set of search parameters. The
information will be saved, and a search set with the appropriate name will be added to
the Search Set menu. To recall the search parameters you’ve saved, simply choose
the appropriate set name from the Search Set menu.

By default, Mulberry searches the current mailbox for messages that match your search
criteria. You can also specify multiple mailboxes to be searched. To get a list of
mailboxes to be searched, click the disclosure triangle next to the ‘Show Mailbox
Information’ text. A list of the mailboxes to be search will be revealed. You can add
mailboxes to the list by clicking the Add... button and selecting a mailbox. To clear the
list of mailboxes to be searched, click the Clear button. You can also quickly all of the
mailboxes within a cabinet to the search list by using the Add Cabinet popup menu.

The Options... button provides you with a dialog from which you can set various
options:

search Options =cF—H

E Simul taneous Searching

Mazimum MHumber-:

[[] Load Balance Multiple Accounts

Eﬂpen First Matching Mai lbox

| Cancel I

Figure 74 The Search Options dialog

You should check with your server administrator if you’re unsure about any of these
settings.
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Simultaneous

Selecting this option causes Mulberry to search all of the mailboxes

Searching you’ve specified simultaneously instead of one at a time. Mulberry
will open an separate IMAP connection for each mailbox to be
searched if this option is selected.

Maximum This field allows you to specify a maximum number of IMAP

Number connections that Mulberry can make at once for performing

searches. This option is only available if ‘Simultaneous Searching’ is
turned on.

Load Balance
Multiple
Accounts

This option tells Mulberry to split the number of IMAP connections
used for searching across multiple IMAP servers, when appropriate.

Open First
Matching Mailbox

To automatically open the first mailbox with messages matching the
current search, select this option. The mailbox window will be
opened after the search is completed.

5.3.2 Column Headers

The column headers indicate what message information is displayed in each column in
the message list below it.

MAC OS To change a category, or to insert a new category, or to delete an existing
category click the mouse button with the command (3 ) key down
(3 -click) on the category title.

WINDOWS To change a category, or to insert a new category, or to delete an existing
category click the right mouse button on the category title.

A menu will appear giving you the choice of what category to show in the
corresponding column, as shown in Figure 75. You can also insert a new column before
or after the one clicked, or delete the column that was clicked.
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Subject
Thread
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Date Received
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Draft  Reply Flags SE[EEt'@ Search
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i %1 Parts 001928 -0 P5
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Figure 75 A mailbox window with the column title changer menu displayed.

5.3.2.1 Resizing Column Headers

Columns in the mailbox window can be resized by clicking and dragging the cursor

whilst it is over a column boundary (the cursor will change shape to <k when it is close
to a column boundary).

5.3.2.2 Smart Address

One special category is the ‘Smart Address’ category. When this category is selected, the
column title is ‘From: / To:’ (see the third column in Figure 66). When this category is
chosen, Mulberry discriminates between messages that were sent by you to someone
else, messages sent directly to you by someone else, and sent indirectly to you (possibly
via a mailing list). This is useful if you have a mixture of messages received and
messages sent in the same mailbox. In this case Mulberry will display in the message
list either the ‘From:” address, if the message was sent by someone other than you, or
the ‘To:” address, if the message was sent by you.
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To indicate which is which, it displays different icons in front of the addresses in that
column:

4 for messages sent directly to you by someone else (your address does not appear
in the ‘From’ address field of the message, but does appear at least once in the ‘To’ or
‘CC’ address field)

#+  for messages sent indirectly to you by someone else (your address does not
appear in the ‘From’ address field of the message, and it does not appear in the ‘To’
or ‘CC’ address field)

I for messages sent by you (your address appears at least once in the ‘From’
address field)

Note By default Mulberry always uses the email address which
it has set for you to discriminate between messages sent or
received by you. But you can specify additional address to count
as yours by adding them to the ‘Outgoing Addresses to Count as
Mine’ list in the ‘Mailbox’ preferences (see page 44).

5.3.2.3 Sorting Messages

You can sort the message list in a mailbox window by any message category. If a category
appears in a column title, you can click that column title to sort by that category. If the
category in a column is the one being used to sort the messages the title display will
change (for example in Figure 66 the messages are being sorted by ‘Number’ (the ‘#’
column).

If you want to sort the mailbox by a category that is not displayed then choose the

category from the Sort sub-menu in the Mailboxes menu (see page 191). The order of
sorting (ascending or descending) can be changed by clicking the sort direction button
on the far right of the category titles. The button appears differently for each sorting
method:

: @ for ascending sorts

: E] for descending sorts

When sorting a mailbox, keep in mind that only messages that currently have
information cached will be included in the sort (for a detailed description of caching,
see page 127). If you attempt to sort the messages in a mailbox by clicking on a column
header, and all of the messages in that mailbox have not yet been cached, you will be
presented with the following dialog:
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Some information needed to sort all the
A messages is unavailable. Do you want to
download the missing message
information and then do a full sort, or just
sort the currently available messages?

Eancel] [Eurrentl || Full 5ort “

Figure 76 The Search Warning dialog box

To sort only the messages for which Mulberry currently has information cached, click
the Current button. To download information on all messages that have not been
cached and then perform the sort, click the Full Sort button. Note that this action may
not be desirable if the mailbox has a large number of messages or you’re limited by
available memory or a slow connection (e.g. a modem). To cancel the sort action, click
the Cancel button.

5.3.2.4 Displaying Message Threads

A special sorting category is ‘Thread’. When this is selected for a column, Mulberry
displays in the column the subject of the message. The messages in the list are grouped
together by subject but sorted by the date of the first message in each group. Thus
message ‘threads’ are kept together and are sorted by the date of the first message in the
thread.

5.3.3 Message List

The message list shows one message per row with the data in each column
corresponding to the category of message information selected for that column.
Messages in this list can be manipulated in a number of different ways.

5.3.3.1 Selecting Messages

All operations on messages only occur for those messages that are selected at the time.
There are a number of different ways to select a message:

A message can be selected by clicking anywhere in its row.

More than one message can be selected either by shift-clicking to extend a selection,
or command-clicking (Mac OS) or control-clicking (Windows) to make a
noncontiguous selection.

5.3.3.2 Manipulating Messages

You can manipulate selected messages in a number of different ways:
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Pressing r et ur n or ent er on the keyboard will also open any selected messages. If
the message is marked as a draft it will be opened into a draft window (see page 151),
otherwise it will open into a message window (see page 131).

Pressing del et e on the keyboard will toggle the delete flag of any selected messages.

Messages may be copied by dragging them out of the mailbox window into another
mailbox window or onto a mailbox shown in the server window. An option in the
‘Message’ preferences panel (see page 51) allows copied messages to be automatically
marked as deleted after a successful copy. This option can be toggled by holding
down the opt i on key during the drag.

MACOS ONLY . Messages may also be saved by dragging them to the Desktop or a
Finder window. They can also be dragged to a window of any open
application that can receive drag and dropped text (SimpleText for
example). In this case the first text part of the selected message is sent
to the receiving application.

Some commands can act on all messages in a selection together, or on each
individual message. For example, Figure 77 shows the dialog that appears when
saving more than one selected message. You are given the choice of saving all
messages in the selection to a single file (click the Single button), or saving each
message to their own separate file (click the Multiple button). A similar dialog
appears when replying or forwarding with more than one message in the selection.

Do vou wantto save the selected messages
in a single file or as multiple files, one for
edach message?

CﬂncEI] [ SingIE] || Multiple “

Figure 77 The dialog giving the choice of whether to operate on all messages
in a selection together or individually
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5.3.3.3 Message Flags

The IMAP server assigns various flags to each message that is stored in a mailbox, to
help you keep track of the state of each message. If you have the ‘Flags’ category column
on display in the table, Mulberry will display different icons to represent these states.
These icons are:

Ea for messages that have arrived since the mailbox was last checked (recent)
#&F for messages that have never been opened (unseen)

& for messages that have been opened at least once (seen)

#=  for messages that have been replied to (answered)

for messages that are drafts (draft)

ﬁ for messages that have been marked as deleted (deleted)

For messages in more than one state (e.g. answered and deleted) the icon order in the
list above will take precedence (i.e. for messages answered and deleted, the deleted icon
will be shown).

5.3.3.4 Attachments in messages

You can see if any messages in the mailbox have attachments by viewing either the
‘Attachments’ column category or the ‘Parts’ column category. The ‘Attachments’
column will display an icon if the message contains more than one part. The ‘Parts’
column will display the total number of parts in the message.

5.3.3.5 Color and Text Style of Displayed Messages

The color and text style of messages displayed in the window is also determined by the
state of the message. The color and text style can be set in the ‘Display’ preferences (see
page 35).

5.3.3.6 Limiting the Number of Displayed Messages (Caching)

You can limit the maximum number of messages on display in every mailbox window
by changing the ‘Message Display Cache’ settings in the ‘Mailbox’ preference panel (see
page 44). This may be required if you have large mailboxes that would either use up too
much of the available memory when all messages are visible, or take a long time to
download over a slow connection (e.g. when using a modem).

The individual caching options are described on page 45. As you become more familiar
with these settings, you will be able to customize them to suit your available RAM and
connection speed. The following chart will give you starting point for different
situations:

Mulberry Reference Guide v2.0 127



Connection Speed
Slow Fast
Available Memory Low Initial Download: 20, Initial Download: 100,
Limit To 100, Auto Limit To: 100, Auto
Increment Increment
High Initial Download: 20, Initial Download: 100,
Unlimited Total, Auto Unlimited Total,
Increment Increment by: 100

5.3.4 Reference

OPERATIONS ON MESSAGES IN MAILBOX WINDOWS

To open one or more Pressret urnor ent er on the
selected messages keyboard.

Double-click one of the selected
messages.

Choose Open Message from
the File menu or press
Command-0 (Mac OS) or
Ctrl-0 (Windows).

To delete one or more Press del et e or cl ear on the
selected messages keyboard.

Choose Delete from the
Messages menu or press
Command -D (Mac OS) or
Ctri-D (Windows).

Click the Delete button in the
mailbox window.

To undelete one or more Press del et e or cl ear on the
selected messages (which are  keyboard.
all deleted)

Choose Undelete from the
Messages menu or press

Command -D (Mac OS) or
Ctri-D (Windows).

128 Mulberry Reference Guide v2.0



Click the Undelete button in
the mailbox window.

To undelete one or more
selected messages (some of
which are not deleted)

Delete the messages ‘twice’.
The first time will delete all
those not already deleted. The
second time will undelete all
the deleted messages.

To copy one or more selected
messages to another mailbox

Select the mailbox you want to
copy the messages to from the

Copy to Mailbox sub-menu in
the Messages menu.

Drag and drop the messages
onto another open mailbox
window.

(This feature is only available if
Drag and Drop is supported)

Drag and drop the messages
onto a mailbox in the server
window.

(This feature is only available if
Drag and Drop is supported)

To print one or more
selected messages

Select Print from the File
menu or press Command -P
(Mac OS) or Ctrl-P (Windows).
(Only the first text part in the

message is printed, not the whole
message)

To save one or more selected
messages to disk

Select Save from the File
menu or press Command -S
(Mac OS) or Ctrl-S (Windows).
(Only the first text part in the

message is saved, not the whole
message)

To check for new messages

Select Check Mail from the
Mailbox menu or press
Command -L (Mac OS) or
Ctri-L (Windows).
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To create a text clipping (a
simple text file in the Finder)
of the message text in one or
more selected messages

Drag the messages to the
Desktop.

(Only the first text part in the
message is dropped on the destination,
not the whole message)

(This feature is only available if
Drag and Drop is supported)

To change the flags for one
or more selected messages

Select the flag to toggle from
the Flags sub-menu in the
Messages menu.

To select messages with a
particular flag set or unset

Choose the flag to select by
from the Select by Flag sub-
menu in the Edit menu.

To reply to or forward the
selected messages

Select the required option from

the Messages menu or click
the appropriate button in the
mailbox window.

To bounce or send the
selected messages

Select the required option from
the Messages menu.

To create a message digest of
the selected messages

Choose Create Digest from
the Messages menu.

To expunge (permanently
remove) deleted messages
from the mailbox

Choose Expunge from the
Mailboxes menu or press
Command -E (Mac OS) or
Ctrl-E (Windows).

Click the Expunge button in
the mailbox window.
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5.4 Outgoing Message Queue Window

Mulberry has the ability to collect outgoing messages in a local queue. The outgoing
message queue is a special type of local mailbox that is managed by Mulberry. There are
several advantages to this approach, including the ability to send outgoing messages in
the background, as well as compose messages while in disconnected mode and send
them the next time a network is available.

To enable the outgoing message queue for a particular SMTP account, you must first
select that account in the Accounts preference panel and turn on the appropriate items
in the Options tab (see page 30).

Once one or more SMTP accounts are enabled for local queuing, the Outgoing Message

Queues window will be accessible via the Show Outgoing Queues item in the File
menu. The window is shown in Figure 78.

[ | =—— Outgoing Message Queues: Cyrusoft SMIP - Disabled == El &
(] E;ﬁ @ \ﬁ Fh:n:n:-unt:[ Cyrusaft SHTP s ] E
Hold  Priority Delete Expunge Enable

P ™ From: / To: | Date Sent: | Thread: ]
1 P Dan McCarriar 2714700 23:04.. Hello
2 @ B Cyrus Daboo 2/14400 23:05 - ... Outgoing queues are cool

- + H ol
g E B et b R S e et

= {1 (4[]~

Figure 78 The Outgoing Message Queues window

The Outgoing Message Queues window is very similar to a Mailbox window, although
different buttons are used in the header area and the icons in the ‘Flag’ column are
different. Messages can be opened, deleted, and expunged exactly as in a regular
Mailbox window. The other header buttons include:
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The Hold button allows you to put a selected message on ‘hold’. Held
messages are not sent, even when Mulberry is in connected mode and the
outgoing queue is enabled.

The Priority button allows you to assign a higher priority to a particular
message. Priority messages are sent before other messages.

If multiple SMTP servers are defined in the Accounts preference panel, the

Account popup allows you to switch between the queues for each SMTP
server.

The Enable button allows you to enable the outgoing queue and send any
queued messages. When the queue is enabled, this button will change to a
Disable button. The outgoing queue is automatically disabled when
Mulberry is in disconnected mode. When switching from disconnected
back to connected mode, the outgoing queue is normally re-enabled, and
any messages queued while in disconnected mode are sent.

The possible flag icons for messages in the outgoing queue include:

132
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A message waiting to be sent.

A message being held in the queue.

A message in the process of being sent.

A message that was not sent successfully.

A messages that has been marked as deleted.
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5.5 Message Window
Header expand/collapse Message subject  Position of message
______Address fields with in its mailbox Navigation
disclosure buttons buttons

Message window header

.

[J ==——————Mulberryis Great! % BB

From: [Cyrus Doboo <dabooRcoyrusoft.com? | flz=selzz £ e 8
To: = | friendldomain . uk - ﬁ —
|| |nobodyReyrusoft.com [ | T
_— -
-
Cc: |SDmEdeI=|E!EI=|r‘L.ISth «COm |
Subject: Mulberry is Great!

a | 25|

Date sent: |Sunday, Februgry 13, 2668 1:85 PH —-A590 | I

Just to let gou know, | think Mulberry is great! [~ |

AN

Sl

4 N\ b

AN

N

Parts header Message text display

Figure 79 A typical message window with an expanded header area, one
address list expanded and its parts list collapsed

Figure 79 shows a typical incoming message window. Message windows display the
contents of incoming messages (the window title is the text of the subject or the address
of the sender if the subject line is empty). You can set the default size and location for
message windows by sizing and positioning a message window to your tastes and then

choosing Save Default Window from the Windows menu (see page 202).

Message windows are divided into three main sections:

The Header section can appear expanded or collapsed:

Expanded: shows the addresses, subject and date for the message, together with
navigation buttons and other buttons to operate on the message (as illustrated in
Figure 79).

Collapsed: Shows only the navigation buttons and other buttons used to operate
on the message.. Address, subject and date information is displayed in summary
form in the message text display area (as illustrated in Figure 80).
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The Parts section can be expanded or collapsed. In its collapsed state (as shown in
Figure 79) it shows the total number of MIME parts to the corresponding message,
together with a button for displaying the message header, pop-up menus to change
the display format and choose a mailbox to copy the message to, and a button to
perform a copy to the selected mailbox. In its expanded state, it also shows a list of
each MIME part allowing you to manipulate the individual parts.

The Text Display section is used to display any text parts in the message.
These sections are now described in more detail.

5.5.1 Header
D = Mulberrvis Great' =——— E
E= ﬁ =
| =8 | &= 7 =
Celete  Reply Forward Mes=sage 2 of 3
[* Parts: El Formatted — Copy to:| imap:INEQX —
From: Cyrus Daboo <{dabooRcyrusoft.com? -
To: friendidomain.uk, noboduyflcyrusoft.com |
cct somebodyfloyr-usof t.ocom
Subject:i Mulberry is Great!
Date—-5Sent: Sunday, Februarg 132, 2080 1165 PH -@2568
Just to let gou know, | think Mulberty is great!
4] Q7

Figure 80 The message window showing the header area in collapsed state,
with the message address, subject and date information displayed in the
message body.

In its expanded state, the message window header shows three address fields for the
‘From:’, “To:” and ‘CC:” address lists in the message. These fields display either the first
address in the corresponding list if it is collapsed, or a scrolling list of all the addresses
in the corresponding address list if expanded. Each address field can be expanded or
collapsed by clicking the disclosure button next to it.
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Note When Mulberry opens or displays a new message in an
existing message window with an expanded header, it will
automatically expand or collapse the address fields depending
on whether there is one or more than one address in the list to
be displayed. If there is only one address and its text fits in the
single address field, the disclosure triangle will be disabled.

The expanded header in the message window also shows the subject of the message and
the date on which it was sent. You cannot edit the text in these fields or any address
field. However, you can select the text and either copy it or drag and drop it to a
different location (for example dragging addresses to an address book, which would add
those addresses to the address book list).

5.5.1.1 Moving Between Messages

The message window header in both expanded and collapsed states includes four
navigation buttons as shown in Figure 81. These buttons are used to display a different
message in the current message window without having to open another window.

=]
[ = | Message Eﬁ of B4 Read previous message
H ﬁ — Copy and read next message
hal L Read next message
]

Delete and read next message

Figure 81 The navigation buttons in a message window

To display the previous message in the mailbox, click the read previous button .
To display the next message in the mailbox, click the read next button .

To delete the current message and then display the next message in the mailbox,
click the delete and read next button .

To copy the current message to the mailbox specified in the ‘Copy To’ pop-up menu
in the parts header area, and then display the next message in the mailbox, click the
copy and read next button . If you hold down the Option (Mac OS) or Alt (Windows)
key while clicking the button, the effect of the ‘Delete Message after Copy’ option in
the ‘Messages’ preferences panel (see page 51) will be toggled for the copy action.
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Note If the current message is the first in the mailbox then the
read previous button will be inactive, as there is no previous
message to read. Similarly, the read next button will be inactive
if the message is the last message in the mailbox. However, the
delete and read next button is never inactive. Instead the
message is deleted and the window will be closed.

Note If the message is a MIME sub-message part within
another message then the navigation buttons are replaced with
text indicating this situation (see Figure 82). The read next and
previous buttons also change functionality to let you move
through the other sub-message parts.

Sl= Indicates that this message is a
- Digest 2 of 3 sub-message part within
— N another message
= v Read previous message in digest
] I Read next message in digest

Figure 82 Indication of the fact that the message on display is a MIME sub-
message part within another message

Figure 83 shows the three other buttons available in the message window header in
either expanded or collapsed state, to allow messages to be deleted or undeleted, to
create a reply to the message, or to create a forward template in order to forward the
message to another user.

Reply button

_I |
Delete/undelete — 1 Copy to mailbox
button 3 m B= button
:l -‘= [=:.7
Celete Eeply Forward

o= TS
- T4

Figure 83 Message window header buttons
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5.5.1.2 Deleting a Message

A message can be deleted by clicking the Delete button.

Note Mulberry can be configured to prevent or allow the
opening of deleted messages. This is controlled by the ‘Allow
Deleted Messages to be Opened’ checkbox in the ‘Message’
preferences panel (see page 51). If this option is off you will not
be able to open any deleted messages from a mailbox window.
Similarly when you delete a message with a corresponding
message window, the window is automatically closed. If the
option is on then deleted messages can be opened and
displayed in a window. In this case the Delete button changes
to an Undelete button.

Note If the message comes from a mailbox with read-only
permission you will not be able to delete it and the Delete
button will not be active.

Note If the message is a MIME sub-message part within
another message you will not be able to delete it and the

Delete button will not be active.

5.5.1.3 Replying to Messages

There are two ways to use the Reply button which depend on whether the Option
(Mac OS) or Alt (Windows) key is held down when clicking the button. The choice of
action is determined by the ‘Message’ preference panel setting (see page 51).

In one case a new draft message window (see page 151) is automatically created in
reply to the current message. The draft message has its ‘To:” address field filled in
with the ‘Reply-To:” address of the message being replied to. Any other addresses in
the original message are ignored.

In the second case Mulberry will display a dialog (shown in Figure 84) which allows
you to choose which addresses from the original message are to be used in the reply
and where they should appear in the reply. The dialog lists all the addresses in the
original message (it does not display duplicate addresses) and indicates in what field
the addresses were originally in. You can then choose where to put each address in
the reply message by clicking on or off one of the diamond buttons next to the
address. Once the required choice is made click the Create Reply button or press

r et ur n to create a new draft message with the requested addresses automatically
filled in. The ‘quick select’ buttons immediately below the address list allow typical
choices for different types of replies to be automatically selected by Mulberry, or in
the case of the ‘None’ button removes any choice.
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List of all addresses in The field in which the corresponding address
original message appeared in the original message

| |
—— = Reptlylo—————

Select Addresses|to be used in the Reply:

To Ce Bee Address Originally

% < < Happy Customer <hoppyfdomain.uk> Reply—to [*
3 < @ mulberrylogrusoft.com To

& ¢ ¢ friendPdomain.uk To

£ % ¢ somebodyfcyrusoft.com cC

—Select:| [ Reply-To [ Reply &l | From [ Sender | HMone |

[ Cancel I [ Create New I || Create Reply II

Buttons to choose where the
‘Quick select’ corresponding address will appear in
buttons the reply

Figure 84 A typical ‘Reply To’ dialog used for filling in addresses for a
message in reply to another

Note The default ‘Reply To’ action can be toggled at your
option. The default is to have the dialog appear only when the
Option (Mac OS) or Alt (Windows) key is down. To change this
click the appropriate radio button in the ‘Allow Choice of who
to Reply to when’ group in the ‘Message’ preferences panel (see
page 51).

5.5.1.4 Quoting Message Text in a Reply

When replying to the message, if you want to have any part of the message text
automatically displayed as a quotation in the reply, select the required text before

clicking the Reply button or using one of the reply commands from the Messages
menu. Alternatively, if the ‘Quote Whole Message if no Selection’ option is turned on
in the ‘Message’ preferences panel (see page 51), the whole of the text on display in the
text area will be quoted in the reply if no selection already exists. If this option is off, no
text will be quoted unless there is an existing selection.
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5.5.1.5 Bouncing, Forwarding and Sending Again
Mulberry gives you three additional ways to ‘reply’ to messages:

‘Bounce’ - allows you to pass the message on to someone else and have it appear as
though it originated from the original sender of the message. This allows the
recipient to reply direct to the original sender.

‘Forward’ - allows you to pass the message on to someone else (who may not be in
the original list of recipients or may not be the original sender).

‘Send Again’ - allows you to resend any messages which were originally sent by you.
This option is only available when Mulberry recognizes the message as having been
sent by you.

5.5.1.6 Copying the Message to Another Mailbox

The message on display can be copied to another mailbox. There are two different ways
to specify the mailbox to copy to. You can choose a mailbox directly from the Copy to

Mailbox item in the Messages menu. Selecting a mailbox from this menu will
immediately carry out the copy operation.

Alternatively you can select a mailbox from the ‘Copy To’ pop-up menu in the parts
header area (shown in the next section). Then either click the Copy Now button, select

Copy Now from the Messages menu, or use the copy navigation button (described on
page 135) or select Copy & Read Next from the Messages menu.

5.5.2 Parts Header

5.5.2.1 Message Parts Header: Controls

The message parts header area contains a number of controls as shown in Figure 85,
and described in more detail below:

‘Parts’ disclosure triangle  Expands or collapses the display of the parts table.
‘Parts’ number The total number of parts in this message.

Attachment indicator If present, indicates that the message contains some
attachments. Different icons indicate different types
of attachment:

Indicates a message which contains styled text and
plain text alternatives.

|£| Indicates a messages which contain other types of
attachment.

‘Header’ button Toggles the display of the message’s header (see next
section.
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‘Formatting’ pop-up menu Changes the formatting of the text on display (see
page 144).

‘Copy To’ pop-up menu  Selects the mailbox that will be used when one of the
copy buttons is clicked or the Copy Now item in the
Messages menu is used.
‘Copy Now’ button Copies the current message to the mailbox specified in
the ‘Copy To’ pop-up menu.
Note When opening a new message window, the last value
chosen for the Copy To pop-up menu is used for the new

message window. The first message window opened after
starting Mulberry, will have ‘None’ set as the copy to mailbox.

L'e |eTe Eeply Forwarag ==y S U

[:IrPartg; |3 ||E-| | Formatted :I Copy tn:l imap :MEOX :I fieis
| N N |

Parts Parts Attachment Header Formatting Copy to mailbox
Disclosure Number indicator button popup menu popup menu
Triangle

Figure 85 The message parts header area controls

5.5.2.2 Showing Message Headers

Mail headers contain the addressing information and details about the structure of the
message and are used by SMTP servers when a message is sent. The headers are also
used by the IMAP server to determine the addressing information as well as the MIME
parts and structure of the message. Sometimes it is useful to see all the headers in a
message and the header button (shown in Figure 85) is used to toggle the display of the
message’s mail header. When it is on, the mail header text is displayed at the top of the
text display area. When off, the mail header is not displayed.

The style for the header fields displayed in the header can be changed in the ‘Styles’ tab
of the Display preferences panel.

Note You can choose whether to have the mail header
displayed or not displayed when first opening a message
window. This option is controlled by the ‘Show Message
Header in Window’ option in the ‘Message’ preferences panel
(see page 51).
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5.5.2.3 Message Parts Header: Parts Table

The MIME standard allows messages composed of multiple parts to be sent via email.
These parts can be ordinary plain text or more complex ‘binary’ data such as images or
even application files. The MIME structure of a message is hierarchical and allows
message parts to be grouped in a ‘multipart’ part.

MIME messages have these features:
Every message contains one or more parts.

Each part is described by a type and a related subtype. For example there are three
standard subtypes corresponding to the ‘text’ type. These are:

‘plain’ - indicates the part contains plain, unformatted text.

‘enriched’ - indicates the part contains text in the special ‘enriched’ format which
allows formatted text to be sent.

‘html’ - indicates that the part contains HTML (Hyper Text Mark-up Language)
text that is used as the basis for World Wide Web pages.

Other types are used to represent binary data (e.g. ‘image’, ‘audio’, ‘video’,
‘application’) and the ‘multipart’ type is used to indicate a group of other parts. A
special ‘message’ type also exists and this is used to indicate an encapsulated email
message inside another or other information about a specific email message.

Mulberry allows you to view any text part, and includes support for viewing
enriched and HTML formatted text as well as plain text (see page 144).

Other parts can be downloaded to any disk on your local computer and then opened
using their appropriate application.

The message MIME parts display can be either collapsed (as shown in Figure 79) or
expanded (as shown in Figure 86). In the collapsed state it just indicates the total
number of different MIME parts in the message. When expanded it displays a either a
hierarchical list of all the MIME parts in the message or a flat (simplified) list, showing
the MIME type and sub-type, the size, and the name of each part. To switch between
hierarchic and flat mode use the flat/hierarchic toggle button. In the flat (simplified)
mode Mulberry shows only those parts which you can actually view or save to disk.

The expanded view also shows which parts can and cannot be viewed in the text
display area, and whether they have already been seen. This is indicated by the
diamond buttons in the first column of the list:

4 Indicates the part currently on view in the text area below.

< Indicates that the corresponding part is of a type that Mulberry can display in the
text area below. Clicking this button will cause the part to appear in the text area
below.
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% Indicates that a part which Mulberry can display has already been seen. Clicking
this button will cause the part to appear in the text area below.

Indicates a part which Mulberry is unable to display in the message window.

O Indicates a part that is a MIME sub-message included in the main message.
Clicking this button will open a new message window showing the sub-message.

B Indicates a MIME sub-message part that has already been seen.

A part which cannot be viewed

A multipart part Flat/hierarchic
toggle button

The current part on view

EFdELF RFiii - |.¢|_.'.¢_."h.u L

¥ Fil e i L 1 L " 1
— Lelete  Reply Fu:nrwaru:l|

7 Parts: [[t= Formatted = | |Copy to:| Mone -
9, Ly Content-type Size Hame
L text/plain 20 Unknown part #1 -l

?%mul tipart/mixed
appl ication/mac—-binhex40 56K  test hgx

G text/plain 1234 Unknown part #2 2
(I | - é] message M fod22
—H text/plain 4414 Unkrnown part #3001
{} text/plain 321 Unknown part #3302 ||
w
I think Mulberry is great - don®t gou? -

dl N\ [z

S

A part that has been viewed Message text display

Split-pane divider used to

A part which is a sub-message resize parts list and text area

A part which has been saved to disk

Figure 86 The message parts list showing a complex message structure
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You can see more detailed information about each part by selecting it and choosing

Properties from the Edit menu. This will display the dialog shown in Figure 87
with the details for the selected MIME part filled in.

A eD0e————— E
MHame |Unr‘u:|med part #2 |
Tupe: | text/himl |
Encoding:  |7bit |
MIME o | |
Properties
Description: HTML document
Farameters: |charset=us-ascii -
[ |
Application
that will open —+ Open with:  [HebBrowser |
this part

Figure 87 A typical ‘MIME Part’ dialog that shows detailed information
about a particular MIME part

5.5.2.4 Saving MIME Attachments to Disk

One or more parts can be saved to disk by selecting them and either double-clicking
them, dragging them to the Finder, or selecting Extract Parts from the Messages
menu (see page 195). When a part has been saved to disk a + mark appears next to it in

the second column of the list. If you drag a multipart item to disk then all the enclosed
parts are downloaded one after another.

MAc OS If you receive a multipart/appledouble part then you should download
ONLY the multipart item rather than the individual sub-parts because the
whole multipart actually corresponds to a single Mac OS file.

You can choose how Mulberry behaves when it downloads a part to disk by choosing

the appropriate option in the ‘Save to Disk’ section of the ‘Attachment’ preferences
panel. You can choose to have Mulberry give you the choice of where to download a
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part to (when double-clicking or using Extract Parts from the Messages menu) or
automatically download the part to a pre-chosen destination folder.

You can also choose how Mulberry behaves after a part is downloaded to disk. This is
controlled by the choices in the ‘Open after Save’ section in the ‘Attachment’ preference
panel. Mulberry can be set to either automatically open the downloaded part in its
appropriate application, to ask you whether to open the part, or to never open the part.
In addition, it is possible to override this for parts that can be displayed in Mulberry (i.e.
text parts). This allows you to choose not to open parts that you have already seen if all
you want to do is save them for later perusal.

Note You can resize the parts list by clicking and dragging on
the split-pane divider lines between the parts list and the text
display area. When the cursor is over the split-pane divider it

changes shape to ==

5.5.3 Text Display

This displays the text of the currently selected MIME part in the message. Mulberry will
show the first item in the MIME parts list that it is capable of displaying when opening
a new message window. If there are no parts that can be displayed in the text area then
this is left blank. The message’s mail header may appear at the top of the text area
depending on whether the header button (see page 140) is on or off.

Note You can use the spacebar to navigate through messages.
When you press the spacebar Mulberry will scroll down the
current text display area one page at a time. When it reaches
the end of the scrollable area it will move on to the next
message in the mailbox list. If you hold down the Option
(Mac OS) or Alt (Windows) key while using the spacebar, the
message being read will be marked as deleted before the next
message is displayed.

5.5.3.1 Working with Styled Text

Mulberry is able to display a number of different formats of styled text. Styled text is text
which has different type-face characteristics, for example a different font or size, or use
of bold or italic text. Styled text normally requires the use of special ‘tags’ embedded
within the text itself that are used to mark the start and end of ‘style runs’. These tags
are interpreted by the application viewing the text and used to created the styled text
display. Mulberry is able to interpret ‘enriched’ and ‘HTML’ styled text. When you
receive a MIME message with text in one of these formats, Mulberry determines what
type it is and displays it accordingly. You can choose to change how Mulberry displays
the text by using the formatting pop-up menu, shown in Figure 88, in the message parts
header area (see page 139).
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Formatted
Plain Text
Raw Text

as HThL
as Enriched
Fixed Font

Figure 88 The formatting pop-up menu

‘Formatted’ — the text is displayed using the styles determined from the tags and
appropriate for the type of styled text being viewed.

‘Plain Text’ - the text is displayed without styles, but with the styled text tags
removed.

‘Raw Text’ - the text is displayed without styles, with styled tags showing.
‘as HTML’ - the text is displayed as HTML.
‘as Enriched’ — the text is displayed as Enriched text.

‘Fixed Font’ — the text is displayed using a fixed-width font.

For all text types, when ‘Formatted’ text is being displayed, URLs are highlighted using
the style set in the ‘Styles’ tab of the ‘Display’ preference panel (see page 43). When the
cursor is over a URL it changes to a hand icon and you can click on the URL to launch
it. Mulberry only highlights URLs that have a scheme that matches an entry in the
‘Recognize URL Schemes’ area in the ‘Styles’ tab of the ‘Display’ preferences panel (see
page 43). URLs are not highlighted when viewing ‘Plain’ or ‘Raw Text’.

MAC'O'S Note URLS can only be launched if a suitable ‘Helper’

application is set-up in Internet Config (see page 207).

M Note URLSs can only be launched if a suitable ‘Helper’

application is available in the Windows Registry.

When the message header is displayed, Mulberry will change the text style of the
message header fields to that specified using the style set in the ‘Styles’ tab of the
‘Display’ preferences panel (see page 43). When ‘Formatted’ text is being displayed, any
URLSs in the message headers will also be styled according to the URL style as described
above.
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When viewing ‘Raw Text’, Mulberry will change the text style of any formatting tags to
that specified using the style set in the ‘Styles’ tab of the ‘Display’ preferences panel (see
page 43).

5.5.3.2 Text alternatives

Sometimes you may receive messages with ‘alternative’ text parts. These usually
consist of a plain text part followed by a styled text part, and are sent to ensure that all
email programs are able to see the text of the message correctly. Since some email
programs are not able to display styled text, they will display the first plain text part to
the user. Other mail programs, including Mulberry, that are able to display styled text
will choose to show the second, styled text, part to the user. You can control this
behavior in Mulberry by using the ‘Show Styled’ option in the ‘Message’ preferences
(see page 51). When turned on, Mulberry will pick the best styled part in a text
alternative message to display. When turned off, Mulberry will always display the plain
text part in an alternative.

5.5.4 Reference
OPERATIONS ON MESSAGE WINDOWS

To save the current message Choose Save from the File

display text menu or press Command=-S
(Mac OS) or Ctrl-S

(Windows).
To print the current message  Choose Print from the File
display text menu or press Command-P
(Mac OS) or Ctrl-P (Windows).
To show the previous Click the Read Previous
message in the mailbox in button

the current window

Choose Read Previous from
the Messages menu or press

Command-[ (Mac OS) or
Alt-[ (Windows).

To show the next message in  Click the Read Next button
the mailbox in the current
window

Choose Read Next from the
Messages menu or press

Command-=] (Mac OS) or Alt-]
(Windows).
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To delete the current
message and then show the
next message in the mailbox
in the current window

Click the Delete and Read
Next button

Choose Delete & Read Next
from the Messages menu or

press Command-/ (Mac OS)
or Alt-/ (Windows).

To copy the current message
and then show the next
message in the mailbox in
the current window

Select a mailbox in the Copy
To pop-up menu. Then click
the Copy and Read Next
button

Select a mailbox in the Copy
To pop-up menu. Then choose

Copy & Read Next from the
Messages menu or press

Command-\ (Mac OS) or Alt-\
(Windows).

To delete the current
message

Click the Delete button in the
message window

Choose Delete from the
Messages menu or press

Command-D (Mac OS) or
Ctrl-D (Windows).

Delete the message in its
mailbox window.

To undelete the current
message

Click the Undelete button.

Choose Undelete from the
Messages menu or press

Command-D (Mac OS) or
Ctrl-D (Windows).

To show the message’s mail
header
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Click the header button in the
message window.
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Choose Show Header from
the Messages menu or press

Option-Command-H
(Mac OS) or Alt-Ctrl-H
(Windows).

To hide the message’s mail
header

Click the header button in the
message window.

Choose Hide Header from the
Messages menu or press

Option-Command-H
(Mac OS) or Alt-Ctrl-H
(Windows).

To reply to the message’s
‘Reply-To:” address

Click the Reply button in the
message window.

Choose Reply from the
Messages menu or press

Command-R (Mac OS) or
Ctrl-R (Windows).

To reply to the message’s
‘Sender:” address

Choose Reply to Sender from
the Messages menu.

To reply to the message’s
‘From:” address

Choose Reply to From from
the Messages menu.

To reply to the all the
addresses in the messages

Choose Reply to All from the
Messages menu.

To forward the message to
someone else

Choose Forward from the
Messages menu or press

Command-J (Mac OS) or
Ctrl-J (Windows).

Click the Forward button in
the message window.

To bounce the message to
someone else

Choose Bounce from the
Messages menu.
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To send the message again

Choose Send Again from the
Messages menu.

(This feature is only available if the
message was originally sent by you)

To copy the message to a
different mailbox

Select the mailbox you want to
copy the messages to from the

Copy to Mailbox sub-menu in
the Messages menu.

To copy the message to the
mailbox selected in the Copy
To pop-up menu

Click the Copy Now button in
the message window.

Choose Copy Now from the
Messages menu or press

S hift-Command-C (Mac OS)
or Shift-Ctrl-D (Windows).

To change any of the flags for
the message

Select the flag to toggle from
the Flags sub-menu in the
Messages menu.

To save one or more selected
parts in the parts list

Double-click the selected parts.

Drag the selected parts to the
Finder.

(This feature is only available if
Drag and Drop is supported)

Choose Extract Parts from
the Messages menu or press

Command-; (Mac OS) or Alt-;
(Windows).

To see more detailed
information about a selected
part
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Choose Properties from the
Edit menu or press
Command-I (Mac OS) or
Ctrl-1 (Windows).

149



To decode BinHex embedded choose BinHex from the

in the message text Decode Embedded sub-

menu in the Messages
menu.

To decode UU embedded in  Choose UU from the Decode
the message text Embedded sub-menu in the
Messages menu.

MAcC OS ONLY MAcC OS ONLY

To have your computer read Choose Speak Message from
the message to you aloud the Speak menu or press

Command-T.

(This feature is only available if
Speech is supported)
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5.6 Draft Win
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Figure 89 A typical draft message window with the header area in expanded
state

Figure 89 shows a typical draft message window. Draft message windows display the
contents of messages which you are in the process of writing prior to sending (the
window title is the name of the file if the draft message was originally opened from

disk).

You can set the default size and location for new draft windows by sizing and
positioning a draft message window to your tastes and then choosing Save Default
Window from the Windows menu (see page 202).

Draft message windows are divided into three main sections:
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The draft header section can appear expanded or collapsed:

* Expanded: shows the addresses and subject for the new message. It also contains
buttons and a menu listing all available mailboxes for saving a copy of the
message when sent (as illustrated in Figure 89).

» Collapsed: Contains buttons and a menu listing all available mailboxes for
saving a copy of the message when sent (as illustrated in Figure 90).

The draft parts section contains a hierarchical list of MIME parts that represents the
structure of the message being sent.

The message text display section is where you can type text for any text parts you
wish to send in the message.

These sections are now described in more detail.

5.6.1 Header
- : . -
Copy to: irnap : MBI *= || Ep al | zese
| — gf-1 Elvg| | e
EH[ED copy ariginal message ttach I_'Ir'iginal Send

[ Parts: El | Flain %rapped @ = I Identity : | Default I|_q..i I

--0n Sunday, February 13, 28608 1:85 PH —6508 doboolcyrusoft.com wrote:

¥ Jdust to let gou know, | think Mulberry is great!

Thanks for gour comments.

N
L
S 4]

Figure 90 The draft window showing the header area in collapsed state.

In its expanded state, the window header has three address fields which can be used to
enter the email addresses to which you want to send this message (‘To’), or to which
you want a copy to be sent (‘Cc’), or to which you want an copy to be sent without
revealing their email address (‘Bcc’). Use of these fields are described in more detail in
the next section.

The subject of the message should be entered in the ‘Subject’ field. If this message was
generated as a reply to an existing message, Mulberry will insert ‘Re: ’ followed by the
subject from the original message into the subject field (‘Re: ’ is not prepended if it is
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already there). Similarly, if the message is being forwarded, Mulberry inserts the
original message’s subject followed by ‘(fwd)’ in the subject field.

5.6.1.1 Address fields

Each of these fields can be collapsed to display a single line of text, or expanded to
display a scrolling list of text.

Single addresses can just be typed straight into a collapsed field.

For multiple addresses, separate the addresses by a comma or put each one on a new
line. You can type legitimate email addresses in a number of different ways:

Example Address Description

mulberry@dial .pipex.com Standard email address format
<mulberry@dial .pipex.com> Standard email address format
“Mulberry Owner” Email address with name

<mulberry@dial.pipex.com>

mulberry@dial .pipex.com (Mulberry Owner) Email address with comment

<mulberry@dial .pipex.com> (Mulberry Email address with comment
Owner)

As you type in addresses, Mulberry attempts to determine whether what you typed was
a complete address or a ‘partial’ address. In the case of a partial address a number of
things might happen when you type Return or move the cursor outside of the address
field:

5.6.1.1.1 Nickname Resolution

Address or group entries in address books can contain nick-names (see page 164 for
more about Address Books). Just type the name of the nick-name or group name in
place of an email address. Mulberry will attempt to resolve the nick-name by searching
each address book marked for nick-name resolution (see section 5.7.4 for more details).
The first matching nick-name (if one exists) will then be substituted for the partial
address in the address field.

5.6.1.1.2 Address Expansion

When doing address expansion, Mulberry searches the text in various address fields in
an address book (as specified in the ‘Expansion Tab’ of the ‘Addresses’ preferences panel
— see page 69) for a match to the partial address. The search is done on each address
book marked for searching (see section 5.7.4 for more details). If there is a single match
it will be substituted in place of the partial address in the address field. If there is more
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than one matching address, then Mulberry will display all matches in a dialog box list
allowing you to choose one or more addresses to substitute for the partial address.

5.6.1.1.3 Default Domain

If Mulberry cannot resolve a partial address as a nick-name, or via expansion, it
assumes that the text typed is an ‘unqualified’ address. It will then append the ‘Default
Domain for Outgoing Mail’ value, set in the ‘Outgoing’ preferences panel (see page 55),
to the typed text and take that to be the email address. If the ‘Default Domain for
Outgoing Mail’ value is empty, an error will occur when you attempt to send the
message because the typed text cannot be recognized as a valid email address.

5.6.1.2 Saving Copies of Sent Messages

If you want to have the draft message copied to a mailbox in the server list after it is
successfully sent, select the required mailbox from the ‘Copy To’ pop-up menu.
Alternatively select ‘None’ at the top of the ‘Copy To’ pop-up menu.

You can also copy the draft message to any mailbox before sending it by selecting a
mailbox from the ‘Copy To’ pop-up menu, and clicking the ‘Append Now’ button, or

choosing Append Now from the Draft menu. Alternatively, choose a mailbox from
the Append to Mailbox sub-menu.

Note When creating a new draft message, Mulberry will
automatically select the default ‘Copy To’ mailbox specified in
the ‘Draft’ preferences (see page 55). Also, if ‘Remember Chosen
Copy Mailbox’ is on in the ‘Draft’ preferences then any change
to the ‘Copy To’ mailbox in a draft message window is
remembered and the modified value used the next time a draft
message window is created.

If the draft message is in reply to another (or is being forwarded or bounced) then you
can also choose to have Mulberry copy the original message to the ‘Copy To’ mailbox
before it copies the reply by turning on the ‘Also copy original message’ checkbox. This
allows you to file messages, relating to the same subject, together in a mailbox in the
correct order (i.e. original before reply).

5.6.1.3 Quoting Text in a Reply

The Original button can be used to insert the text of an original message at the current
selection position in the text display area. The text is inserted as a quotation with a
header giving information about the original message (see the first four lines of text in
Figure 89). If the draft message is not a reply to another message then the Original
button will not be active.
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5.6.1.4 Sending a Message

The Send button can be used to send the draft message.

After sending a message, an icon appears in the bottom right of the header area to
indicate successful completion (see Figure 91). This will not appear if the message could
not be sent. Since a network related error can occur either while sending the message or
while copying it to a mailbox (if that option is chosen), the icon can be used to confirm
that the message was sent correctly and that the problem arose after sending it (i.e.
while copying to a mailbox). Mulberry automatically closes a draft message window
only after successfully sending the message and copying it to a mailbox (if that option is
chosen). This could mean that the window may disappear before the successful send
icon can be seen, but the message has been sent successfully in this case.

feplied To =

=

Indication that draft _|
has been sent

Figure 91 The symbol used to indicate that sending the draft message was
successful

5.6.1.5 Attaching Files

The Attach button works together with the parts list and is described in the next
section.

5.6.1.6 Using ldentities

The Identity popup can be used to choose the identity used when sending a draft
message. An identity provides a way to set information such as the return address or
signature used with a draft. For more information on the contents of an identity and
how to create and edit them see page 62. When you switch identities using the Identity
popup, or edit the existing identity set in the popup, Mulberry automatically changes
information in the draft window to reflect the new identity chosen, or the changes
made to the currently selected identity. This includes change any signature, changing
the Copy To popup menu setting, and various other items.
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5.6.1.6.1 Tied ldentities

When creating a draft message, Mulberry determines which identity to use based on a
set of rules that use ‘tied identities’ to determine what to do. An identity can be ‘tied’ to
a mailbox (see page 98) or a mail account (see page 26) such that use of that mailbox or
account will trigger the use of the ‘tied’ identity when creating drafts with that mailbox
or account ‘active’. To determine the correct tied identity Mulberry uses the following

rules:

Server window active,
server row selected

Use the tied identity for the account of the selected server, if
it exists

or
Use the default identity

Server window active,
mailbox selected

Use the tied identity for the mailbox, if it exists
or

Use the tied identity for the mailbox’s account, if it exists
or

Use the default identity

Mailbox window active

Use the tied identity for the mailbox, if it exists
or

Use the tied identity for the mailbox’s account, if it exists
or

Use the default identity

Message window active

Use the tied identity for the mailbox containing the
message, if it exists

or

Use the tied identity for the account of the mailbox
containing the message, if it exists

or
Use the default identity

Any other case

Use the default identity

Mulberry will then use the tied identity or the default identity based on another set of
rules outlined in the next sections.
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5.6.1.6.2 Tied Identities and new drafts

When creating a new draft using the New Message menu command or by clicking a
Draft button in a server or mailbox window, the following rules apply:

‘Use Tied ldentities with Option (Mac OS) | Identity set when draft is created

New Drafts’ or Alt (Windows)
Key
Off Not used Default identity
Off Down Tied identity for the active

window (as determined by rules
in section 5.6.1.6.1).

On Not used Tied identity for the active
window (as determined by rules
in section 5.6.1.6.1).

On Down Default identity

5.6.1.6.3 Tied Identities when replying, forwarding, bouncing, sending again or creating
a digest

When replying, forwarding, bouncing, sending again or creating a digest of messages,
Mulberry will always use the tied identity appropriate for the selected messages as
determined by the rules of section 5.6.1.6.1.

5.6.2 Sending Attachments: Parts Display

Mulberry allows you to create sophisticated MIME-structured messages for sending. As
well as sending any number of text parts, which it allows you to type in, you can also
send any type of file stored on the local file system, complete messages from any
mailbox on the IMAP server, or individual parts of messages on the IMAP server.

By default, the draft message window is created with a single text part. Additional parts
can be added in a number of ways and the hierarchical structure of the MIME message
changed accordingly. Mulberry also allows you to set details for each part being sent
such as the encoding method, the MIME type details, the name of the part and the
description of the part, which could be useful to the recipients.
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Figure 92 The expanded hierarchical parts list in a draft message window

The message parts display section contains a hierarchical list (see Figure 92), similar to
the one in the incoming message window, that displays the full hierarchy of the
message being composed.

The diamond buttons in the first column have the same meaning as in the message
window parts list (see page 139).

The second column indicates whether the details of the part can be changed. This
includes being able to change the MIME type and encoding used for the part. In
general, all message parts (be they a complete message or a part from within an
existing message) that belong to messages on the IMAP server are read-only.

The third column lists the MIME type that will be used when the part is sent.

The fourth column shows the size of the part. Note that the size of the current text
part is only updated when switching the text display to another part.

The fifth column shows the name of the part. If the part has no assigned name,
Mulberry will generate a default name for display in the hierarchy list. However,
this name is not used when the message is sent.

The final column indicates the type of encoding that will be used to send the part.
‘Text’ and ‘Automatic’ encodings correspond to the standard MIME encodings.
Mulberry will choose the best MIME encoding to use in this case. Other encodings
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may be used if the file requires special processing, for example to ensure that the
resource fork of the file is preserved when sent between Mac OS users.

5.6.2.1 Editing MIME Information

The type, name and encoding of parts can be modified (if the part can be changed) or
viewed (if the part is read-only) by choosing Properties from the Edit menu.

For read-only attachments, the dialog shown in Figure 87 is displayed with the relevant
information filled in. For parts that can be modified, the dialog shown in Figure 93 is
displayed. This allows you to change the name of the part, the MIME type and subtype,
the encoding and add a description to the part. The name and description are sent with
the part and can be viewed by the recipient if they have a suitable application to view
the message with (Mulberry for instance!). The type and subtype should not generally
need to be changed, as Mulberry will generate defaults for these that should suffice.

To change them, either type a new value into the appropriate field or choose one from
the pop-up menu next to each field. Note that the items in the subtype pop-up menu
depend on the value in the type field.

Mame: [Admin Guide {Mac 0S5).pdf |
Type: |application || = I
Subtype: ||:u:|f || ¥ I
En-:-:iding:[ Automatic — ]

Description:

Dispn:-sitic-h:[ At tachmeant ‘]

-

Ehur‘set:[ Automatic - ]

| Cancel I

Figure 93 The dialog used to edit the details of a MIME part before sending it

5.6.2.2 Creating MIME Multiparts

You can add new levels of parts hierarchy by choosing a suitable ‘Multipart’ item from

the New Multipart sub-menu in the Draft menu. This will create a new hierarchy
level into which you can place single parts or more multipart hierarchies.
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When inserting new parts into the parts list, the new parts will always be added as sub-
parts of any selected hierarchy. Thus to create a hierarchy within a hierarchy, select the
top level hierarchy part in the list and then choose the appropriate menu item. If no
hierarchical part is selected in the list, new parts are added at the top level of the
hierarchy.

You can move parts around inside the parts list by dragging them to the desired
hierarchy position.

The next sections describe how you can create and use different types of parts in
Mulberry.

5.6.2.3 Manipulating Text Parts

You can create new text parts by choosing an item from the New Text Part sub-menu

in the Draft menu. This will add a new text part of the chosen subtype to the parts
hierarchy list and automatically switch the text display area over to viewing this part.

You can switch the text display area between different text parts by clicking the diamond
buttons in the first column of the parts hierarchy list. These buttons have the same
meaning as those used in incoming message windows (see page 139). The size of the
text part displayed in the parts table is only updated when switching to another part.
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5.6.2.4 Attaching Files to a Message

Choose a folder or disk
to locate files to attach

Files available
to be attached

|ﬁ Docs | — HDB500
‘E Mulberry Admin [ ] To add the selected
£% Mulberry Admin.srd file to the
‘E Read Me [ Desktop ] at.tachment list,
) click here
£% Read Me.srd
saved Draft R 7
To add all the
1 files to the
[ Add All ) attachment list,
click here
Attached files:
[ Remove To remove a file
HUIIJEI'I'IJ [HEITII]I.IE A I] selected in the
special address book N attacments list,
click here
[ Done ]\
| To remove all
[ cancel | \ files from the
attachments list,
click here

Files selected for
attachment

Figure 94 The dialog box used to select and attach files to a draft message
(pre-Mac OS 8 Navigation Services)

MAc OS To attach files to draft messages so that they get sent along with any other

WITH parts, click the Attach button, and the dialog shown in Figure 94 will

gg;’ﬁé;o'“ appear. This allows you to choose any number of files to be attached to
the draft message. You can also drag files directly from the Finder into the
parts list to have those files sent.

OTHERS To attach files to draft messages so that they get sent along with any other

parts, click the Attach button, and choose the files you want to send from
the resulting file open dialog. This allows you to choose any number of
files to be attached to the draft message. You can also drag files directly
from the desktop into the parts list to have those files sent.
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5.6.2.5 Whole Message Parts

You can attach a complete message located on the IMAP server to a draft message. To
do this drag the message out of its mailbox window into the draft message’s parts list.
This will produce a ‘message/rfc822’ part which contains the parts hierarchy for the
original message. You can delete parts from the sub-message’s hierarchy but you cannot
reorder them or add other parts.

5.6.2.6 Parts from other Messages

You can attach parts from messages located on the IMAP server to a draft message. This
allows you to send particular parts of messages that have been sent to you on to
someone else. To do this, drag the parts from the parts list of the original message
window into the draft’s parts list.

5.6.3 Text Display

This displays the text of the currently selected draft message part. You can type the text
for the message here. Mulberry allows you to create and edit plain, enriched or HTML
text. When a draft is first opened, Mulberry chooses the text style based on the settings
in the ‘Outgoing’ preferences panel (see page 55). When editing enriched or HTML
styled text, Mulberry places a toolbar at the top of the text area to allow you to easily
change the formatting of selected text, as well as show the current format of the selected
text. Formatting can also be changed by choosing a command from the Draft menu (see
page 198).

5.6.4 Reference
OPERATIONS ON DRAFT MESSAGE WINDOWS

To save a draft message Choose Save from the File

menu or press Command=-S
(Mac OS) or Ctrl-S

(Windows).
To save a draft message Choose Save As from the
using a different name to the File menu

one previously used

To create additional text parts choose New Text Part from
the Draft menu.

To create multiparts Choose the appropriate item
from the New Multipart sub-
menu in the Draft menu.
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To attach files to a draft
message

Click the Attach button and
add the files you want to
attach.

Drag a file from the Finder into
the expanded parts list.

Drag a file from a parts list in
another draft message window
into the parts list of this draft
message window.

To attach a message from a
server mailbox to a draft
message

Drag the message from its
mailbox window into the parts
list.

To attach one or more parts
from a message in a server
mailbox to a draft message

Drag the parts from the
original message window into
the parts list.

To remove attachments
from a draft message

Select the attachments in the
parts list and press delete.

To include the text of the
message being replied to,
forwarded or bounced

Click the Original button.

Choose Include Original
from the Draft menu.

To include text as a quotation

in the draft message

Copy the text to the clipboard
and choose Paste as
Quotation from the Edit
menu or press Command-’
(Mac OS) or Alt-" (Windows).

To send the message

Click the Send button.

Choose Send from the Draft
menu or press Command-M
(Mac OS) or CtrI-M
(Windows).
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5.7 Address Book Manager Window

Creates anew Opens an existing Deletes an Shows details about  Searches for
address book  address book address book an a/ddress book an address
O0=== Addres|s Book Ma/nager =
S | | ,’E/
Category ~ MNew Open  Delete Details Search
Local address b B Address Books |~
books = =
= ) Iimsp —
Remote address o o 5 gn dahon
book server i _
@ G W B daboo lists
@ G W P company
G D G Eﬁ company . lists
@ G W P company sites £
£t P bl
al [+ [

List of address books

Figure 95 The Address Book Manager window used to manage local and
remote address books

Figure 95 shows the address book manager window. The address book manager is used
to organize local and remote address books. The address book manager window is
divided into three main sections:

The Header section provides buttons to help manipulate address books.

The Column Headers section indicates which information about an address book is
displayed in the corresponding column in the list below.

The Address Book List section shows the list of address accounts and their
corresponding address books.

5.7.1 Header

The New button creates a new address book. In order to do this you must first select an
account (either local or remote) in the address book manager list.

The Open button opens an existing address book. In order to do this you must first
select an account (either remote or local) in the address book manager list. For local

164 Mulberry Reference Guide v2.0



address books, a standard file dialog is then shown allowing you to choose an address
book located on the local machine. For remote address books, a dialog requesting the
name of the address book is shown. You will need to enter the full name of the address
book to open it. In general you will not need to do this as Mulberry displays all remote
address books available to you when you login to the remote address book server. You
can then open a remote address book by double-clicking on it in the address book
manager list.

The Delete button deletes the local or remote address books selected in the address
book manager list. This will permanently remove the address book and all its entries.

The Search button brings the Address Search window (see page 167) to the front ready
to execute a search for an address.

The Details button allows you to configure and see information about the address
books selected in the address book manager list as described on page 167.

5.7.2 Column Headers

The column headers indicate what address book information is displayed in each
column in the list below it. The column indicates with text or an icon what the
information is:

‘Name’ The name of the mailbox or hierarchy.

£ Shows a ‘diamond’ button that can be clicked on or off to have address books
opened on startup.

£2  Shows a ‘diamond’ button that can be clicked on or off to have address books
used for nick-name resolution.

# Shows a ‘diamond’ button that can be clicked on or off to have address books
used for searching for email addresses when using the Address Search Window (see
page 172).

MAc OS To change a category, or to insert a new category, or to delete an existing
category click the mouse button with the command (3 ) key down
(3 -click) on the category title.

WINDOWS To change a category, or to insert a new category, or to delete an existing
category click the right mouse button on the category title.

When you do this the menu shown in Figure 96 will appear giving you the choice of
what category to show in the corresponding column. You can also insert a new column
before or after the one clicked, or delete the column that was clicked.
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Category Open at St_art

column — Resolve Mick=Mame
choice Allow Searching

Insert and Insert Column after
delete E— Insert Column before
commands Delete Column

Figure 96 The pop-up menu used to change column information in the address
book manager window

Note The ‘Name’ column which shows the name of the
address book or address server is always present and cannot be
changed or deleted. You can insert columns before or after it
though.

5.7.3 Address Book List

The address book manager list shows address books within a hierarchy that represents
the local or remote ‘account’ that handles the address books. The first account is always
‘Address Books’ and represents the local storage of address books on the computer on
which Mulberry is currently running. Subsequent accounts are remote address book
accounts setup in the ‘Accounts’ preference panel (see page 68). Different icons are used
to represent the different types of items displayed in each row:

d

+0
*

166

A remote address book server account.

A remote address book server account that is available for use in disconnected
mode. This icon is only shown when in disconnected mode.

A Local address book account.
A remote or local address book that can be opened.

A remote address book that has been synchronized for use in disconnected
mode. This icon is only shown when in disconnected mode.

A remote address book whose contents are only available while in connected
mode. This icon is only shown when in disconnected mode.
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5.7.4 Getting Information on Address Books

Information about address books can be displayed by selecting the address book and

then choosing Properties from the Edit, or clicking the Details button in the
address book manager header (see page 164). This will display the dialog shown in
Figure 97 which will have two different panels displaying different information about

the address book:
‘General’

‘Access’

Address Book:daboo

i - Geera |

General

Hame: |daboo

Server: |imsp.cgrusoft.com

Addresses:
Tatal:
Single:
Group:

D Open on Startup

[ Use for Hick-names
[ Use for Searching

Click button here Different panels
to see a different are shown here
panel

Figure 97 The Address Book Properties dialog showing the ‘General’ panel

Mulberry Reference Guide v2.0

167



5.7.4.1 Address Book Properties: General

General o
Mame ! |daboo | e

SEFVEF:|im5p.:gru5ﬂft.cnm |

Addresse=:

Total:
Single:

1

Group :

] Open an Startup
[¥] Use for Hick-names
[#] Use for Searching

[+¥] Sunchronise on Disconnect

Figure 98 The Address Book Properties ‘General’ panel

The items in this panel are:

‘Name’ The name of the local address book or full pathname of the remote
address book.

‘Server’ The internet address of the server on which this address book is located.

‘Addresses’  These items will only be available if the address book is open. This
will always be the case for local address books, but not necessarily for remote address
books which may be listed in the address book manager but may not be open in
Mulberry.

- ‘Total’ The total number of addresses and groups in the address book.
- ‘Single’ The number of single addresses in the address book.
— ‘Groups  The number of groups in the address book.

‘Open on Startup’ If turned on, the address book will be opened whenever the
current preference set is opened, including when Mulberry next starts up.

‘Use for Nick-names’ If turned on, the address book will be used for nick-name
resolution when typing addresses into an address field in a draft window. If the
address book is local, it must also be open in Mulberry for nick-name resolution to
take place. If it is a remote address book, Mulberry must be logged in to the server,

168 Mulberry Reference Guide v2.0



but the address book need not be open in Mulberry as nick-name resolution can be
done remotely.

‘Use for Searching’ If turned on, the address book will be used for searching
when searching address books (see page 172).

‘Synchronise on Disconnect’ If turned on, the address book will be synchronised
when disconnecting from the network, provided that address book synchronisation
has been requested in the disconnect dialog (see section 5.2.5).

Address book state icon:

@ An address book on a remote server.

E An address book on the local machine.

B An address book on a remote server that is
+ available for use in disconnected mode. This icon
is only shown when in disconnected mode.

5.7.4.2 Address Book Properties: Access

Access Control List

__Key

User ID 9 Fﬁ @ E%] = Lookup
Current User: N R N I =d Read
dabon W W W W W W Ffl ¥rite
wall @ W N B G % @ Create
justin . I ) Delete
vince LR I R %M_

min

[Neleser'...] [ Delete ] Style: @

Figure 99 The Address Book Properties ‘Access’ panel
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The ‘Access’ panel displays information about the access control list for the address
book. This is the list of users who have ‘rights’ to the address book. For address books,
there are a total of six rights or privileges that can be applied to each user. These are:

=X ‘Lookup’ - if set, the user is able to see the address book if they attempt to list it.
‘Read’ - if set, the user is able to see addresses or groups in the address book.

Fi ‘Write’ - if set, the user can change any address or group in the address book,
but not delete them.

@ ‘Create’ - if set, the user can create sub-hierarchies of address books below the
current address book.

& ‘Delete’ - if set, the user can delete addresses or groups from the address book.

% ‘Admin’ - if set, the user is able to change the access control list for the address
book.

The rights that you have to the address book are shown in the ‘Current User:’ row at
the top of the access control list table. All users’ rights are then shown in the table below
this. Each row consists of a user id, followed by six icons or buttons representing the
state of the right for that user. This table behaves in exactly the same way as the one
used to set the access control for mailboxes (see page 101).

5.7.5 Reference
OPERATIONS ON ADDRESS BOOKS

To bring the Address Book Choose Address Book
Manager window to the Manager from the

front
Addresses menu.

To create a new address book  choose New Address Book
from the Addresses menu
after selecting an address
server, or click the New

button.
To open one or more Pressret urnor ent er on the
selected remote address keyboard, or click the Open
books button.

Double-click any one of the
selected address books.
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To open an address book

Choose Open Address

Book from the Addresses
menu, or click the Open
button

To rename one or more
selected address books

Choose Rename Address

Book from the Addresses
menu.

To import addresses from a
different type of address book
into the selected address
book

Choose Import Addresses
from the Addresses menu.

To export addresses in the
selected address book to a
different type of address book

Choose Export Addresses
from the Addresses menu.

To delete one or more
selected address books

Choose Delete Address

Book from the Addresses
menu, or click the Delete
button.

To login to the selected
remote address book server

Choose Login from
Addresses menu.

Double-click the remote
address book server.

To logout from the selected
address book server

Choose Logout from the
Addresses menu.

To see information about the
selected address book

Choose Properties from the

Edit men, press Command-|
(Mac OS) or Ctrl-1 (Windows).
or click the Details button.

To search for addresses in
address books marked for
searching

Choose Search from the

Addresses menu or click the
Search button.
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5.8 Address Search Window

‘Field” pop-up ‘Method’ pop- ‘Match’ pop- ‘Server’ choice Search Create new
menu up menu up menu pop-up menu data  draft message
| AN— |
[0 =————— Address Search = B
|
Find |tems ['u5ing LOAF — ] Seruer E whose
{ Email Address — ][ Conhtains — ] |E|:|Fu5th |
Clear search
results §E:‘E \§._.:_._
Start search =i = |
Search Clear Message
C_ategory Full hamme Ernail Address
titles
_ = %1. Full HName = ¥ince [ |
Different _ _
search D ¥ince Everrett wince@cyrusoft.com
results || =7 %1 Email Address = cyrusoft
l:;' Mulberry Sales sales@cyrusoft.com
D Mulberry Support support@cyrusoft.com
D Yince Everrett vince @cyrusoft.com
[ |
4] b Lz

Search results list

Figure 100 The Address Search window used to search for addresses in
local and remote address books, or using directory services

Figure 100 shows the Address Search window. This is used to perform searches for
addresses either in local or remote Mulberry address books, or using a directory lookup

protocol.
The Address Search window is divided into four main sections:

The Criteria section is used to specify the criteria for the search operation.
The Button section allows has various buttons for common actions.

The Column Headers section indicates which information about an address is
displayed in the corresponding column in the list below.

The Results section displays a list of search results.
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5.8.1 Criteria

The address criteria section allows the search criteria to be specified. It consists of three
pop-up menus and one text field:

The ‘method’ pop-up menu (shown in Figure 101) allows you to choose between the
various types of address accounts available for searching:

- ‘in Address Books’ will search those Mulberry address books that have the ‘Use
for Searching’ option turned on (see page 168).

- ‘using LDAP’ will use any LDAP directory accounts selected in the ‘Server choice’
popup menu.

in Address Books
using LDAP

Figure 101 The method pop-up menu used to select the method to use for
the address search

* The ‘server choice’ pop-up menu (shown in Error! Reference source not found.)
only appears when LDAP has been chosen as the search method. The pop-up allows
each individual LDAP server to be searched in turn if desired.

The ‘field’ pop-up menu (shown in Figure 102) allows you to choose which address
field to search. These are the fields available in a Mulberry address book (see
page 179).

Full Name
Mick-Mame
Email Address
Company
Address
Phone Work
Phone Home
Fax

LRLs

Motes

Figure 102 The field pop-up menu used to select which field to search on
when doing an address search

The ‘match’ pop-up menu (shown in ) allows you to choose which part of the
address field you want to look for text in:
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- ‘Is’ will attempt to find addresses with fields exactly matching the search text.

- ‘Starts with’ will attempt to find addresses with fields which have the search text
at the start.

- ‘Ends with’ will attempt to find addresses with fields which have the search text
at the end.

- ‘Contains’ will attempt to find addresses with fields which have the search text
contained anywhere within it.

Is

Starts with
Ends with
Contains

Figure 103 The match pop-up menu is used to select which part of the
address text to compare with the search text

The text field allows you to enter the text to search for. Pressing r et ur n or ent er on
the keyboard will initiate the search. You can use a **’ as a wildcard character to
match one or more occurrences of any character. e.g. ‘cyru*’ will match ‘cyrus’ and
‘cyrusoft’. When you use the ‘Starts with’, ‘Ends with’ or ‘Contains’ options for the
‘Contains’ popup menu, Mulberry automatically includes a “*’ in the appropriate
place for the search. E.g. assuming the text field is set to ‘search’

- ‘Starts with’; actual text searched ‘search*’.
- ‘Ends with’ ; actual text searched “*search’.

- ‘Contains’ : actual text searched ‘“*search*’.

5.8.2 Buttons

The button section contains the following buttons:
Search - initiates a search using the criteria provided.
Clear — removes all search results from the results list.

Message — creates a new draft message with its address fields automatically filled

in with any selected entries in the results list. There are two ways to use the
Message button which depend on whether the Option (Mac OS) or Alt
(Windows) key is held down when clicking the button or not. The choice of action is
determined by the ‘Addresses’ preference panel (see page 60).

In one case a new draft message window is automatically created with its ‘To>’
address field filled in with the selected entries in the active list.
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In the second case Mulberry will display a dialog (similar to the one shown in
Figure 84) which allows you to choose which addresses from the selection in the
active list are to be used in the draft message and in which address fields they
should appear. You can choose where to put each address in the draft message by
clicking on or off one of the diamond buttons next to the address. Once the
required choice is made, click the New Message button or pressr et ur n to
create a new draft message with the requested addresses automatically filled in.

5.8.3 Column Headers

The column headers indicate what address information is displayed in each column in
the list below it.

MAc OS To change a category, or to insert a new category, or to delete an existing
category click the mouse button with the command (3 ) key down (3£ -
click) on the category title.

WINDOWS To change a category, or to insert a new category, or to delete an existing
category click the right mouse button on the category title.

When you do this the menu shown in Figure 104 will appear giving you the choice of
what category to show in the corresponding column. You can also insert a new column
before or after the one clicked, or delete the column that was clicked.

Full Name
Mick-MName
Email Address
Company
Category Address
gﬁg’l?en ~ || PhoneWork
Phone Home
Fax
LRLs
Motes
Insert and Insert Column after
delete — Insert Column before
commands Delete Column
Figure 104 The pop-up menu used to change column information in the

address search window
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5.8.4 Results

The results lists shows results of searches. Each search is shown in its own hierarchy,
with the hierarchy row shown in gray, and with a description of the search criteria used
to generate that particular set of results. You can collapse or expand a hierarchy by
clicking on the disclosure button next to the description.

The search results will not be deleted when the window is closed, but they will be lost
when quitting from Mulberry. You can remove all the results using the Clear button.
You can delete an entire hierarchy by selecting the hierarchy description row and
pressing del et e. You can delete individual search results by selecting them and
pressing del et e.

Each address can be edited by double-clicking on the address entry. This will display the
dialog shown in Figure 107, which can be used to edit the address.

Addresses in the results table can be copied to an address book or to a draft window

address field either through the clipboard Copy and Paste functions, or by using drag
and drop to drag the addresses of interest to their destination.

5.8.5 Reference

SEARCHING ADDRESS BOOKS

To bring the Address Search Choose Search from the
window to the front

Addresses menu.

Click the Search button in the
Address Book Manager
window.

To start a new search Click the Search button.

Pressret urnor ent er on the
keyboard after entering text in
the text field.

To delete all search results Click the Clear button.

Press cl ear on the keyboard.

To delete selected search Press del et e on the keyboard.
result sets

To delete selected individual Press del et e on the keyboard.
address search results

To change one or more Double-click the selected
selected individual address address, or press r et urn or
search results ent er on the keyboard.
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To create a draft message
using one or more selected
addresses or groups

Choose New Message from
the File menu or press

Command-=N (Mac OS) or
Ctrl-N (Windows).

Click the Message button in
the address book windowv.

To copy one or more selected
addresses to a draft message

Choose Copy from the Edit
menu or press Command-C
(Mac OS) or Ctrl-C
(Windows), go to the address
in the draft message and
choose Paste from the Edit

menu or press Command-=V
(Mac OS) or Ctrl-N
(Windows).

Drag the selected items to the
address field in the draft
message window.

(This feature is only available if
Drag and Drop is supported)

To add one or more selected
addresses to an address book

Mulberry Reference Guide v2.0

Choose Copy from the Edit

menu or press Command-C
(Mac OS) or Ctrl-C
(Windows), go to the address

book window choose Paste
from the Edit menu or press

Command=V (Mac OS) or
Ctrl-N (Windows).

Drag the selected items to the
single address table in the
address book window.

(This feature is only available if
Drag and Drop is supported)
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Drag the selected items to the
address book listed in the
Address Book Manager
window.

(This feature is only available if
Drag and Drop is supported)
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5.9 Address Book Window

To show or hide

the group list, To create a new
To show or hide the click here address or group,
S|Irlgklehaddress list, click here To delete a selected
click here address or group,
/ click here
== tltl;«(ﬂ[l[l sshmok=EHH To create a new draft
= = message with the
3 @ §Ij§j:j’ §:I . selected address filled
== in, click here
Single Group MNew  Delete Mez=sage
Sort By: [ Last Hame — I
Show: | Emai | Address —

custormer @domai noconm
happuedomain.uk

everyone@domain.uk ) )
The list of single

addresses

friend @damain.uk
mulberry®dial . pipex.com
somebody&domain.uk

Split-pane divider

I [ Family =] [ used to resize lists
= E»l'_qr' Friends Zggrgz'; eosf groups of
friend@domain.uk
= [33 Mulberry The name of
customer @domai n.uk | agroup
mulberry@dial.pipex.com | — Q?tirﬁszezroup
Addresses: E Groups D E

The number of single The number of
addresses in the groups in the
address book address book

Figure 105 A typical address book window

Figure 105 shows a typical address book window.
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Address books allow you to store commonly used email addresses and groups of
addresses. Address books can either be stored locally on the computer running
Mulberry, or remotely on a server. Address books are managed using the Address Book
Manager window.

You can assign ‘nick-names’ to addresses and groups, which you can then enter in
address fields in draft message windows. Mulberry will automatically substitute the
correct email address when it sends the message.

Note Nick-name resolution only works if the address book
containing the nick-name has been marked for nick-name
resolution in the Address Book Manager Window. In addition,
local address books must be open for nick-name resolution to
take place. To this end, Mulberry will issue a warning
whenever you attempt to close a local address book window.

You can specify any number of address books to be opened when a preference set is
opened by turning on the ‘Open at Startup’ option for the address book in the Address
Book Manager window.

An address book window is divided into three main sections:

The header section provides buttons and pop-up menus for changing the
appearance of the address book and for editing entries.

The single address list section shows the list of single addresses in the address book.

The group list section shows a hierarchical list of groups with their corresponding
addresses.

5.9.1 Header

The Single and Group buttons can be used to toggle the display of the single address
and group lists. In Figure 105 both lists are visible, so clicking on one of these buttons
will hide the corresponding list, shrinking the size of the window.

The New button can be used to create new entries in the active list. To activate a list,
select it by clicking in it (the active list appears with a black border around it as the
single address list in Figure 105 has). Similarly, the Delete button is used to delete the
selected entries from the active list.

5.9.1.1 Creating Messages with the Address Book

The Message button is used to create a new draft message with its address fields
automatically filled in with any selected entries in the active list. There are two ways to
use the Message button which depend on whether the Option (Mac OS) or Alt
(Windows) key is held down when clicking the button or not. The choice of action is
determined by the ‘Addresses’ preference panel (see page 60).
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In one case a new draft message window is automatically created with its ‘To:’
address field filled in with the selected entries in the active list.

In the second case Mulberry will display a dialog (similar to the one shown in Figure
84) which allows you to choose which addresses from the selection in the active list
are to be used in the draft message and in which address fields they should appear.
You can choose where to put each address in the draft message by clicking on or off
one of the diamond buttons next to the address. Once the required choice is made,
click the New Message button or pressr et ur n to create a new draft message with
the requested addresses automatically filled in.

5.9.1.2 Displaying Address Details

The two pop-up menus are used to determine what information is shown in the single
address field and what method of sorting is used to display the addresses. The menu
choices are shown in Figure 106.

Sort By:| First Mams - Show: | Full Mame -
Last MHame Email Address
E-mail Address Mick-rname
E-mail Domain Compariy
Mick-rame
Comparny
Figure 106 The choices available for sorting and displaying addresses in

an address book window

5.9.2 Single Address List

The single address list shows single addresses in the address book. The information
displayed is determined by the ‘Show’ pop-up menu in the address book header. The
order of addresses in the list is determined by the ‘Sort By’ pop-up menu in the address
book header.

5.9.2.1 Creating a New Address

To create a new entry in the single address list, first make sure it is active by clicking
inside it and then click the New button in the address book header. This will display
the dialog shown in Figure 107. Enter the values you desire and then click OK. The
‘Nick-name’ field can be used as an alias for the email address. This can be entered in
any draft message window and Mulberry will resolve the nick-name to its proper email
address provided the address book containing it is open.
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Address bHlit=—-——— H

Mick—Name: [custi Phone Hork: [+1 412 605 04992 |

Ful | Mame: [First Customer Phone Home: [+1 412 605 0499 |

|
I

Emai | : |cu5tnmer@dnmuin.cnm | Fox: |+1 412 G053 07035 |
I

Compay : |Emui| Lid

Address: 221 SMTP Driwe,
Protocol Parkway,
Homa Town. ]

RFC 822,
URL=: Ritp: Afwow, cgrusoft . comfmulberey
Motes: First ewver Mulberry customer.

Hopeful ly wvery satisfied.

|Cance|| | oK I

Figure 107 The new address dialog, which is also used for editing
address information

5.9.2.2 Editing an Address

To edit an address in the single address list double-click it. The dialog shown in Figure
107 will again appear allowing you to change the values previously entered.

5.9.2.3 Copying Addresses

You can drag and drop addresses between address books or to a draft message window
to copy an address to another location.

5.9.3 Group List

The group list shows groups of addresses in the address book. You can group any
number of single addresses or other groups together in a group, which can then be
referred to by a nick-name. When a group nick-name is resolved all the addresses in
the group will be inserted into the address field. Mulberry can resolve up to 10 levels of
nested groups as well.

5.9.3.1 Creating a Group

To create a new entry in the group list, first make sure it is active by clicking inside it
and then click the New button in the address book header. This will display the dialog
shown in Figure 108. Enter the values you desire and then click OK. The ‘Nick-Name’
field can be used as an alias for the group. Single addresses or groups should be typed
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into the ‘Addresses’ field. Entries in the ‘Addresses’ field can also be alphabetically
sorted by clicking the Sort button.

Group Edit "ia7————=—H

Mick—MHame: |Hu|bEPPg |

Group Hume:lﬁulberwg U=er= |

Addresses: |customerBdomain.uk S
mulberrygediaql .pipex. com

-
Figure 108 The new group dialog, which is also used for editing a group

5.9.3.2 Editing a Group

To edit a group in the group list, double-click it. The dialog shown in Figure 108 will
again appear allowing you to change the values previously entered.

5.9.3.3 Copying Groups

You can also drag and drop or copy and paste addresses from a single address field into a
group. You can drag and drop groups between address books or to a draft message
window to copy the group to another location.

5.9.4 Reference
OPERATIONS ON ADDRESS BOOKS

To create an address book Choose New Address Book

from the Addresses menu
with either the ‘Local’ or a
remote server item selected in
the Address Book Manager
window.
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To open an address book
from disk

Choose Open Address

Book from the Addresses
menu with either the ‘Local’ or
a remote server item selected
in the Address Book Manager
window..

To import addresses into an
address book from a different

format address book

Choose Import Addresses

from the Addresses menu.
You can import
‘Communicator’, ‘Pine’,
‘Eudora’ or ‘Netscape’ address
entries.

To export an address book in

another format

Choose Export Addresses

from the Addresses menu.
You can export as
‘Communicator’, ‘Pine’,
‘Eudora’, or ‘Netscape’.

To save an address book

Choose Save from the File

menu or press Command-S
(Mac OS) or Ctrl-S
(Windows).

To save an address book
using a different name

Choose Save As from the
File menu.

To create a new address

Select the single address list
and click the New button in
the address book windowv.

To change one or more
selected single addresses

Double-click the selected
address.

To delete one or more
selected addresses

Click the Delete button in the
address book window.

To create a new group

Select the group list and click
the New button in the address
book window.

To add addresses or other
groups to a group

Drag the selected addresses or
groups to the another group.
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Double-click the destination
group and type the addresses or
groups you want added.

To change one or more
selected groups

Double-click the selected
group.

To delete one or more
selected groups

Click the Delete button in the
address book window.

To create a draft message
using one or more selected
addresses or groups

Choose New Message from
the File menu or press

Command-=N (Mac OS) or
Ctrl-N (Windows).

Click the Message button in
the address book windowv.

To copy one or more selected
addresses or groups to a draft
message

Choose Copy from the Edit

menu or press Command-C
(Mac OS) or Ctrl-C
(Windows), go to the address
in the draft message and

choose Paste from the Edit

menu or press Command-=V
(Mac OS) or Ctrl-V (Windows).

Drag the selected items to the
address field in the draft
message window.

To add addresses from a
message to an address book

Drag the message from its
mailbox window into the
address book window.
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6. MENU REFERENCE

6.1 File Menu

Mew hMessage 3EMN
Open Mailbox... £+ 30
Open Message 30
Open Draft...

Import Text...

Close WY
have 3ES
Save As...

Revert

Preferences...

Disconnected Mode...
Show Outgoing Queues

Page Setup...
Print... #*P
Quit #10Q
New Message Creates a new draft message window in which you can create

Command-N Mmessages to send.

Open Mailbox Opens a new mailbox or a selected mailbox depending on the
Shift-Command-0 current selection in the top server window.

Open Message Opens the selected messages in the top mailbox window.
Command-0

Open Draft Opens a previously saved draft message from disk.

Import Text Inserts text from any text file at the current selection position

in a draft message window.
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Close Closes the active window.
Command-W
Save Saves the current message, draft message or address book to
Command-s disk.

Save As Saves the current draft message or address book to disk
allowing you to choose the file location and name.

Revert Discards changes to the current draft message or address
book.

Preferences Opens the ‘Preferences’ dialog box to allow the settings for

the application to be changed.

Disconnected Mode

Switches Mulberry between connected and disconnected
mode.

Show Outgoing

Opens the ‘Outgoing Message Queues’ window or brings it to
the front.

Queues
Page Set-up Sets paper size, orientation and other printing options for
printing messages.
Print Allows selected messages in a mailbox window or messages
Command-p displayed in their own window to be printed.
Quit Quits from Mulberry. This will close all open windows

Command-Q

(allowing any unsaved changes to be saved or discarded) and
logs out of the mail server if its still logged in to.
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6.2 Edit Menu
Undo L
Cut X
Copy 3#EC
Paste Y
Paste as Quotation 38"
Clear
Select All A
Find... EF
Find Next #0
Find Selection #H
Replace #bB
Replace & Find Next #ET
Replace All
Properties... #1
Change Password...
Check 5pelling -
Spelling Options...
- Choose...
Dictionary b Edit...
Undo Undoes the previous editing action.
Command-Z
or
Redo Redoes the previous editing action that was undone.
Command-Z
Cut Cuts the current text selection in the active window to the
Command-x clipboard.
Copy Copies the current text selection in the active window to the
Command-c clipboard.
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Paste
Command-V

Pastes the text contents of the clipboard at the selection
position in the active window.

Paste as Quotation
Command-'

Pastes the text contents of the clipboard into at the selection
position in the active draft message. The text is indented
using the quotation character from the ‘Outgoing’
preferences panel

Clear Remove the current selection in the active window.
Select All Selects all available items in the active window. This could
Command-A Detextinamessage or draft message window, messages in a
mailbox window, mailboxes in a server window, or addresses
and groups in an address book window.
Find Display the Find and Replace dialog that can be used to find

Command-F

and replace text in a message or draft window.

Find Next
Command-G
Shift-Command-G

Finds the next occurrence of text in a message or draft

window. If the shift key is down, the previous occurrence is
searched for.

Find Selection
Command-H
Shift-Command-H

Finds the next occurrence of the currently selected text in a

message or draft window. If the shift key is down, the
previous occurrence is searched for.

Replace
Command-B

Replace the currently selected text with that previously
specified in the Find dialog.

Replace & Find Next
Command-T
Shift-Command-T

Replace the currently selected text with that previously
specified in the Find dialog, and then find the next

occurrence of the text. If the shift key is down, the previous
occurrence is searched for.

Replace All Replace all occurrences of the text to find with the text
specified in the Find dialog.
Properties Displays a dialog box that gives detailed information about
Command-] the selected item.

Change Password

Allows passwords for accounts setup in the preferences to be
changed using password plugins installed in the Plug-ins
folder.

Check Spelling
Option-Command-L

Checks the spelling of the currently selected text in a message
or draft window. If there is no selection the entire text will be
checked. Only text in a draft window can be replaced with
corrections.
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Spelling Options Displays a dialog allowing various spell checking options to

be set.
Dictionary Choose  Allows a new default dictionary to be set for use
when spell checking.
Edit Allows the current default dictionary to be

edited.
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6.3 Mailboxes Menu

Mailboxes

Create... New Display Hierarchy...
Rename... Edit Display Hierarchy...
Remove Display Hierarchy...
hMark Contents S5een P
Delete... Refresh
Expunge 3#EE -
Synchronise... New Cabinet..
Clear Disconnected.., Edit Cabinet...
Remove Cabinet...
Display Hierarchy 4
Cabinets b Add Wildcard Item...
Edit Wildcard ltem...
Subscribe #=
Unsubscribe 3 - Remove Item
To
Check Mail #L From
Check Favourites 3L Reply To
Sender
Sort By 4 cr
Subject
Goto Message... EG Thread
Load All Messages Date Sent
Date Received
Search... HY Sizp
Search Again SRY Flags
Smart Address
Attachments
Parts
Matching
Disconnected
Create Creates and opens a new mailbox on the server. A dialog

appears asking for the name of the new mailbox.
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Rename

Renames any mailboxes selected in the active server
window. A dialog appears asking for the new name.

Mark Contents Seen
Option-Command-P

Marks any unseen messages as seen in the entire mailbox.

Delete

Deletes any mailboxes selected in the active server window.

Expunge
Command-E

Expunges the deleted messages in the active mailbox
window. This will permanently remove any messages
flagged as deleted from the mailbox.

Synchronise

Synchronises the messages in the active mailbox window or
any mailboxes selected in the active server window.

Clear Disconnected

Clears the disconnected message cache for the active mailbox
window or any mailboxes selected in the active server
window.

Display Hierarchy

New Display Hierarchy
Creates a new display hierarchy in the currently
selected server. This can be used to create a new
hierarchy of mailboxes to view.

Edit Display Hierarchy
Edits the root name for the currently selected display
hierarchies in the active server window.

Remove Display Hierarchy
Removes the currently selected display hierarchies
from the server window. This does not delete any
mailboxes, it merely removes them from the server
window display.

Refresh
Refreshes any selected display hierarchy, or all the
display hierarchies in a selected server. Refreshing
forces the mailbox list to be updated from the server.

192

Mulberry Reference Guide v2.0



Cabinets

New Cabinet
Creates a new mailbox cabinet in the server window.

Edit Cabinet
Edits the name of the currently selected mailbox
cabinets in the server window.

Remove Cabinet
Removes the currently selected mailbox cabinets from
the server window. This does not delete any mailboxes,
it merely removes the cabinet and its contents.

Add Wildcard Item
Creates a new cabinet item that is able to match a group
of mailboxes using search criteria.

Edit Wildcard Item
Edits the name of a cabinet item that is able to match a
group of mailboxes using search criteria.

Remove Item
Removes an item from a mailbox cabinet. This does
not delete any mailboxes, it merely removes the cabinet
item from the server window.

Subscribe
Command-=

Adds any mailboxes selected in the active server window to
the server’s list of ‘subscribed’ mailboxes.

Unsubscribe
Command--

Removes any mailboxes selected in the active server window
from the server’s list of ‘subscribed’ mailboxes.

Check Mail
Command-L

Checks for new mail arriving in any mailboxes selected in
the active server window, or in the active mailbox window.

Check Favourites
Shift-Command-L

Checks for new mail arriving in any mailboxes marked for
automatic checking.

Sort By

Provides a hierarchical menu to choose the sorting method
for the active mailbox window.

Goto Message
Option-Command-G

Allows the selection in the active mailbox window to be
moved to a specific message number.

Load All Messages

Forces the loading of all message details when a mailboxes
message cache is not complete.

Search
Command-Y
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Search Again Applies the previously used search criteria to the current
Shift-Command-Y mailbox or currently selected mailboxes in the server
window.

Next Search Closes the current mailbox and opens the next mailbox
Option-Command-Y which has search results from the last search carried out.
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6.4 Messages Menu

Read Previous E[

Read MNext #]

Delete & Read Next S

Copy & Read Mext 3N,

Reply 3R

Reply to Sender

Reply to From

Reply to All EK

Forward 31

Bounce

Send Again

Create Digest

Copy to Mailbox 4 Seen “CH 1

Copy Now SHC Important 32
Answered "C33

Flags b Deleted “C#4
Drait S

Extract Parts 3

Decode Embedded 4 BinHex

Yerify/Decrypt LU

Delete 3D

Show Header o 3¥H

Read Previous

Command- [

Displays the previous message in the mailbox in the active
message window.

Read Next

Command-]

Displays the next message in the mailbox in the active
message window.

Delete & Read

Command-/

Next Deletes the message and displays the next message in the
mailbox in the active message window.
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Copy & Read Next
Command-\

Copies the message to the mailbox selected in the ‘Copy To’
pop-up menu, and displays the next message in the mailbox
in the active message window.

Reply
Command-R

Creates a reply to the message in the active message window.
A draft message window is created and the ‘To:” and ‘Subject:’
fields automatically filled in.

Reply to Sender

Creates a reply to the sender of the message in the active
message window. A draft message window is created and the
‘To:” and ‘Subject:’ fields automatically filled in.

Reply To From Creates a reply to the ‘From:” address of the message in the
active message window. A draft message window is created
and the ‘To:” and ‘Subject:’ fields automatically filled in.

Reply to All Creates a reply to all the recipients and the sender of the

Command-K

message in the active message window. A draft message
window is created and the ‘To:’, ‘Cc:” and ‘Subject:’ fields
automatically filled in.

Forward
Command-J

Forwards the message in the active message window. A new
draft message window is created and the ‘Subject.’ field is
automatically filled in. The original message is automatically
guoted in the draft

Bounce Bounces the message in the active message window. A new
draft message window is created, the ‘Subject:’ field is
automatically filled in, and the MIME parts of the original
message are included in the new message.

Send Again Resends the message in the active message window. A new

draft message window is created and all the fields filled in
with the same values as the original message.

Create Digest

Makes a multipart/digest draft from the selected messages in
the active mailbox window.

Copy to Mailbox

Copies selected messages in the active mailbox window or
the message in the active message window to the mailbox
chosen from the sub-menu.

Copy Now
Shift-Command-C

Copies the message in the active message window to the
mailbox selected in the ‘Copy To’ pop-up menu in the active
message window.

Flags

Inverts flags for the message in the active message window.
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Extract Parts
Command-;

Extracts the parts selected in the parts list in the active
message window to disk.

Decode Embedded

Decodes the text currently displayed in a message window as
a BinHex attachment, or a UU attachment based on the
choice from the hierarchical menu.

Verify/Decrypt Verifies a digital signature or decrypts and encrypted message
part or the entire message.
(Only available if the PGP Plugin is present)

Delete Deletes the message in the active message window. This only

command-p flags the message as deleted, it does not permanently remove

it from the mailbox.

or

Undelete Undeletes the message in the active message window.

Command-D

Show Header
Option-Command-H
or

Hide Header
Option-Command-H

Shows the mail header of the message in the active message
window.

Hides the mail header of the message in the active message
window.
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6.5 Draft Menu

Include Original

Plain

Bold
fiakic
Underline

Align Left
Center
Align Right
Justified

Black
Red
Green
Blue
Yellow

Cyan

Insert Signature L3RS
Plain
Attach File... Enriched
New Text Part b HTML
Mew Multipart p Mixed “C®M
Parallel
Send T Digest
Append to Mailbox » Alternative
Append Now L 380
Sign
Encrypt Delivery Success
. . Delivery Failure
Notifications 4 Delivery Delay
i Return Entire Messaqe
Wrap Lines
Linwrap Lines
Quote Lines
Lnquote Lines 9
Requote Lines 38" 10
Shift Left o] 12
shift Right o] :‘B‘
Font » 24
Size 4
Style 4
Alignment 4
Colour 4
198

Magenta
Mulberry
White
Other...
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Include Original

Includes the message being replied to in the active draft
message window. This will copy the text of the message being
replied to into the active draft message window at the
selection point and quote it using the quotation character.

Insert Signature
Shift-Command-S

Inserts the signature for the current identity at the insertion
point in the text display.

Attach File

Attaches a file to the active draft message window. Specified
files can be attached and sent with the message.

New Text Part

Plain
Enriched
HTML

Adds a new MIME text part to the active draft message
window and switches the text display to the new part.

The added part is a text/plain part.

The added part is a text/enriched part.

The added part is a text/html part.

New Multipart

Mixed
Option-Command-M

Adds a MIME multipart part to the active draft message
window.

The added part is a multipart/mixed part.

Parallel The added part is a multipart/parallel part.

Digest The added part is a multipart/digest part.

Alternative The added part is a multipart/alternative part.

Send Sends the message in the active draft message window.

Command-M

Append to Mailbox

Copies the draft message in the active draft message window
to the mailbox chosen from the sub-menu.

Append Now
Shift-Command-M

Copies the draft message in the active draft message window
to the mailbox selected in the ‘Copy To’ pop-up menu in the
active draft message window.

Sign

Digitally signs the current draft message.

(Only available if the PGP Plugin is present)
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Encrypt

Encrypts the current draft message.

(Only available if the PGP Plugin is present)

Notifications

Turns on Delivery Status Notifications for different delivery
conditions.

Delivery Success
Selects a status notification for successful delivery.

Delivery Failure
Selects a status notification for failed delivery.

Delivery Delay
Selects a status notification for delayed delivery.

Return Entire Message
Turns on or off the return of the entire message or just
it headers in the status notification.

Wrap Lines

Insert carriage returns into the selected text so that each line
is no longer than the wrap length specified in the
preferences.

Unwrap Lines

Removes carriage returns from the selected text so that the
text can be reflowed within each paragraph. Only one carriage
return will be removed from a consecutive set of carriage
returns so that the paragraph formatting is unaffected.

Quote Lines

Inserts the currently defined quotation string at the start of
each line of selected text, and ensures that each line is
terminated by a carriage return and is no longer than the
wrap length specified in the preferences.

Unquote Lines

Removes the currently defined quotation string from the
start of each line of selected text.

Requote Lines
Shift-Command-’

Performs the Unquote Lines, Unwrap Lines, and Quote
Lines commands in sequence.

Shift Left Removes a tab or an equivalent number of spaces from the
Shift-Command-[ Start of each line of selected text.
Shift Right Adds a tab or an equivalent number of spaces to the start of

Shift-Command-1]

each line of selected text, and ensures that each line is
terminated by a carriage return and is no longer than the
wrap length specified in the preferences.

Font

Changes the font of the selection in the active draft message
window’s text display, when composing a styled text message.
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Size

Changes the font size of the selection in the active draft
message window’s text display, when composing a styled text
message.

Style

Changes the text style of the selection in the active draft
message window’s text display, when composing a styled text
message.

Alignment

Changes the line alignment of the selection in the active
draft message window’s text display, when composing a
styled text message.

Color

Changes the text color of the selection in the active draft
message window’s text display, when composing a styled text
message.
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6.6 Addresses Menu

Address Book Manager

Mew Address Book
Open Address Book...
Rename Address Book...

Import Addresses
Export Addresses

Delete Address Book...

Login...
Logout
Refresh List

Svnchronise...
Clear Disconnected...

Expand Address #Ereturn

Search..

Address Book
Manager

Brings the address book manager window to the front, and
shows it if it was hidden.

New Address Book

Creates a new local or remote address book depending on
what is selected in the Address Book Manager window, or
whether any remote address book accounts are available.

Open Address Book

Creates a new local or remote address book depending on
what is selected in the Address Book Manager window, or
whether any remote address book accounts are available.

Rename Address
Book

202

Renames the currently selected address books in the address
book manager window, or the active address book.

Mulberry Reference Guide v2.0



Import Addresses

Imports addresses from a different format address book into
the active address book.

Export Addresses

Saves the active address book in a different address book
format.

Delete Address

Deletes the currently selected address books in the address
book manager window, or the active address book.

Book
Login Logs in to the currently selected remote address book server.
Logout Logs out from the currently selected address book server.

Refresh List

Refreshes the list of address books for the server selected in
the address book manager window.

Synchronise

Synchronises any address books selected in the address book
manager window.

Clear Disconnected

Clears the disconnected address cache for any address books
selected in the address book manager window.

Expand Address
Command-return

Expands an address in an address entry field by doing a search
of address books.

Search

Brings the address search window to the front, and shows it
if it was hidden.
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6.7 Windows Menu

Save Default Window

Reset To Default

Expand Header A

Show Parts o
« Status

imap.cyrusoft.com #1

INBOX #E2

WINDOWS ONLY

Cascade

WINDOWS ONLY

Stack the windows one on top of another with a horizontal
and vertical offset between each.

WINDOWS ONLY

Tile Horizontally

WINDOWS ONLY

Tile the windows so they fill the full width of the main
window.

WINDOWS ONLY

Tile Vertically

WINDOWS ONLY

Tile the windows so they fill the full height of the main
window.

Save Default Window

Saves the current window’s position and size as the default
for that type of window.

Reset to Default

Resets the current window’s position and size to the default
for that type of window.

Expand Header
Option-Command-A

Collapses or expands the active window’s header area.

Show Parts
Option-Command-B

Collapses or expands the active window’s parts list.

Status

204

Shows or hides the Status window based on its current state.
If it is currently visible, this item will havea mark.
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Other menu items Other menu items correspond to other windows that are
open. Select an item to bring the corresponding window to
the front. If an item appears in brackets ‘(...)’ then the
window is hidden. Select the item to make the window
visible again.

6.8 Speak Menu (Mac OS Only)

This only appears in the menu bar if speech synthesis software is installed and
activated.

Speak Selection ==%¥T Fast
Normal
Rate b 7|_stow
Pit!:h 4 ~.[ High
Voice 4 Mid
Low
Speak Selection Speaks the selected messages in the active mailbox window.
Option-Command-T
or
Speak Message Speaks the message in the active message window.
Options-Command-T
or
Stop Speaking Cancels the current text to speech operation.
Option-Command-T
Rate Provides a hierarchical menu to alter the rate at which text is
spoken.
Pitch Provides a hierarchical menu to choose alter the pitch of the
voice used to speak text.
Voice Provides a hierarchical list of all voices available to speak

text.
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7. Appendix A: Using Internet Config (Mac OS Only)

7.1 General

Internet Config is a System Extension that provides a central location for the storage of
internet based preferences and information. Applications, such as Mulberry, that are
‘Internet Config aware’ can make use of the information stored in Internet Config to
determine their own settings. The major benefit of using Internet Config is that
common internet preferences only have to be entered once (in Internet Config),
without having to make the user duplicate the same information in each application.
Also, it makes it easy to change settings, since they only need to be changed once, in
Internet Config, rather than in each application. Mulberry makes use of three types of
information stored in Internet Config:

File Mappings These are used to determine MIME type to Mac OS and Mac OS to
MIME type file mappings. These are always used.

URL Helpers These are used to determine which application should be used
for a particular type of URL when it is clicked by the user. These
are always used.

Preferences These are used to set various preferences in Mulberry. They are
only used when the ‘Use Internet Config Settings’ checkbox is on
in the Preferences dialog (see page 17).

7.2 File Mappings
Mulberry uses the file mappings in Internet Config to determine:
The MIME type for a file attached to a draft message.

The Mac OS file type for a MIME attachment in an incoming message.

You should ensure that for every type of attachment you want to send or receive, there
is a corresponding suitable entry in Internet Config for that attachment.

Since MIME to Mac OS file type mappings is a one-to-many mapping (e.g. ‘text/plain’
could map to a SimpleText document or some other word processing document), it is
necessary to explicitly tell Mulberry which of the possible mappings you want to use for
an incoming attachment. You can do this by using the ‘Mappings’ option in the
Attachment Preferences (see page 69) to set up the unique mapping from MIME to

Mac OS file type. If an explicit mapping is not set, Mulberry will use the first mapping
returned by Internet Config (which is usually the first one in its list that matches the
MIME type).
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7.3 URL Helpers

Mulberry uses the URL helpers settings in Internet Config to determine which
application should be used when a user clicks on a URL in an incoming message. For
each type of URL that you are likely to receive, you should ensure that Internet Config
has been configured with the application appropriate to your local machine. For
example, make sure that your current Web browser has been set as the helper for ‘http
URLs.

7.4 Preferences

When the ‘Use Internet Config Settings’ checkbox is on in the Preferences dialog,
Mulberry will read certain preference information from Internet Config and use these
in place of any settings previously stored in the preferences. It will also disable the
relevant fields or controls in the dialog, so that their values can only be changed via
Internet Config. When the checkbox is on, Mulberry will read in the Internet Config
settings whenever the corresponding preference set is opened. It will also re-read the
settings if the checkbox is switched from off to on. Thus if you make any changes to the
Internet Config preference settings that Mulberry uses, while Mulberry is running, you
should turn off, then turn on the ‘Use Internet Config Settings’ checkbox in the
Preferences dialog to ensure that Mulberry ‘picks-up’ the new values. The preferences
that are affected by Internet Config are:

‘Personal’ panel in Internet Config

Real Name If simple preferences are being used, this is used to set
the “Your Name’ field. If advanced preferences are
being used, this is used to set the ‘Name’ field in the
‘From’ tab of the Default Identity, which can be found
in the ‘Identities’ preference panel. (see page 60).

Quote String The quote string is used to set the ‘Reply Prefix’ value
in the ‘Outgoing’ preference panel (see page 55).

Signature If simple preferences are being used, this is used to
configure the ‘Set Signature’ option. If advanced
preferences are being used, this is used to set the
‘Signature’ in the ‘Options’ tab of the default identity,
which can be found in the ‘Identities’ preference
panel (see page 64).
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‘Email’ panel in Internet Config

Email Address When simple preferences are active, this is used to set
the ‘Email Address’ field. When advanced preferences
are active, this is used to set the ‘Email’ field in the
‘From’ tab of the Default identity, which can be found
in the ‘Identities’ preference panel. (see page 60).

Email Account This should be a string of the form
‘mulberry@imap.cyrusoft.com’. The user id part of
this string (i.e. ‘mulberry’ in the above example) is
used to set the ‘IMAP User ID’ field in the simple
preferences. The domain part of this string (i.e.
‘cyrusoft.com’ in the above example) is used to set the
‘IMAP Server’ field in the simple preferences.

When advanced preferences are being used, the user
id and the domain are used as the User ID and the
Server, respectively, for the default IMAP Mailbox
account.

SMTP Host This is used to set the ‘SMTP Server’ field in the
simple preferences. When advanced preferences are
active, this is used to fill in the ‘Server’ text box for
the default SMTP server. (see page 30).

Email Headers When advanced preferences are used, this is used to
set the ‘X-Header Lines’ in the ‘Options’ tab of the
default identity, which can be found in the ‘lIdentities’
preference panel.

‘Fonts’ panel in Internet Config

List Font This is used to set the ‘Lists’ font and font size in the
‘Fonts’ panel of the advanced preferences dialog (see
page 38).

Screen Font This is used to set the ‘Plain Text’ font and font size in

the ‘Fonts’ panel of the advanced preferences dialog
(see page38).

Printer Font This is used to set the ‘Printer’ font and font size in
the ‘Fonts’ panel of the advanced preferences dialog
(see page 38).
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9. LICENSE

A separate license agreement is provided with this software. You must read the license
agreement and agree to its terms before using the software.

10. DISCLAIMER

Whilst Cyrusoft International, Inc. has fully tested this software to the best of its ability
there may still be bugs. In no event will Cyrusoft International, Inc. be liable to you for
any consequential, incidental or indirect damages due to the use of or inability to use
this software or accompanying documentation.
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11. REPORTS or SUGGESTIONS

To get up-to-date information about Mulberry look at the Web page at:
http://www.cyrusoft.com

Here you can find a list of known problems as well as a list of features being considered
for future versions.

Mailing lists are available to promote discussion of Mulberry and related issues and for
announcements about Mulberry. A Frequently Asked Questions (FAQ) page is also
maintained. Information on all these is available on the Web page:

http://www.cyrusoft._com/support

If you have any comments or reports please email them to:

mailto:mulberry@cyrusoft.com

Mulberry is © Cyrusoft International, Inc. 1995-2000.
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12. INDEX

A

ACAP, 1, 14, 19, 22, 32, 77, 86, 106, 107
Access Control, 12, 101, 102, 103, 170
Address Books, 106, 167, 168, 169
Setting and Viewing, 101, 170
ACLs. See Access Control [Lists]
Address Book Manager, 44, 164, 165, 166, 167, 168,
202, 203
Address Book Window, 179
Address Books
Creating a New Address Book, 164
Creating a New Address Entry, 181
Deleting, 165
Displaying Address details, 181
Editing an Existing Address, 182
Eudora, 184
Exporting Addresses, 171, 184, 203
Groups, 180, 182, 183, 184
Importing Addresses, 171, 184
Netscape, 184
Opening, 164
On Startup, 168
Pine, 184
Saving Address Books, 184
Searching, 33, 34, 68, 165, 171, 172, 173, 175, 176,
203
Results, 176
Sorting Entries and Groups, 183
Address Fields, 41, 134, 152, 153, 174, 175, 180, 181
Automatic Expansion and Collapse of, 135
Addresses, 1, 8, 14, 41, 61, 63, 65, 68, 69, 108, 115,
116, 119, 124, 133, 134, 135, 137, 148, 152, 153,
165, 168, 170, 171, 172, 174, 175, 176, 177, 180,

181, 182, 183, 184, 185, 189, 202, 203
Copying into Addressbooks, 8
Preferences. See Preferences:Address
Searching for, 1, 14, 86

Addresses Menu, 202

Administrative and Configuration Information
see also the Mulberry Administrator’s Guide,
6,7, 10, 15,17, 121

Aliases. See Nick-Names

Alt key uses, 53, 68

Append Now, 154, 199

AppleDouble Encoding, 70

Attachments, 1, 4, 8, 37, 71, 72, 77, 127, 139, 143,
159, 161, 163. See also MIME
MeiSSaége Attachment Indicator in a Message Window,
Saving, 71, 143, 144, 149, 197

Sending, 157, 161
Viewing in a Message, 127

B

Balloon Help see also Help, 1, 5, 20
Binhex Encoded Messages, 150, 197
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Bounce, 139, 148
Bulletin Boards. See Mailboxes; see also Access
Control

C

Cabinet, 36, 39, 47, 79, 83, 91, 92, 93, 94, 107, 121,
193

CC Field, Sorting on, 124

Column Headers, 80, 82, 83, 111, 122, 123, 164, 165,
172,175
Server Window, 80

Configuration, 14, 17, 75

Context Menu, 8, 81, 122, 165, 175

Copy Now, 139, 140, 149, 196

Copying Messages. See also Messages:Copying
Copy To Pop-Up and Options, 47, 64, 92, 98, 135, 139,
140, 147, 149, 154, 155, 196, 199

CRAM-MDS5, 15, 23

D

Delete key, uses of, 126, 176

Deleted messages
Display style, 41

Desktop, Macintosh, 126, 130

Dial-in Protocols see also Network Protocols, 2

Digests. See Mail Digests

Directory Separator, 25

Directory Services see also LDAP, IMSP, 14, 25

Disconnected Operations, 11, 12, 25, 28, 32, 49, 98,
104, 105, 106, 107, 108, 109, 169, 187, 192, 203

Display Hierarchies, 12, 87

Display Options. See Preferences:Display and
individual window entries

Display Preferences. See Preferences:Display

Downloading files and parts. See
Attachments:Saving

Draft (IMAP Message Flag), 117, 127

Draft Menu, 198

Draft Messages, 9, 52, 53, 56, 57, 58, 74, 137, 151,
154, 155, 156, 157, 158, 161, 162, 163, 174, 175,
177, 180, 181, 182, 183, 185, 186, 187, 189, 196,

199, 200, 201, 206
Creating with Address Books, 180
Saving, 162

Draft Window, 151

Drag and Drop capabilities, 1, 3, 8, 61, 93, 94, 126,
129, 130, 135, 143, 149, 161, 162, 176, 177, 178,
182, 183, 185

E
Edit Menu, 188
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Email Addresses. See also Addresses
Acceptable Formats, 153
Shortcuts in composing, 154

Email, is our life. pp. 1-

Eudora. See Address Books:Eudora

Expunging Messages, 27, 45, 46, 102, 112, 113, 130,
192

F

Favourite Folders, 40, 81, 92, 110, 193

Favourites. See New Mail Checking

FCC. See Messages:Copying:Automatic INBOX
Reply Copying

File Menu, 186

Files. See also Attachments See also Draft
Messages
Saving Multiple, 126

Filters. See Message Window:Columns

Finder, Macintosh, 8, 20, 126, 130, 143, 149, 161,
163

Finding Addresses. See Address Books:Searching

Flags. See also individual flag names
Changing Message Flags, 130

Flags, IMAP, 47, 101, 106, 112, 118, 119, 126, 130,
132, 149

Folders. See Mailboxes

Font. See also Preferences:Display
List Font display, 208

Formatted Text. See also Styled Text See also
URLs, Headers, Quoted Text
Defined, 145

Forward, 136, 148

From field, changing values. See also ldentities

From/To.See Smart Addresses

G
Groups. See Address Books:Groups

H

Headers
Fields
Cycling through. See Tab key configuration
Display Styles, 43, 145
Saving with a message, 51
Showing Message Headers in a window, 51, 140

Help, 1, 4, 5, 10, 13, 20, 77, 82, 127, 164

Helper Applications, 206, 207

Hierarchies. See Mailboxes:Hierarchies and
Mailboxes:Lists

Hierarchy
Separator Characters. See Directory Separator
HTML. See Styled Text:HTML
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Identities, 15, 26, 56, 60, 61, 62, 63, 64, 65, 66, 67,
98, 155, 156, 157, 199, 207, 208
Preferences. See Preferences:ldentities
IMAP, 1, 8,11, 12, 13, 14, 15, 22, 23, 25, 26, 50, 77,
79, 81, 82, 83, 84, 85, 86, 87, 90, 93, 95, 97, 98, 100,
104, 105, 106, 107, 108, 113, 122, 127, 140, 157,
158, 162, 208
CAPABILITY options see also Access Control and
Quota, 95
Servers, 95
Server Names, 22
Servers, 8, 11, 12, 79, 82, 83, 85, 87, 90, 95, 98, 106,
122,127, 140, 157, 158, 162, 208
IMAP User ID, 208
IMSP, 1, 8, 14, 19, 22, 31, 32, 77, 86, 106, 107
INBOX, 35, 46, 57, 74, 78, 79, 83, 84, 85, 86, 87, 88,
90, 94
Installation of Mulberry, 4, 5
Internet Config, 4, 13, 20, 72, 145, 206, 207, 208
Internet Message Access Protocol. See IMAP
Internet Message Support Protocol. See IMSP
Internet Preferences. See Internet Config
Internet Preferences file, 206

K
Kerberos, 15, 23, 24

L

LDAP, 1, 14, 22, 33, 34, 77, 86, 173
Displaying raw LDAP schema, 34

Lightweight Directory Access Protocol. See
LDAP

List Mail, Sorting. See Message
Window:Columns

Local mailboxes, 113

Logins, 25, 32, 85

Logouts, 79, 171, 203

M

Macintosh System Compatibilities, 2
MacTCP see also TCP/IP, 3
Mail Checking
Automatic, 98
Mail Digests, Creating, 52, 130, 157
Mailbox Window, 36, 41, 45, 93, 111, 112
Description, 111
Mailboxes

Creating, 90

Hierarchies, 165

Lists of, 12, 80, 82, 83, 86, 90, 91, 106, 108, 144, 192
Searching, 117

Setting the Number of Messages to Display, 127
Status, 100

Mailboxes Menu, 191
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Memory Requirements, 2, 128

Message Window
Header Controls, 113
Selecting Messages, 125
Sorting, 124
message/rfc822 (MIME type), 162

Messages
Copying, 8
Automatic INBOX Reply Copying, 57
Delete Options, 52
Remembering the last mailbox copied to, 57
Deleting, 110, 128, 135, 137, 147, 171, 184, 185
Drafts
Recovered Draft Files, 9
Manipulating (general), 125
Navigating Between, 135, 146
Opening, 128
Printing, 129, 146
Read-Only Privileges, 112, 137
Read-Write Privileges, 112
Replying, 137
Multiple Recipients, 138
Saving, 146
File Extensions, 52
Mac OS File Creator Type, 52
Searching, 117
Sending, 30, 56, 155
Sent mail indicator, 155
Size Limits, 52
Undeleting, 128, 129
Wrap Length, 56
Messages Menu, 195

Messages Window
Display Style, 127

MIME, 1, 4, 13, 59, 60, 70, 71, 72, 73, 134, 136, 137,
140, 141, 142, 143, 144, 152, 157, 158, 159, 196,
199, 206. See Multipurpose Internet Mail

Extensions

Creating MIME Multiparts, 159

Editing MIME Information, 159

Mappings, 4, 72, 73, 75, 206

Mappings between file types and MIME types, 71
Multiparts, 51, 52, 59, 60, 141, 143, 159, 196, 199

Modems, see also Dial-In Protocols, 2, 49, 125, 127
Mouse Button, Right. See Context Menu
multipart/alternative MIME structures, 51, 199
multipart/appledouble, 143

multipart/digest, 52, 196, 199

Multipurpose Internet Mail Extensions see MIME

see also Internet Configsee also Attachments
Defined, 13

N

Navigation Between Messages, 133, 135, 136, 139
Netscape. See Address Books:Netscape
Network, 2, 8, 15, 16, 77

Canceling Network Operations, 8
Errors, 155

Network Protocols, 2, 3
New Mail Checking, 110, 129
Automatic, 81
New Message Indicator (Server Window), 99
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New Messages. See Draft Messages

Nick-Names, 33, 153, 154, 165, 168, 180, 181, 182
Using in Address Book Searching, 168
NOTES

Special advisory notes are on these pages -, 6, 7, 8, 15,
22, 26, 30, 59, 63, 66, 79, 82, 83, 85, 87, 89, 90, 92,
93, 94, 95, 97, 112, 113, 124, 125, 135, 136, 137,
138, 140, 144, 145, 154, 158, 159, 166, 180
NTLM, 15, 23

O

OpenTransportsee also TCP/IP, 3
Option Key uses, 53, 68, 102, 126
Outgoing Queues, 30, 131, 187

P

Parts Table see also MIME, 139, 141
Display, 85, 121, 135, 139, 144

Passwords
Matching User ID and Passwords, 22

Pine. See Address Books:Pine

Port Numbers, 22

Post Office Protocol (POP), 1, 11, 12, 13, 15, 22, 26,
27,28, 29, 50, 69, 77, 79, 81, 82, 83, 85, 86, 87, 95,
96, 108, 113

Preferences, 1, 4, 6, 14, 17, 18, 19, 20, 23, 24, 31, 38,
77,78, 83, 85, 86, 95, 112, 124, 126, 127, 135, 137,
138, 140, 143, 145, 146, 153, 154, 162, 187, 189,

200, 206, 207, 208
Attachments, 206
Identities, 61

Local vs. Remote, 19
Remote, 8, 19, 20, 86
Saving, 19, 20

Prefixes, 56, 207
Printing, 52, 56, 129, 146
Messages, 129

Q

Quota, 12, 97, 104

Quoted Text
Options when replying, 138, 154

R

Raw Text, defined, 145

Recent (IMAP Message Flag), 127

REFERENCE sections appear on these pages -,
109, 128, 146, 162, 170, 176, 183

Registry. See Windows Registry

Remote Preferences. See Preferences:Remote See
also IMSP

Replying to a Message see also Messages -
Replying
Choosing from Multiple Addresses, 53

Reply-To field, 63, 67, 137, 148
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Return key, uses of, 109, 126, 128, 170, 174, 176
RFC822 Name, 207

S

Search Window, 117

Searching
Addresses. See  Address Books:Searching
Mailboxes. See Mailboxes:Searching
Messages. See Messages:Searching

Security, 15, 59, 63, 66

Seen (IMAP Message Flag), 127

Seen Mail folder, setting. See
Messages:Copying:Automatic INBOX Reply
Copying

Send Again, 9, 139, 149

Sender field, 148

Sending Messages. See Messages:Sending

Sent-Mail Folder. See Messages:Copying:Moving
Automatically

Server Window, 78, 85, 95

Shared Folders. See Access Control, Quota, and
Subscriptions, Mailbox

Simple Mail Transport Protocol. See SMTP

Slash (/) character, 25

Smart Addresses, 61, 123, 124

SMTP, 1, 9, 13, 15, 22, 30, 62, 66, 77, 86, 131, 132,
140, 208

Sorting
Address Book Entries, 183
Ascending Order, 124
Descending Order, 124
Messages, 124

Speak Menu, 205
Special Mailboxes. See Subscriptions, Mailbox
Speech Support, 4, 37, 73, 74, 75, 150, 205
Stationery. See Draft Messages
Status Line, 77
Status Window, 77
Styled Text, 43, 44, 58, 139, 144, 145, 146, 162, 200,
201
Displaying as default, 51
Generating multipart/alternatives, 58
HTML, 44, 58, 199
Text/Enriched, 44, 58, 199

Toggling between formatted and plain text displays,
140

Subject header, 125, 135, 152

Subscribe. See Subscriptions, Mailbox:Subscribing

Subscriptions, Mailbox, 11, 35, 78, 79, 83, 84, 86,
93, 100, 110, 193

Subscribing, 90, 110, 193
Unsubscribing, 110, 193

System Requirements, 2
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System Software, 3, 4
System Software see also Windows NT, Windows
95 and Windows 98, 3

T

TCP/IP see also Network Protocols and Dial-In
Protocols, 2, 3
Templates. See Draft (IMAP Message Flag)

Text
Composing. See Draft Messages and Messages:Drafts
Copying, 8

Text Alternatives see also multipart
alternatives, 146

Text Clipping (Mac OS feature), 130

Text Display, 134, 144, 162

Text Files, Macintosh file creation, 52

text/enriched. See Styled Text:Text/Enriched

text/html see also Styled Text
HTML, 44, 58, 199

text/plain MIME parts, 58
viewing parts, 162

Threads, defined, 125

Trash, Emptying. See Expunging Messages

U

UID Validity, 100

Uniform Resource Locators. See URLs

Unseen (IMAP Message Flag), 127

Unseen Message Indicator (Server Window), 80,
99

Unsubscribe. See Subscriptions,
Mailbox:Unsubcribing

URLs, 34, 43, 145, 206, 207
Recognizing, 145
UUENcoded Messages, 150, 197

W

Window Positions

Resetting to Factory Defaults, 204
Saving Default, 133, 151, 204

Windows 95, 2, 3

Windows 98, 2, 3

Windows Menu, 204

Windows NT, 3

Windows Registry, 19

Wrap Length. See Messages:Wrap Length

X
X-Headers, 64, 208
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